Follett Aspen:

Managing Student Information

User Guide
Version 5.2

o FOI Iett http:/www follettsoftware. com/school-administration -software



Copyright © 2014 by X2 Development Corporation,a Follett School Solutions Company. No part of this
publication may be reproduced or distributed in any form or by any means without the prior written
consent of the publisher.

Version 5.2



Table of Contents

Managing Student Information ... .. i 8
Understanding the Student List ... ... . i 8
Using the Student List .. .. 8
Navigate the Student List ... il 10
Set the Number of Rows onalList Page ... ... . . .. 11
Use Field Sets ... . L 12
Filtering Students on the Student List ... .. 13
View Active Students ONly .. 13
View Secondary Students Only ... ..o e 14
Using Queries to Finda Group of Records ............ ... .o i 14
Find Students Enrolled in Class Taught by a Specified Teacher ... .. ... ... 16
Using Snapshots to Create and Store Groups ... ... 17
Manage Snapshots for Individual Records ........ ... ... . 19
Understanding Queries, Snapshots, and Filters ... . ... ... ... ... ... 19
Finding and Selecting a Student by Name ...l 20
Use ControlHF il 20
Usethe Page Control ... . L 21
Search by Initials and Beginningof Names ... . ... ... ... 21
Selecting Students onthe List ... 22
Select a Student to View, Enter, or Edit Information ........ ... ... ... ... 22
Select a Student to Perform Functions or Print Reports . ... .. ... ... 22
Browsing Through a List of Student Records ......... . ... . ... .. 23
Using the Student List Reports Menu .. 24
Generate a Quick Print Using the Printer |con ... . 24
Generate a Quick Report Usingthe Reports Menu .......... .. ... i, 25
Use Quick Letters ... . 38
Createa Quick Letter .. . . L 38
Print Labels IN ASPON 50



Commonly Used Label Sizes in ASpen ... .. 52

Maintaining Student Information ... ... 52
View Archived Students . . 53
StUAENt AlBI S . 53

Create Medical, Legal, and Other Alerts ... . ... . . 54
View a Student's Current Location ... .. .. . . . 55
View a Student’s Cross-Enrollment Status .......... . ... ... ... 56
View a Daily Absence Alert ... 57
Create Education Plan Alerts .. ... .. 58
Determine the Alert Icon foran EducationPlan ... . ... ... . ... 59
View an lEP Alert il 60
Customize Other Alert [CONS . ... ... e 61
Custom Alert ICONS ... 63
Entering and Viewing Student Details ... ... 74
Protect Student Demographic Information ___ .. ... 76
View Changes to Student Demographic Information ... ... ... 77
Create Medical, Legal, and Other Alerts ... . ... . . 78
Import Student Photos ..l 80
Search for Students or Staff Without Photos ... ... ... .. 82
Assign Next School for Students ... ... 83
Enter or View Student Contact Information ... .. ... .. .l 84
View a Student's Current Location ... ... . . 85
Enter or View Class Attendanceonthe Student Tab ... . ... ... ... ... ... 87
Enter or View Conduct Incident for Specific Student . ... . . i 87
Entering and Viewing Transcript Information ... . ... .. .. 88
Promoting a student mid-year ... ... . L 89
Creating arecord foratransfercourse .. .. 89

View and Adjust a Student's Credit Summary ... ... i, 91
View and Adjust a Student's Grade Point Summary ... ... ..l 92



Define Different Credits for Students inthe Same Course ... ... ... 93

Managing Graduation Requirements . . 93
Creating and Managing a Program of Studies ... . . .. 94
Define Details fora Program of Studies ............. ... 94
Define and Manage Program Requirements ....... . ... . ... ... ... 96
Attach Courses to Requirements .. .. 97
Viewing Programs of Study fora Student ... 98
View Graduation Requirement Status foraStudent _______ .. . .. ... ... 99
Run the Graduation Progress Report .. ... .. 101
Graduation Progress Chart Report . . ... L 104
Enter or View Student Assessments .. ... .. ... . 106
Enter Assessment Information for Groups of Students ... ... .. ... 107
View the Details of Your Students' Other Classes ......... ... ... i, 108
Working With and Viewing a Student's Schedule . ... .. . . L 109
View aStudent's Schedule ... ... . 109
Email aStudent’s Teachers ... .. oo 110
View a Student Schedule Matrix ... ... . i 111
Define Student Scheduling Parameters . ... ... L 112
Making Changes to a Student's Current Schedule .. ... ... . .. 115
Make Student Schedule Changes Using the Matrix ... ... ... ... ... 117
Drop Courses from a Student's Schedule .. ... . 120
Add Courses toa Student's Schedule ... .. ... .. i 120
Posta Student’s Schedule . ... .. . . 122
Update Students' Course Requests on Their SchedulePage ... .. ... ... ... .................... 123
Reschedule Students Based on Course Requests ... . 123
View Changes to a Student's Schedule . ... . 125
View Graduation Progress fora Student ...l 125
Managing Student Requests forNext Year ... ... ... 126
Enter Requests for a Student Using the Options Menu ... . .. ... 126



Entering Requests for Teacher Recommendations ... ... ... ... 129

Add Course Recommendations for Several Students .......... ... 130
Accept Recommendations to Create Course Requests for Several Students ................... 131
Approve Requests Entered by Students Online ... ... .. .. . ... 132
Review Course Recommendations and Requests fora Student ... ... ................ 133
Working With Student Enrollment Information ... ... . 134
Register a StUdENt . L 134
Re-register a Returning Student ... .. 139
Withdraw a Student .. ... . 141
Withdrawing a “Private” Student . ... .. . L 143
Transfer a Student ... . 144
Change a Student's Enrollment Status ....... .. ... 146
Promote or Demote a Student ... ... .. . 146
Associate a Studenttoa School ... . ... . 147
Create Secondary School ASSOCIatioNs . . ... . L 149
Cross-Enrolling Students Whose Primary Schools DoNotUseAspen ... ...... 151
Secondary School Information Report ... ... 152
Assign a Group of Students toa Program . ... . 153
Track @ Student's Programis ... 155
View and Manage a Student's Groups ... .. 155
Entering Student Transactions ...l 156
View Student EVents .. .. 156
Manage Student Work oW S .. 157
Managing Documents for Students ... ... .. e 157
Add or View Documents Associated With Students/People .......... .. ..o . 157
Manage a Student Joumal . . .. 158
View a Student's IEP ... 158
View and Print Student FOrms .. ... 159
Managing a Student's Educational Plans ... ... 160



Create an Educational Plan Record ... ... 160

Track Meetings for an Educational Plan ... . 161
Run the Educational Plan Report . ... 162
End an Educational Plan ... e 163
Managing a Student 504 Plan ... 164
Createab04 Plan ReCOrd ... ... ... o 164
Track Meetings for a 504 Plan ... 166
Runthe 504 Plan Report ... L 166
View Summary of Student's 504 Plan ... 170
End ab04 Plan ... 171
Determine the Alert Icon fora 504 Plan ... 172
Manage Snapshots for Individual Records .. ... . ... 172
Associate Related Students ... .. ... . 173
Assigna Student COUMEN . ... 173
Manage Courier GIrOUDS ... ... e 174
DX . 176



Managing Student Information

Managing Student Information

Pages School Student Staff Attendance Conduct Grades Assessment Schedule Global

Use the Student tab to access the Student List for either your district, intermediate organization or
school, depending on which view you are logged on to or what you have access to. The Student List
is your online filing cabinet full of student records, containing a folder for all of your active and
inactive students. Access all of a student's information — such as demographics, contacts,
conduct, attendance, enroliment, and schedule — from the Student List.

Y

You can determine the information you view for each student on the list, and if you want to view a
group of students with something in common only, such as a year of graduation.

To use the Student tab, familiarize yourself with the basic navigation and student selection
process. Then you can use the side-tabs to enter, edit, or view information for a specific student.

Understanding the Student List

The Student List contains a list of all of the students in your school. Familiarize yourself with the
basic navigation and student selection processes. You can do the following:

« Use the Student List.
« Filter students on the Student List.

« Find and select a student by name.
« Use the Reports menu.

Using the Student List

The Student List displays a list of the active students in your school or district, depending on which
view you log on to:

Use the following table to navigate the Student List:
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Use this section of the Student List

ti Report Hel
Options, Reports, and Help menus Perform functions or print reports. You can

Options Reports Help also access Aspen online help.

Side-tabs to the left of the page

Student List

Details
Contacts
Attendance

Conduct

Enter, edit, or view information for the

Transcript student you select.

Assessments
Schedule
Membership
Transactions

Documents

Snapshots

Navigate through the pages of students in
the list.

Page control
In addition to displaying the page control at

the top of all list pages, you can set your
user preferences to display it at the bottom
of all list pages.

I 1: dbbondanzio, fnthory L

(=2

Record counter View the number of records you selected
in the list. Click £ to clear the
[ 012090 satacted 7] checkboxes of all selected records.
Record navigation bar Browse through the list of students without
having to return to the Student List to
I« [ < [ Q [ > | > J access each record individually.

Determine the group of records that appear

Filter menuicon on the page, such as All Active Students.
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Use this section of the Student List

g

Field Set menu icon

=]

Sort Order menu icon

d-+E

Dictionary menu icon

=B

Select the columns of information you
want to view for each student in the list.

Determine how you want the records on
the page sorted, such as by name or
homeroom.

On lists that use extended Data
Dictionaries, select which one you want to
use.

Navigate the Stude

nt List

The Student List sorts students alphabetically by last name, by page, similar to a phonebook or
dictionary. At the top of the Student List, the first student on the current page appears in the page

control drop-down:

Click the drop-down to view the students who begin each page of the Student List:

Student @

Details
Contacts
Attendance
Conduct
Transcript
Assessments
Schedule
Membership

Transactions

: Abrsham, Allison

1: Abraham, Allison
: Aronson Wain. ..
. Bell, Melanie

: Bridgeman, Jenna
: Caruso, S=an

: Cicone, Rae

: Cowan, Rae

: Delia, Elizabeth

: Dooks, Chittur

. Enrigquez, M...

: Fougere, Da...

: Gitlin, Tristan

: Greenhalgh,...
. Hayes, Ashley

. Hosne, Jessa

s Inz, Jake

. Keohan, James
: Larsen, Ashley
: Linscott, Snow

|20: Macomber, Anne
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If you click a name in the drop-down, the system displays a new page with that student as the first
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record. For example, from the above screenshot, selecting '14. Hayes, Ashley' opens the
following page:

Student g

Details
Contacts
Attendance
Conduct
Transcript
Assessments

Schedule

Membership

Transactions
Documents

Snapshots

[ 12: Hayes, Ashley v| 0 of 763 selected (7
[1|Name Address YOG DoB EnrStatus
I:‘ Hayes, Ashley 484 B |denson Grove 2010 1/21/1932 Active

|:| Hayes, Danisl 978 Fairmount street 2012 11501993 Active

I:‘ Hayes, Howard 9 Green Nesdles Pl 2009 142601991 Active

D Hayes, Michas| 18 Prescott Sreet 2009 41411991 Active

I:‘ Hayes, Sinclsir 34 Boston Post D 2010 4/9/1992 Active

D Hedtman, Amanda E77 South road 2010 H2BMER2 Active

I:‘ Hegarty, None 18 Sweeney Rad 2012 1/30/1984 Active

D Hegarty, Rebeccs 229 Kelly Streest 2008 Active

I:‘ Hennessey, Elizabeth 78 Cinnamen Gt 2009 Active

I:‘ Hennesssy, Elliot 42 Fern Highway 2011 10/10/1883 Active

D Henry, Patricia 72 Old Stage Coach Ct. 2011 510/1993 Active

I:‘ Hernandez, Briana 225 Old Colony Sreet 2012 8/21/1985 Active

D Hernandez, Kayls 18 Rutland A3 2011 82771893 Active

To view students on the previous page, click Previous . To view students on the next page,
click Next .

You can customize the number of records, or rows, that you want to view per page and the
information, or field sets, that appear for the students.

In addition to displaying the page control at the top of all list pages, you can set your user

preferences to display it at the bottom of all list pages.

Set the Number of Rows on a List Page

To determine the number of rows that appear on a list page, set the records per page in your

preferences.

Do the following to determine the number of rows on each list page:

1. Onthe settings bar, click Set Preferences. The Set Preferences dialog box appears

-11 -
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General Home Security Gradebook
Default View District -
Default school Crow Point High School Q

Auto-save interval (minutes) | 2

Disable User-defined Help [l
List ions
Records per page 25
Showr lower page controls E
Warn on save

2. Inthe Records per page field, type the number of records, or rows, you want to view on any
page in the system that appears as alist. The number you enter here, along with the font size for
your Web browser and your computer's desktop resolution, determine if you will need to scroll on
list pages or if you can view all records on a page at once.

3. Click OK.

Use Field Sets

Throughout Aspen, you can use field sets to customize the columns that appearin alist. When you
create field sets, you define the columns of information you want to see for every record on the

page.

Manage your field sets in the right-hand corner of each page using the Field Set menu icon EE=)

-12-
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Pages School Student  Staff Attendance  Conduct Grades  Assessment  Schedule  Glebal Admin

Options Reports Help
Manage Field Sets..
Student List

Details [[1: by, Emiy I 0 of 764 selected &7 All Active Students
2 [ {name SASID LASID HiN1  |EnrStatus  (Grade |Homersom HR Teacher
Contacts

[ |abety, Emily 1247732110 238847 [N lActive 08 LGl
Attendance [1|adkerman, James 1345584589 293478 [N Active 11 D101 Hartwell, A
Conduct [ |adam, Menigue 1202258211 208544 [N |Active 11 E207 Deang, C

[ |adams, Tyler 1652226004 297230 [N lActive 12 D105 Baker, A
e [ |Aldorisio, Mingle 1172991282 232039 [N lActive 10 D103 Baum, H 117131983 maldorisio@eudors.com
Assessments | [ EUENITLH 1129254845 208672 [N lActive o9 E107 Siclie, E 12/26/1993 ldsllen@sol.com

[ |atper, Hesther 1062556430 248235 [N |Active 11 E101 Weisz, J 11/151993 halper@blusyonder.com
Schedule

[ |amico. Elaine 1204051381 244040 [N lActive 12 B205 Ambrose, A 16/20/1991 lepilla@hotmail.com
Membership [ |amice. Jessph 1215480388 205214 [N lActive 11 4101 Medwsr, D 1/2/1993 lismico@eudors.com

[ [mice, Timethy 1062645502 241387 [N lActive 09 E201 Brandy, H 1/14/1995 ltemico@eudors.com
Transactions

[ |angersen, 1sabells 1260305854 283490 [N |Active o9 B105 Bowers, J 5/12/1995 ipost@earthlink com
Documents [ |#nderon, Le= 1208288082 280887 |M |Active 10 D104 Hollandg, K z/2e1884 Ivenkatesh@earthlink.com
Snapshots [ |Andersen, Margarst 1395487850 236201 [N lActive 11 D201 Liu, K 16/20/1992 manderson@comcast.com

[ |andersen, Rese 1188397751 255284 [N lActive 12 D201 Liu, K 5/3/1992 randerscn@eudors.com

[ |andersen, Tayler 1038939048 231707 [N |Active 10 A204 Ban, O 1/18/1994 thoulgste@sol.com

[ Apety. Emiy v|

From this area of the page, you can do the following:

« Create afield set.

« Modify an existing field set.
« Copy afield set.

« Delete afield set.

Filtering Students on the Student List

At times, it is not necessary for your Student List to contain every record in Aspen. Sometimes,
you might need to select and work with only active students or students with a specific year of
graduation. Aspen contains numerous methods for filtering the students you see on your Student
List, including the following:

« Viewing active students only
« Viewing secondary students only

» Using queries
« Using snapshots

« Viewing custom selections (A custom selection is a group of students you specifically select
and are currently viewing).

View Active Students Only

By default, Aspen displays active students only on your Student List. You might look at a
shapshot or use a query to find a specific group of students and then want to return to viewing only
active students.

To view active students only:

1. Onthe Student List, use the Filter menu ? to select Active Students:

-13-
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Pages School Student Staff  Attendance Conduct Grades  Assessment Schedule Global Admin

Options Reports Help Y

v All Active Students ~h

Student List

- 1 Er 1
Details [+ Aosty. Emiy ¥ =] 0 of 764 selected (7 All Active Students
- D Hame SASID LASID H1N1 EnrStatus. Grade Homeroom
Contacts

[ |assty, Emily 1247732110 238347 N Active 08 L&l
Attendance [ |Ackerman, James 1345584589 293479 [N Active 11 D101
Conduct [ |adam. Menique 1302458311 208544 [N Active 11 E207

[ |adams, Tyler 1652228004 287230 [N Active 1z D108
Transcript [ |aigorisic, Mingle 1172991282 232038 [N Active 10 D103 Lic@eudora.com
Asse: [|aiten, Dians 1129254845 208872 [N Active s E107 Sjclie, E 12/28/1882 dsllen@scl.com
Schedul I:l |Alper, Heather 1082558430 248235 N Active 11 E101 \Weisz, J 11/15/1993 halper@blueyonder. com
>Chedule

[ |amice. Elaine 1304051381 244040 [N Active 1z B205 Ambrose, A 812011881 epilla@hotmsil.com
Membership [ [Amico, Jeseph 1215480288 205214 |N Active 11 a104 Medwar, D 1/2/1893 jamico@suders.com

. |Amico, Timoth: 1082645502 241387 N Active fil:] E201 Brandy, H 1/14/1995 tami udora.com

Transactions a il 7, co@e

[ |Andersen. Isabella 1260305854 283430 N Adtive 08 B105 Bowers. J 5/12/1885 ipest@earthlink.com
Documents D |Anderson, Lee 12082668082 2606887 N Active 10 D104 Holland, K 2/24/1994 Ivenkatesh@earthlink com
Snapshots [ |anderson. Margaret 1385487850 238301 |N Active 11 D201 Liu, K 8/20/1882 mandersen@oomeast com

The system refreshes your Student List to display all active students in your school or district,
depending on which view you log on to.

View Secondary Students Only

During the school year, students in a particular school might transfer to another school within your
district. When a student transfers, the system moves his or her record to the new school. That
record becomes a secondary student record in the original school.

For example, assume a student transfers from West Elementary to East Elementary in November.
Her record appears in East Elementary on active student lists and in West Elementary on
secondary student lists.

To view secondary students:

1. Log on to the School view.
2. Click the Student tab.

3. Use the Filter menu ? to select All Secondary Students. The Student List displays only stu-
dents who transferred from your school to another school in your district during the current school
year.

Using Queries to Find a Group of Records

A query represents a dynamic filter. It helps you search for and filter a group of records that matches
specific criteria at a particular time.

-14 -
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For example, you can perform a general search for a group of students with the same year of
graduation, or a more specific search for students in the same graduating class in a particular
homeroom.

You can also save queries you use often. Or, you can copy queries to use as a shell to create a
new query for yourself, or share queries with other users, your school, or your district.

There are three modes of queries:

« Simple Mode: These queries search for records based on the system’s lists of tables, fields,
and operators.

For example, create a Simple query to search for all students graduating in 2012 who are in
homeroom 100. After you save this query and run it again, it will always return a list of
students graduating in 2012 who are in homeroom 100. Saved Simple queries always search
for records based on the same criteria.

« Advanced Mode: These queries also search for records based on the system’s lists of tables,
fields, and operators, but have added functionality. When you use a saved Advanced query,
you have the option of changing the search criteria before it completes the search.

For example, create an Advanced query to search for all students graduating in 2012 who are
in homeroom 100. After you save this query and run it again, you can change some or all of
the search criteria. You can search for students graduating in 2012 who are in homeroom
150. Saved Advanced queries can be changed to search for records based on different
criteria than the criteria they were originally created for.

« Direct SQL Mode: These powerful queries search for records based on your own self-defined
criteria, not the system’s tables, fields, and operators. You use SQL syntax to define the cri-
teria; therefore, you are not limited by interface restrictions.

For example, create a Direct SQL query to search for all students who have more than one
absence this year.

In Simple and Advanced modes, you can also create parenthesized queries to manage and group
complex search conditions. Parentheses allow you to group criteria, resulting in a more powerful
search tool.

With a parenthesized query, a single search produces results that would require multiple queries
using the basic method. For example, you can search for records that meet the following
conditions:

« all females who are in homeroom 287; or

« all females who are in homeroom 360; and
« Wwhose graduation year is 2010; or

« whose graduation year is 2011.

-15-
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Find Students Enrolled in Class Taught by a Specified Teacher

To create an advanced query to search for all students enrolled in a class
taught by a specific teacher:

a A~ 0N~

Go to the School view.

Click the Student tab.

From the Options menu, click Query.

At the top of the Query dialog, click Advanced Mode.

Under SELECT * FROM STUDENT, copy and paste the following:

WHERE STD OID IN (
SELECT TRN_STD OID
FROM STUDENT TRANSCRIPT
WHERE TRN MST OID IN (
SELECT MST OID
FROM SCHEDULE MASTER
WHERE MST_SCH OID = '[SCH OID]'

AND MST STF OID PRIMARY = '[STF OID]'

)
)

Replace the [scH 01D] value in the query as follows:

« Goto the School view, click the School tab and then the Schedules side-tab.

« Hover over the desired school year, such as 2010-2011 (or right-click and select Properties
or Copy Link Location).

« The following line appears in the browser’s status bar at the bottom of the window (or in the
Properties pop-up or in your clipboard if you've copied it):

javascript:doParamSubmit (2100, document.form[ ‘contextListForm’],
‘SCHO0000001i0116")

7. Replacethe [STF 01ID] valueinthe query as follows:

« Go tothe School view and click the Staff tab.

-16-



Managing Student Information

« Hover over the desired staff name, such as Petullo, Anna (or right-click and select Prop-
erties or Copy Link Location). The following line appears in the browser's status bar at the
bottom of the window (or in the Properties pop-up or in your clipboard if you've copied it):

javascript:doParamSubmit (2100, document.form[‘contextListForm’],
YSTF0000000004e”)

8. Click Search. The results of your query appear.

Using Snapshots to Create and Store Groups

A snapshot represents a static filter. Think of a snapshot as a picture of a particular group of
students, staff members, courses, or rooms that you can file and easily retrieve.

For example, assume you manage the Math club and want to be able to quickly access all of the
students who are members. You can use a query to find the students initially, and then create a
snapshot of these students. This way, each time you want to work with students in the Math club,
you need only refer to your snapshot.

To create a snapshot:

1. Do one of the following:

2. Search for or select the records you want to include in your snapshot. You might select these
records individually, or use a query to find them.

3. Onthe Options menu, click Snapshots.
4. Inthe Manage Snapshots dialog box, click New. The Snapshot Definition dialog box appears:

-17 -
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o o

10.

Name Math Club
Crhavner Aspen Public Schools |[w
Sawve as filter

Mowe to top of my list |:|

Records to Include

{(®) Cument List

() Snapshot Combination

Save Cancel

Type a name for this snapshot.

Click the Owner drop-down to select the user, school,intermediate organnization, or district as
the owner. This determines which other users, if any, can use this snapshot.

Note: Not all users have privileges for all levels of ownership.

If you would like to make this snapshot an option on your Filter menu f, select the Save as fil-
ter checkbox.

If you would like this snapshot to be your default filter (for example, whenever you open the Stu-
dent List, these are the records you'd like to see), select the Move to top of my list checkbox.

In the Records to Include box, select one of the following:

« Current List to include only those records you selected checkboxes for on the list page.

» Snapshot Combination to combine two existing snapshots. (This option is only available if
you have already defined at least two snapshots.)

If you selected Snapshot Combination, use the following table to determine how you want to
assemble the two snapshots you select:

-18-
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Select To include the following in the snapshot:

Any records that appear in the first snapshot you select or the second
snhapshot you select. For example, if you want to create a snapshot of
students who appear on either or both the first term and second term
honor roll, select Union.

Union

Only records that appear in both the first and second snapshot you
Intersect select. For example, if you want to create a snapshot of students who
appear on both the first and second term honor rolls, select Intersect.

Any record that appears in the first snapshot you select, but not in the
second. For example, if you want to create a snapshot of students who
appear on the first term honor roll, but not on the second term honor roll,
select Difference.

Difference

11. Click Save. The Manage Snapshots dialog box displays the snapshot you created.

12. Select the snapshot you created, and click Use. The list page displays the records in the snap-
shot selected.

Note: You can also save a snapshot to the Filter menu on a list page. Then, you can
quickly select that snapshot.

Manage Snapshots for Individual Records

You can manage the snapshots a specific student, staff member, room, or course is a member of.
For example, assume you create a snapshot of all students on the Volleyball team at the beginning
of the season. Then, a student joins the team. Select that student and add him or her to the
snhapshot.

To manage snapshot membership for an individual record:

« Tomanage student snapshots, click the Student tab.
« Tomanage staff snapshots, click the Staff tab.

Search for and select the specific record.

3. Click the Snapshots side-tab. A list of snapshots the student, staff member, course, or room
belongs to appears.

4. Do one of the following:

« Toadd the record to a snapshot, on the Options menu, click Add. The Snapshot Pick List
appears. Select the snapshot and click OK.

« Todelete arecord from a snapshot, select the checkbox next to the record. On the Options
menu, click Delete.

Understanding Queries, Snapshots, and Filters

Queries, snapshots, and filters are ways to filter any list, such as the Student List or the Staff List.

Query
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A query is a dynamic filter. Use a query to search for a group of records one time. If you use the
same query criteria again, it might not produce the same list of records. For example, you can use a
query to search for all ninth-graders who have a GPA equal to or higher than 3.0. Because a
student's GPA can change with each grade term, the group of students that the query gathers could
be different each time you use it.

Snapshot

A snapshot represents a static filter. Use a snapshot to take a picture of a group of records you will
need to access regularly, or need to save. For example, assume you want to save the group of
students the query above finds to determine your Quarter 1 Honor Roll. Once you create the
snapshot — think of a picture taken with a camera — the group of students in the snapshot never
changes.

Therefore, if you create a snapshot of students in your homeroom today, and a new student
registers tomorrow, your snapshot does not contain that new student. But you can modify a
shapshot manually.

Filters

There are default filters and custom filters. Default filters are available from every list page. You can
also create your own filters when you make a snapshot or query. You have the option of saving a
snapshot and a query as afilter so you can use it again. You will be able to easily access the filter

by clicking J/ and selecting the filter you created to view the list of records.

Finding and Selecting a Student by Name

If you know a student's name, there are three ways to find that student on the Student List. You can
do one of the following:

« Use the Find dialog box (CTRL+F).

q: Abbondanzio, dnthony g lb‘l

« Use the Page drop-down |

« Press CTRL+I to search for a student by initials.

Use Control+F

1. Toquickly access a specific student’s record on the Student List:
2. Press CTRL+F.

In the Find dialog box, type one of the following:

» Student’s last name
« Student’s full name (last name, first name)

3. Click OK or press ENTER.

The Student List displays the page containing the selected record and selects the first student
matching that value — or the closest match, if an exact match cannot be found.

Using CTRL+F multiple times will select multiple records.
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CTRLH+F is based on the current sort order of the list. If the list is sorted by YOG rather than name,
then you would type a value such as 2012 in the Find dialog box.
Use the Page Control

At the top of the Student List, the first student on the current page appears in a drop-down list in the
page control. Use this list to quickly view the students included on the current page.

In addition to displaying the page control at the top of all list pages, you can set your user
preferences to display it at the bottom of all list pages.

If you click a student’s name on the drop-down, the system displays a new page with that student
as the first record:

[=] | 1: Abbondanzio, Anthony

1:Abbondanzio, Anthonmy ~
D 2: Andrade, Susan Edward .
|——2: Bagley, Brittany
[la: panow, Eleanor claire Foumer H
| — |5: Beauchamp, Karina Margaret =
Ble: pesters. e |
E?: Elizal.c. kewin . (ErraT
|— |&: Bossi, James Michael
D 9: Bradley, Caitlin Catherine — Bdets H
|——10: Brooks, Alicia
I:l 11: Bunker, Janelle King
| —|12: Cadigan, Jacqueline -
I:l 13: Carey, Mak Sean Fair A
E 14: Chandler, Kristen Jean —
|—[15: Chrizom, 'ana Elizabeth
D 16: Coady, Cheyanne Kirsten Dl dfield
—17: Coen, hatthew
|:| 18: Concannon, Kara Alexandra pruce O
|—{19: Corbo, Mary Ann Patrick
D 20: Crimminz, Debarah Catherine Franklin

Search by Initials and Beginning of Names

On list pages, such as the Student List, you can search for students by initials and beginning of
names.

To search for values by initials or beginnings of values, press CTRL+1. A prompt appears. For
example, to search for a student, you might do the following:

1. Type the student’s first initial, or the first few letters of the student's first name.
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2. Type the student’s middle initial, if you know it. If you do not know the student’s middle initial,
type the student’s last initial, or the first few letters of the student's last name.

3. Press ENTER, orclick OK. The system displays a list of students who match the initials search
you created.

Selecting Students on the List

Before you can view information or perform functions for students on the Student List, you need to
select the student or students you want to work with.

Select a Student to View, Enter, or Edit Information

To view information on a side-tab for an individual student on the list:

1. Click the Student tab.
2. On the Student list, select the checkbox next to the appropriate student's name.
3. Click a side-tab to enter, edit, or view information for that student.

Select a Student to Perform Functions or Print Reports

To use the Options or Reports menus to perform functions or print reports
for a student or group of students:

1. Click the Student tab.
2. Onthe Student List, select the checkboxes next to the appropriate students’ names:

Pagés S:I;cdl ”Studem Staff  Attendance COT‘I&I.I; Grades  Assessment Schedule Global Admin

Options Reports Help Y EE

Student List

Details [1= Abety. Emiy ~ (=) 4 of 764 selected (7 All Active Students
- D Name SASID LASID HIN1 \Grade jomeroom HR Teacher oo8 Email 1
Contacts

[ |asety. Emily 1247732110 23zEaT M |Active o8 L3l 10/24/1885  |eabety@scl.com
Attendance Adverman, James 1345564568 233879 N |Active 11 D101 Hartwell, A 8/19/1882 ljsdkerman@comeast.com
Conduct D [Adam, Monique 1302499311 208544 N \Active 11 E207 Deang, C 1/20/1993 madam@blueyonder.com

Adams, Tyler 1852226004 297230 N \Active 12 0105 Baker, A 771011891 tadams@gmail com
Tran Ecripl D Aldorisio, Mingle 1172991282 232039 N \Active 10 D103 Baum, H 11/13/1883 maldorisio@eudora.com
Assessments Allen, Disna 1129284845 208672 M |Active 08 E107 Sjolie, E 12/261883  [dallen@acl.com

[ |alper. Heather 1082558420 248235 [N |Active 11 E101 Weisz. | 11/151882 halper@blueyonder.com
S [ |amice, Elsine 1204051281 242080 [N |Active 12 B205 Ambrose, A lar20/1881 lepilla@hotmail.com
Membership iv} |Amico, Joseph 1215430988 205314 |N Active 11 A101 Medwar, D /211993 jamico@eudora.com
Transactions D (Amico, Timothy 1082645502 241387 N \Active |09 E201 Brandy, H 1/14/1895 tamico@eudora.com

[ |anderson, 1sabella 1260305854 283880 M |Active 03 5105 Bowers, J 5121888 ipcst@earthlink. com
Documents [ |andersen, Lee 1208268082 zeosET (M Active 10 D104 Hallznd. K (272411884 Ivenkatesh@earthlink.com
Snapshots [ |anderson, Margaret 1285487850 238301 [N |Active 11 D201 Liu, K lar20/1882 manderson@comeast.com

D [Anderscn, Rose 1188397751 255264 N \Active 12 D201 Liu, K 5/3/1992 randerson@eudors.com

I:l [Anderson, Taylor 1038939048 231707 N \Active 10 (A204 Bam, D 1/18/1994 thoulgate@acl.com

[ Apety. Emiy ~| E

3. Onthe Options menu, click Show Selected.
The Student List displays only the students you selected:
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Pages School Student

Staff

Attendance

Conduct

Grades

Assessment

Managing Student Information

Schedule

Global

Options

Student List

Details
Contacts
Attendance

Conduct

Reports

Help

0 of 4 selected &7

Custom Selection|

Name

SASID

LASID

H1N1

‘Grade

HR Teacher

DOB

Email 1

\Adkerman, James

1345584583

293479

Active

11

D101

Hartwell, A

8/18/1892

jsckerman@comeast.com

|Adams, Tyler

1652226004

287230

\Active

12

D105

Baker, A

71101891

tadems@gmail.com

|Allen, Diana

1129254845

208672

Active

109

E107

Sjolie, E

12/26/1993

ldallen@aol.com

Ogoo|oia

|Amico, Joseph

1215430988

205214

zZ |z =

Active

11

A101

NMedwar, D

1721993

lismico@eudors.com

After you select a student or group of students, the text below the icons displays Custom

Selection to alert you that you are viewing a list of students you filtered.

4. Do one of the following:

« Click an option on the Options menu to perform a function for those students.

« Click areport on the Reports menu to print a report containing information for those stu-

dents.

Browsing Through a List of Student Records

On the Student List, after you select a student and use the side-tabs to view that student’s
information, use the record navigation bar to quickly browse through the list of students:

FIE]

> | >

The following table describes each button on the bar:

Use this button To access
First Record EI

Previous Record EI

Search Records
Next Record E
Last Record E

The first record in the current student list.

The previous record in the current student list.

A pick list of the current student list.

The next record in the current student list.

The last record in the current student list.
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Using the Student List Reports Menu

There are numerous reports available on the Reports menu from the Student tab:

Pages District Student Staff  Attendance Conduct  Grades Assessment Schedule Global Tools  Admin

Options Reports Help Y &= =
Student List | asendancs History ‘h
0 of 2522 selected &7 Active Students
LASID  |HiN1 |EnrStatus  |Grade |Homercom  |HR Teacher poB Email 1
238847 [N [Active o8 Lal 102411995 |esbaty@acl.com
20z822 N |Active KF 214 Andsrsan, N 512/2004 fabety@blusyandsr.com
248217 [N |Active 02 120 Suddy, E 1126/2002 laimsong@eudera.com
288828 [N |Active 01 123 Hekimian, J 12/2/2002 cabrahem@yahce.com
228372 [N |Active o3 238 Fallon, § 712072001 sunn@webiost.com
227azs [N Active 01 114 Schaffhouser, A 1130/2003 repanides@hotmail.com
240801 [N |Active 0z 10 Chang, B 5712001 jacker@webfoct com
213231 [N Active 05 218 Cheung, F lerar1999 [tbarowski@yshoo.com
233473 N |Active i 101 Hartwell, A s18/1382 jackerman@oomeast.com
208544 [N active i 207 Desng, © 112011993 madam@blusycnder.com
505038 |N |Active 08 lat0s Bochman, F l&r1412002
297230 N active 1z D105 Baker, A 7o tagzms@gmail.cam
Snapshots 295721 [N |Active 05 218 Harrington, S erer1989 'sagiorgousis@cemeast.com
[I]Agvemang, Chancte 201733 [N active 0s 122411999 |cagyemang@msn.com
||:||ﬂqyemang Christina, ‘1(]771 38401 (242262 |N |Active o8 8210 Parker, M 5901888 cmurray@msn.com

You can also generate a Quick Print or a Quick Report.

Generate a Quick Print Using the Printer Icon

You can generate a Quick Print using the Quick Printicon 5 in the menu bar on any list page.
Clicking this icon once is the same as going to the Options menu, clicking Quick Report, and
selecting the Simple report type.

Or, to create a different type of Quick Report, click the Quick Printicon and then select Create
Quick Report to go directly to the Quick Report wizard.

To generate a Quick Print using the Quick Print icon:

1. Gotothe list page containing the type of data you want to report on.
2. Select the records you want to include on the report.
3. Onthe Options menu, click Show Selected.

0 of 553 selected 7

4. Click the Quick Printicon 5 in the menu bar. The menu expands:
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5. Click one of the following format options:

« Web Page (HTML): to view the information in an HTML file.

« CSV:toview the information in a text file that separates each field with a comma. If saved,
the file will have a .CSV extension

« TXT: to view the information in a text file that separates each field with a comma. If saved,
the file will have a . TXT extension.

6. Microsoft Word (DOC): to view the information in a Word document. The data appears in a
table, which has all the available options for borders and shading.

7. To print the report, do one of the following:

« From your browser window or dialog box, go to File > Print.

Ca )
« From Microsoft Word, click the Office Button @ and then click Print.

To generate a detail, summary, or group Quick Report using the Quick Print icon:

1. Gotothe list page containing the type of data you want to report on.
2. Select the records you want to include on the report.

3. Onthe Options menu, click Show Selected.
4

. Click the Quick Printicon ﬁ in the menu bar. The menu expands:

5. Click Create Quick Report to open the Quick Report wizard.

Generate a Quick Report Using the Reports Menu

Use a Quick Report to create an on-the-fly report of the information you are viewing on a list page.
You decide what's on it, and the system formats it to look professional.
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If there is a particular report that you run every week, such as an attendance report, creating and
saving a Quick Report means that you only have to set up the formatting once. Then, every time
you run the report it will look the way you want it to.

For example, maybe you like to shade every other line for easier reading and set up the report to pull
statistics such as boy totals and girl totals per attendance category. If you save your Quick Report
and run it each week, the formatting will look the same, but the information on the report will vary
based on the data in the system.

Other users in your school and district can create and share Quick Reports. Before creating your
own Quick Report, you might want to check the saved reports to see if it already exists.

Before starting to create your Quick Report, get your list page (such as the Student List) showing
the fields and records that you want to include. This minimizes the setup time in the Quick Report
wizard.

0 of 763 selected £#

The Quick Report wizard contains eight steps, but only the first four are required. The others let you
customize the report's format and design. If you prefer, you can do the formatting in Excel.

To generate a Quick Report from the Reports menu:

On the Reports menu, click Quick Report. The Quick Report wizard appears:
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Quick Report: Source Step 1 of 8
Source
@ New report
Saved report
<Back || Nemt> | Finish || Gancel

The Quick Report wizard has eight steps:
Step 1: Source

1. Do one of the following to determine if you want to create a new Quick Report or use one that's
been saved:

« Select New report to create a new report.

« Select Saved report to use a report you or another user previously created. The page dis-

plays a list of the reports available to you. You can click Finish to immediately print the
report without making any changes.

2. Click Next.

-27-



Managing Student Information

Step 2: Report Type

ist format. Pidk your columns and sort order, add
statistics, and run.

1. Click the Report type drop-down to select the type of report you want to run:
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Type Description

0000000 J‘_”
3
T
D

Group
[ N

The Simple Quick Report produces a list of the records and fields you
select to include. You select the columns and sort order. You can also
add totals or statistics, which appear in a summary table below the list of
records.

Example: The school nurse wants a list of all eleventh and twelfth
graders sorted by grade level, then homeroom.

The Detail Quick Report produces a page for each record, and the report
aligns the data fields vertically instead of horizontally.

For example, when running a Detail Quick Report on a student-based list,
each student record appears on a separate page, with the fields you
select as the rows.

Example: A new guidance counselor is starting and would like a list of his
students with basic demographic information, as well as a photo, to put in
each student's profile folder. Plus, he wants to know how many boys and
girls he's been assigned.

The Group Quick Report groups records by the fields you select. For
example, on a Student List you can group records by homeroom.

After you select Group, Step 3 displays the fields available to group
records by. Then, on Step 5, you can include page breaks as well as
calculate totals by group. For example, use Group Quick Reports to print
homeroom or bus lists.

Example: The new school year is starting, and you need to pull together
homeroom lists for the homeroom teachers that also show the number of
students in each room.
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Type Description

The Summary Quick Report hides individual records from the list and
produces a list of cumulative values based on the records.

Summary g ] L
— Use this report to print totals and other statistical reports.

After you select Summary, Step 3 displays the fields available to produce
values for. Then, on Step 5, you can include page breaks, as well as
calculate totals.

Example: The principal would like to know, for each course, how many
sections are offered and what is the average enroliment for the course.

2. Click Next.

Step 3: Field Selection

Quick Report: Field Selection Step 3 of 8
Available Fields | Sort A-Z Selected Fields
v Name
Identifier ~| Local identifier
Photo = State identifier
Last name E E:.de level
First name meroom
Middle name Date of birth
Name Enrcliment status
Address

Suffix

Local identifier

of graduation

< Badk MNeat = Finish Cancel
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1. Select the fields you want to include on the report and the order you want them to appear in.

2. Highlight afield in the Available Fields column, then click Add to add the field to the Selected
Fields column. To select several fields next to each other, press SHIFT and the Up or Down
arrow on your keyboard to select the fields. To select several fields together that do not appear
next to each other, press CTRL while you click each field you want to include.

To remove a field from the Selected Fields column, highlight it, and click Remove.

3. Click Next.

Step 4: Sort Order
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Quick Report: Sort Order

Step 4 of 8

Available Fields [ Sort A-Z

Student

Selected Fields

w

Identifier
Photo

Last name
First name
Middle name
Title

Address

Suffix

Local identifier
Gender

State identifier
Date of birth

“ear of graduaticn
Grade level

=

Name

< Badk Mext =

Finish Cancel

. To determine how the system sorts the overall report, such as which records print first, do the fol-

lowing:

In the Available Fields column, highlight the field you want the system to use to sort the report

by, and click Add to move the field to the Selected Fields column. You can continue to select
fields and add them below the primary sort.

In the Selected Fields column, highlight the fields and click Up and Down to determine the sort
order (the field that appears first in the column is the primary sort, then the secondary sort, and

soon).

Click Next to continue with setting up grouping and formatting options (optional). Or, click Finish

to run your report.
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1.

2.

3.

Managing Student Information

Quick Report: Totals and Statistics Step 5of8
Totals
Group Total Count Page Break
Crverall I:‘
Year of graduation
Statistics
Field Function Reset By
Home language | MAX » | | Group: Year of graduation W | x
Name | MAX b | | Group: Year of graduation | | ﬂ
[Fron] (e}

In the Totals section, to include totals of records on the report, select the Total Count check-

box next to the group.

In the Statistics section, for each field you include on the report, the report can provide the min-
imum, maximum, and total count of each field. For example, click the drop-down to select
Gender, click Add, and select COUNT to see totals of boys and girls. You can also track field
averages and sums for numeric fields. Following any statistic selection, if you have selected
group by fields, specify exactly when you want that statistic to reset. By default, the statistic
will be reset only at the end of the report. If a group field is chosen, the value will be reset at the
end of that grouping, allowing you to view group-based statistics.

You can add several statistics and resets for each field.

Click Next.
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Step 6: Format Options

Quick Report: Format Options Step6of8

Header

Report title c PA Report

Print date
Body

Format .:'\“.ft—b Fage [HTML) V|

Font face _:Arial v_.

Font size I'1‘_'—d|urr| V

Grid lines [ I.-!:.l.i.z:}ntal E\\-’E"tl cal v

Shade alternate lines

1. Use the following table to enter information in the fields:
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Field Description

Report title Type a title for the report.

Select the Print date checkbox if you want the report to print the current

Print date date.

Select one of the following:

+« Web Page (HTML) to view the information in an HTML file.

« Comma-separated values (CSV) to print the information in a text file
that separates each field with a comma. The file will be saved with a
.CSV extension.

« Comma-separated values (TXT) to print the information in a text file that
Format separates each field with a comma. The file will be saved witha . TXT
extension.

Font face Select the font you want the report to print in.
Font size Select the font size of the report.
Grid lines Select the type of grid lines (vertical, horizontal, or both), if any.
Shade . . .
Select this checkbox if you want the report to shade every other line for
alternate S
. easier viewing.
lines
2. Click Next.
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Step 7: Field Format Options

Custom Width
Humber of characters. I:l
——
Fonttsce
Font s
Bold vl
Italic O
Underline O
[ <Back | Next= i B Finien I cance: .

1. Foreach field that displays on the report (the columns of information that appear), you can define
a custom width in number of characters, and specific font and text effects.

2. Click Next.
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Step 8: Save Options

Quick Report: Save Options Step8of8

Save Dptions

Q Don't save

() Save

() Saveas

Name |GPA Report
Owner
Type User v_'

Hame Administrator, System Q

1. Use the following table to enter information in the fields:

Field Description

Select one of the following in the Save Options box:

« Select Don’t save if you do not want to save the report para-
meters you just selected. When you click Finish, if you like
the report that appears, you will have to go through the wizard

Save Options again to recreate it.

» Select Save to save any changes you made to an existing
saved report.

« Select Save as to save the parameters you entered as a new
Quick Report.

If you selected Save as, type a name for the report (this is the

> Elul) report's file name, not its title).

Select the type of report (User, School, Intermediate
Owner Type Organization, or District). The options available to you depend
on the view you are logged into and your privileges.

Owner Name Click ""1 to change the name of the report's owner.

2. Click Finish. The report displays the information in the format you selected.
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Use Quick Letters

Use the Quick Letters feature to quickly create and customize attendance, conduct, or grade-
related letters from any student list page for students meeting a given set of criteria. You can then
print these letters as one print job and mail them to the students or their parents/guardians.

For instance, you might use Quick Letters to create a custom form letter regarding students who
have five or more absences so far this semester. The letter would notify parents that their students
are in danger of losing course credit. You could also use this feature to create a more general letter
for all students informing them of the school attendance policy.

To create a Quick Letter, click the Quick Letter icon J on any student list page and complete
the Quick Letter wizard. For instructions on completing the Quick Letter wizard, see the "Create a
Quick Letter" Help topic.

Create a Quick Letter

On any student list page, click the Quick Letter icon J to access the following options:

« Create Quick Letter: Brings up the Quick Letter wizard, which lets you customize your Quick
Letter in detail and access saved letters.

« Attendance: Brings up a streamlined version of the Quick Letter wizard that begins on the input
page for an attendance-related letter.

« Conduct: Brings up a streamlined version of the Quick Letter wizard that begins on the input
page for a conduct-related letter.

« Grades: Brings up a streamlined version of the Quick Letter wizard that begins on the input page
for a grades-related letter.

Note: You can access the student list page by clicking the Student tab while logged on to the
District, Intermediate Organization, or School view.

To create a Quick Letter:

On any student list page, click J and select Create Quick Letter. The six-step Quick Letter
wizard appears:
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Quick Letter: Source Step 1 of 6

Source

& MNew letter

Saved letter

= Badk Mesxt = Finish Cancel

Step 1: Source

Do one of the following:

o New letter: Select this option to create a Quick Letter from scratch. Then click Next.

« Saved letter: Select this option to either resend a saved Quick Letter or use it as the basis
for a new letter. A table of saved Quick Letters appears. Select the letter you want to re-cre-
ate or use as a basis for a new letter. Then either click Next to skip to Step 3 and customize
your letter, or click Finish to re-create the letter without any changes.
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Step 2: Letter Type

Quick Letter: Letter Type Step 2 of 6

Letter Type Quick Letter - Attendance ¥

= Back Mesxt = Fini

1. Click the Letter Type drop-down to select the type of Quick Letter you want to create:
« Quick Letter — Attendance: Creates a letter for students who meet certain attendance cri-
teria, such as having four or more absences in the past month.

« Quick Letter — Conduct: Creates a letter for students who meet certain conduct criteria,
such as having more than one suspension in the semester so far.

« Quick Letter — Grades: Creates a letter for students who meet certain grades criteria, such
as having a GPA less than or equal to 2.0.

2. Click Next.
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Step 3: Input

Quick Letter: Input Step 3 of 6
Organization Follett Schools
School Crow Point High Scheool

CET
TR
Students to include
Search value I:l

Exclude

Code Ressons Dperator Valus Conneclor
. . =fce Desmm =gl —EuE sed oo
1st criteria ==
i * Absences | v v oo o And ¥
section Tardies | M oo O And ¥
e Dismissals v ¥ oo O And ¥
—
| v v ¥ Joo And ¥
2nd criteria * [~ v v oo And ¥
section | v v ¥ oo And ¥
| v A ¥ oo

= Back Mesxt = Finish Cancel

1. Use the following table to enter information in the fields:
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Field Description

Start date Type the start date of the date range you want to search for
(Attendance and attendance records or conduct incidents within, or click B and
Conduct letters only) select it from the pop-up.

End date Type the end date of the date range you want to search for
(Attendance and attendance records or conduct incidents within, or click EH and

Conduct letters only) ~ Select it from the pop-up.

Click Q . The Transcript Definition Pick List appears. Select the
transcript definition used by the school that the students you want
to create a Quick Letter for attend. The fields of this transcript
(Grades letters only) definition become the criteria that you can choose from when
determining which students to create the letter for. Click OK.

Transcript
Definition

To further limit the set of students who meet your Quick Letter's
criteria, select one of the following options:

« Current selection: Only includes students within the current fil-
ter on the student list page.

« YOG: Only includes students who have a specific year of gradu-
ation. You can specify the YOG at the “Search value” field.

Students to include

« Snapshot: Only includes students who are part of a specific
saved snapshot. You can specify the snapshot at the “Search
value” field.

If you selected YOG or Snapshot at the “Students to include” field,
Search value type the specific YOG or snapshot name you want to restrict your
search to.

Criteria

« The 1st criteria section includes a selection of preset, common attendance
codes (for attendance-related letters) or conduct record types (for conduct-
related letters) that you can use as criteria for your letter.

« The 2nd criteria section lets you select other attendance codes or additional
instances of conduct record types as criteria from drop-downs.

Note: Grades-related letters do not have a 1st criteria section, since the transcript definition
fields you use as criteria vary depending on the transcript definition you select.

Code To include other attendance codes in your criteria than those listed
by default in the 1st criteria section — Absences, Tardies, and

(Attendance letters Dismissals — select those codes from the drop-downs in the 2nd

only) criteria section.

Type To include more instances of the conduct record types listed by
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Field Description

(Conduct letters
only)

Fields

(Grades letters only)

Reasons

(Attendance letters
only)

Code

Operator

Value

default in the 1st criteria section — Incidents and Actions — in your
letter’s criteria, select those types from the drop-downs in the 2nd
criteria section.

For example, you might want to create a Quick Letter for students
who have either more than one suspension or more than four
detentions in a date range. In this case, you would need to have
two Incidents rows, one for suspensions and one for detentions.

Click the drop-downs to select the transcript definition fields you
want to use as criteria.

To restrict your criteria to include only students who have an
attendance code paired with a specific reason, select the reason
from the drop-down.

For example, to create a Quick Letter for students who had
absences due to illness, in the Absences row, select Sick (or
another value) from the Reasons drop-down.

To restrict your criteria to include only students with a specific type
of conduct incident or action, select the appropriate code from the
drop-down.

To restrict your criteria to include only students with a certain
number or range of attendance codes, conduct records, or grades-
related criteria, select the appropriate numerical operator from the
drop-down.

For example, to create a Quick Letter for students who had one or
more suspensions in a date range, you would select Greater than
or equal to as an operator and type 1 in the Value field.

Note: If you leave the Operator and Value fields blank, the letter's
criteria will include all students who have any value in their
student record for the attendance code, conduct record type, or
transcript definition field defined in that row.

For example, say you want to create a generic letter to all
students detailing the school’s attendance policy. You could
create an attendance-related Quick Letter, and leave the Operator
and Value fields blank in the Absences, Tardies, and Dismissals
rows. This would include students who have any value, including
none, for those fields in their attendance records.

If you selected an operator to restrict your criteria to include only
students with a certain number or range of attendance codes,
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Field Description

conduct records, or grades-related criteria, type the value modified
by that operator.
Exclude excused Select this checkbox to exclude from your criteria any instances of

(Attendance letters that row’s attendance code that were excused by a teacher or staff

only) member.
To include multiple criteria, select one of the following connector
options from the drop-down:

Connector « And: Searches for students who satisfy both the criterion defined

in that row and the criterion defined in the next row.

« Or: Searches for students who satisfy either the criterion defined
in that row or the next row.

2. Do one of the following:

« Click Next to customize the header for your Quick Letter.

« Click Finish to create the letter using the default or saved header, body text, and options set-
tings.

Step 4: Create Header

Quick Letter: Create Header Step 4 of 6

HE B MLOR E|= = = == HE || 3= 3= || [ Source || 23

Arial - || 12 - || Format - A-B-|B I U|| x x*||T,

Follett Schools

Attendance Letter
Jul 29, 2014

body table tbody tr td V|

= Back MNext = Finish Cancel

-44 -



Managing Student Information

Customize the header that appears on your letter using a modified version of Aspen’s rich text
editor. For instructions on using the additional tools included in the modified editor, see Step 5.

When creating a letter, certain information appears in the header by default. Your district name is
displayed in the header’s top-left corner, the school name in the top-right (if you are creating a
Quick Letter at the school level), the date in the bottom-right, and the letter type in the center. To
customize the default header, do the following:

1. Make your modifications using the rich text editor.

Note: For more information on using Aspen’s rich text editor, see the “Using the Rich
Text Editor” Help topic.

2. Do one of the following:

» Click Next to customize your Quick Letter’s body text.
« Click Finish to create the letter using the default or saved body text and options settings.

Step 5: Create Letter

Quick Letter: Create Letter

Step 5 of 6
EH HWdO R == = — P — s |22 2| [ source || 52
Font » || Size ~ || Format - A-B- | B I U| x, x*| T,
A
< Badk Mext = Finish Cancel

1. Type the body text for your Quick Letter using a modified version of Aspen’s rich text editor.

In addition to the standard text and media editing tools, the modified rich text editor provides

three additional tools designed for Quick Letters. Use the following table as a reference for
using these tools:
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Function

Field: Use this tool to insert a field, such as “Student name,” into the text box.
When you complete the Quick Letter wizard, this field is populated with the
appropriate information for each student.

Toinsert afield in your Quick Letter, click the icon. The Add Field pop-up appears:

Add Field b1

Student v

15t Time 9th Grade

504 last end date

504 status

8th Gr 1st day room

ACT GE 20 Ind

AM Bus route

AN Shuttle

Abarginal Ancestry

Abariginal Status

Academic Program -

OK C I
ance »

Click the drop-down to select the appropriate table for your field. For instance, if
you want to add a field for the student’s State/Province, you would select the
Physical Address table. The pick list refreshes to display all fields in that table.
Select the appropriate field, and click OK.

Note: Table and field names are determined by your Aspen system
administrator, and might differ from those shown.

Expression: Use this tool to insert an expression into the text box. Expressions
are variables that call and display information from the student record of each
student included in the letter’s criteria. They can also be modified by filters that
alter their output.

For example, you could use this tool to insert an expression in your letter's body
text that displays a pronoun (‘He” or “She”) based on the gender code in the
student record.

Toinsert an expression in your Quick Letter, click the icon. The Add Expression
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Function

pop-up appears:

Add Expression x

Expression Input

|

Cancel
Bl oo |,

Type the expression in the Expression Input field, and click OK.

Calculation: Use this tool to insert a predetermined calculation, such as the
student’s total number of suspensions, into the text box. When you complete the
Quick Letter wizard, Aspen evaluates this calculation for each student included in
the letter’s criteria.

Toinsert a calculation into your Quick Letter, click the icon. The Add Calculation
pop-up appears:
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Function

Add Calculation X

Total # of absences -
Total # of tardies

Total # of dismissals

Total # of unexcused absences

Total # of unexcused dismissals

Total # of other codes

Cancel
| concer |

Select the appropriate calculation from the pick list, and click OK.

2. When you are finished customizing your Quick Letter's body text, do one of the following:

« Click Next to adjust the letter’s options.
« Click Finish to create the letter using the default or saved options settings.
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Step 6: Options

Quick Letter: Options Step 6 of 6
Options
Don't save
Save
®) Save as
Name
Owner
Type School T
Name Gary Caks Secondary SD 72 Q
= Back et = Finish Cancel

1. Inthe Options section, select one of the following:

» Don’t save: Aspen does not save the letter. This is the default setting.

« Save: Aspen saves the letter using previously-provided name and owner information. This
option is only available when customizing a previously-saved Quick Letter.

« Save as: Aspen saves the letter using the name and owner information you provide in Step
2.

2. If you selected “Save as”, use the following table to fill in the letter's name and owner inform-
ation:
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Field Description

Name Type afile name for the letter.

Owner

Click this drop-down to select one of the following, depending on your
user privileges:

« User: Gives a user or yourself access to the letter.
Type « School: Gives users at a school access to the letter.

« Intermediate Organization: Gives all users in an intermediate
organization access to the letter.

« District: Gives all users in the district access to the letter.

Click Q . A pop-up lists the organizations or users you selected in
Name the Type field that you have access to. Select a specific owner for the
letter, and click OK.

3. Click Finish. The letter appears.

Print Labels in Aspen

When printing any kind of address label report, there is a setting in Adobe Acrobat that must be
changed for the print to align properly with the label grid.

Adobe Acrobat employs Page Scaling when you print a document so that it fits within the limits of
your printer's margins. Most printers cannot print to the left and right edges of a page, so the default
setting in Adobe is Shrink to Printable Area. This is fine for most reports but can cause trouble
with labels where positioning is critical.

To correct this problem, change your settings for Page Scaling to None and Zoom to 100% when
you print your labels, as shown in the following screenshot:
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Priviat
Hana: |2 Laamark 1630 o Dot |
Qubus: Faady Comments and Forms: |
Type:  Lemark T630 | Diocument and Markups -
Prek Range Prenvaw; Composte
"y ; 85 i
" Cumert yiew .
| E = B
L = = =
ap [Upwnone < = ==
- .
Page Handing — A
Golsi  [1 2] F il
Lo s
P dcdrg:  [terktofrribedms v =
v utootatgt JRgrable Area D{_ T
shirk to Printable Area = =
_dm WEMM e e
Printing
\ 4
, This shodld
" el Change s sefing o “None” "“"""“I b 100%
1t |
pﬁrmm: Atvared ¥ 4 Cancel |
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Commonly Used Label Sizes in Aspen

The following table lists the dimensions of commonly used label sizes in Aspen.

Band height in iReport is 72 pixels.

Label Size 02x05
Length 4"
Height 2

Top Margin 0.5”
Bottom Margin 0.5
Right Margin 0.18”
Left Margin 0.18”
:-Igzrtitzcr))ntal Spacing 0.14”
Vertical Spacing o

(gutter)

02x10
4"

T

0.5"
0.5"
0.175"
0.175”

0.15625"

Oll

02x15
3.4375”

0.667"
0.5”
0.5”
0.5”
0.5

0.557”

Ou

03x10
2.5935"

T
0.5"
0.5"
0.1875"
0.1875"

0.15625"

Oll

Maintaining Student Information

After you search for and select a student on the Student tab, you can enter, edit, or view that
student's information on the side-tabs. You can enter or view the following information:

« Details, such as address and ethnicity
« Student alerts

« Contacts

« Attendance

« Conduct

« Transcript

« Assessments

o Credit Summary

« Grade Point Summary
« Schedule

« Requests

-52-



Managing Student Information

« Enroliment

« Programs

« Events

« School Associations
« |IEPs

« Documents

o Fees

You can also view information for archived students.

View Archived Students

In Aspen, you view archived students in the History School. Students are archived to the History
School when you execute Step 5 of the End-of-Year Rollover wizard.

To view archived students in the History School:

1. Onthe settings bar, click Select School.
2. Select the History School, and click OK.

Student Alerts

Student alerts are important bits of information about a student that are represented by anicon
next to the student's name on student pages. These icons alert users to information they should
know about a student.

Create the following types of alerts for students:

¢ Medical alerts E can inform users about a student’s medical condition.

88

« Other alerts can inform users about any other important information staff members should
know about a student. When you create an Other alert, you select the icon you want to appear.
For example, you might create an Other alert to let users know that a student has a change in

(s |
transportation this week, and use the Transportation Alerticon &==.

« Legal alerts can inform users about certain legal situations they should be aware of.

Note: The system contains over 150 icons you can use to represent Other alerts. You
must add these icons to the Alert Icons reference table to make them available.

» Quick Status alerts 1:3 can be used to quickly view where a student currently is in the school,
based on their schedule.

o Education Plan alerts, such as a 504 Plan alert , appear if a student has an active edu-
cation plan. Your district can select which alert appears for which education plan.
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« Cross-Enroliment alerts |”*|indicate that a student is taking classes or receiving services at
more than one school.

« Daily Absence alerts IE' indicate that a student has been marked absent for all or part of a

day.

Create Medical, Legal, and Other Alerts

Use alerts to let users know about a student’s legal situation, medical condition, or any other

i3

information users should know about a student. After you enter an alert, the Legal Alert or

Medical Alert T icon appears next to the student’s name on the Student pages in Aspen. Only
users with appropriate privileges can see these icons.

To enter Medical, Legal, or Other Alerts:

Log on to the District or School view.

Click the Student tab.

Search for and select the student.

Click the Details side-tab. The Details page for that student appears.

Click the Alerts sub-tab. The page displays any Legal, Medical, or Other alerts already created
for the student:

o s~ 0N~

Pages School Student Staff Attendance Conduct  Marks Assessment  Timetables Global Admin

Options Reports Help
T (< lalein
IDet il - Concel Default Template -
ails
n Demographics  Addresses Ethnicity Alerts Photo
C
Attendance Legal
Conduct ||5eqNu |De§criptiur| |
= = | Ne matching records |
Transcript
e
- S medical
et Seatlo Description
Membership 0 Grace is prone to nose bleeds
1 Grace is sllergic to peanuts
Tran
Delete
Docu
Other
Snapshot
Seqlo Description lcon
No matching records
e
e
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6. Do one or more of the following:

« Click Add below Legal to add a Legal alert.
« Click Add below Medical to add a Medical alert.
« Click Add below Other to add an Other alert.

The appropriate dialog box appears.

7. Type the Sequence Number for the alert you are creating.

8. Type aDescription of the alert.

9. Click Save. The system displays the appropriate icon next to the student’s name.

10. Toview the alert, click the icon.

View a Student's Current Location

If your school’s schedule is built with your school’s bell schedule, your users can view a student’s
Quick Status on the Student List or in the gradebook.

To view a student’s Quick Status:

1. Do one of the following:

« Log on to the District, School, Special Education, or Health view. Click the Student tab.
Select a student.

« Logonto the Staff view. Click the Gradebook tab, select a class, and click the Scores
side-tab. On the Scores side-tab, click a student’s name.

2. Click the Quick Status Alerticon ﬂ next to the student’s name. The Quick Status dialog box
appears:
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Student

| Adam, Kathleen

Class

Teacher

Location

Time B/25/2008, 5:28 AM
Current pericd AT8:00 AM -9:30 AM]
Class 158230003 - Standard Biclogy J'Sr
Teacher Bardan, Yenitza
Location 080 @ Crow Point High Schocl North
Next period B [9:20 AM - 11:00 AM]

16211-0004 - Algebra |
Barboss, Filomens

353 @ Crow Point High Schoel North

Caily attendance

Yearto-date attendance
Unexcused absences
Excused absences
Tardies

Term-to-date attendance
Unexcused absences
Excused absences

Tardies

Af3)

28

| 26

Term 4

(5]

Cancel

The student’s name and current date and time appear.

Then, the student’s current class information appears, including class name, teacher, and
location. The student’s next class information also appears. If you check a student’s status
during a class period that overlaps with another, the box displays a drop-down menu. Select the
class you want to view.

Note: If your school built a schedule without bell schedules, the system cannot display
current and next class information.

At the bottom, the box displays a summary of the student’s attendance, including:

« Today’s attendance, if any. If the student has been absent for multiple days in a row, the num-
ber of consecutive absences displays next to the code. For example, if the student is absent
for the third consecutive day, A(3) appears next to Daily Attendance.

« Year-to-date attendance, including unexcused absences, excused absences, and tardies

« Term-to-date attendance, including unexcused absences, excused absences, and tardies

View a Student’s Cross-Enroliment Status

Sometimes, a student will take classes or receive services at another (secondary) school while

attending your school. The Cross-Enroliment alert indicates that a student is taking classes
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or receiving services at more than one school.

Note: A student can be associated with a secondary school in all views using the Student
tab, Membership side-tab, Schools sub side-tab, Options > Add. School users can also
select Create Secondary School Associations (School view, Student tab, Options).

The alert appears in the breadcrumbs on student details pages, on student pages that have an
Alerts column in the field set, and in the gradebook (if allowed by System Administration
preferences and a teacher’s gradebook preferences).

Click to view the details of the student’s cross-enroliment status.

Cancel |

Cross-enrollment Alert

Hame Beliveau, Ryan

Primary school Belmonte Middle School

Secondary school(s)

School » Name Year |Start End Type AtthagType

Gary Oaks Secondary 50D 73 2014 07082013 04/08/2014 Secondary |[Mone

| Cancel

View a Daily Absence Alert

Aspen generates a Daily Absence alerticon IE‘ to indicate that a student was marked absent for
all or part of a day. The alert appears in the breadcrumbs on student pages, on student pages that
have an Alerts column in the field set, and in the gradebook (if allowed by System Administration
preferences and a teacher’'s gradebook preferences).

Click IE' to view the details of the student’s absence:
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Close

Daily Absence Alert

Student Meyers, Noah

Date 2014-0403

Daily Attendance Present

Class Absence(s)

Pericd Course > CrsHo Course = Description Code

5] 805m Science & A
Close

The Daily Absence Alert section shows the student’s name, the date, and the attendance code
entered when daily attendance was taken.

The Class Absence(s) section appears if your school also takes class attendance, and a student
has at least one class attendance absence record for the current day. It displays the period number,
class name, number, and attendance code for each period the student was marked absent.

Create Education Plan Alerts

Create Education Plan alerts when you create an education plan record, such as a 504 plan.

Note: Depending on your user role privileges, you may be able to create a student's education
plan from the Student tab, Ed. Plans side-tab in the School, District, Staff, Health, and Special
Education views. Family portal users may have view access to the plan.

To create an education plan record:

1. Log on to one of the following:
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« School view

« District view

« Staff view

« Health view

« Build view

« Special Education view

Click the Student tab.
Search for and select the student.
Click the Documents side-tab, and then click Ed. Plan.

Click to select the type of education plan, such as a 504 plan.
Enter the required information.
At the Status field, select Active.

Click Save. After you save an active education plan, the alert for that education plan appears
for the student. Your district can determine the alert icon that appears for each education plan.

® N o o b~ w DN

Determine the Alert Icon for an Education Plan

You can determine the alert icon that appears for education plans in your district.

To determine the alert icon for education plans:

Log on to the District view.

Click the Admin tab.

Click the Data Dictionary side-tab.

On the Data Dictionary side-tab, click Extensions.
Find and select the STD-EPP-PLAN extension.

6. Select the General Ed Plan checkbox.

7. Click the lcon drop-down to select the icon. As you scroll through the list, the icon appears next
to the field:

a s~ DN~
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Pages District Staff  Attendance Conduct  Grades  Assessment Schedule Global Tools Admin
Options Reports Help

7]
Extensions :: STD-EPP - Educational Proficiency Plan EE|THH|

Cancel Default Template =
Users

Licenses L STD-EPP

MName * Educational Proficiency Flan

Security

Description Dictionary for the Standard Educstional Proficie

Tables ——
Category Student -

Extensions
——— Parent dictionary > Name Qx
L= Health? =
Reference Special Ed? [&]
Calculated pD? [}
Fields
General Ed Flan?

Forms - Education Proficiency Plan =

Workflows

Widget Definitions

8. Click Save. The icon appears as an alert icon for students with an active education plan.

View an IEP Alert

On Student pages, the IEP Alert icon appears next to a student's name if the student has an
active IEP:

Pages School Student Staff Attendance Conduct Grades  Assessment Schedule Global Admin

Options Reports Help El
Student List :: 11 - Adams, Tyler 5 7¥ @iee] A (] <] Q] »]>]
Cancel Detault Template =
" Demographics | ol | o Alerts Photo
Contacts
Attendance First name * Tyler Gender Fow
Conduck Middle name William Date of birth 5181884 B ape 17
. Last name * Adams Phone 1 (781} T41-8508

Transcript

Suffix - Phone 2 817) 741-4799
Assessments — —

Local identifier 224740 Phone 3 (413) T40-5673
Schedule State identifier 7817402679
Membership
Transactions EEEIBlET Crow Foint High Schoal Home language English Q

£ ae

Click the IEP Alerticon to view a summary of the student's |IEP:

-60 -



Managing Student Information

This summary information is NOT the entire Individualized Education Plan.

Mame Adams, Tyler
Start date 11/8/2010
End date 11752011
IEP type Re-evaluation

Ed. envirenment §-21 Full Indusion

(DOE34)

Case Manager > Name Bragel, Lehrer

Accommodations

Content&rea Category Name Deszcription

Mo matching records

Curriculum Accommodations

Heeds Accommodations

Assessments Accommodations

Customize Other Alert Icons

The system contains over 150 icons you can use to represent Other alerts. You must add these
icons to the Alert Icons reference table to make them available. This way, you can control the
types of Other alerts users can create. Other alerts are grouped by the icons users select to
represent them.

Users select the icon they want to use at the lcon drop-down when creating an Other alert.

To add icons to the Alert Icons reference table:

Log on to the District view.

Click the Admin tab.

Click the Data Dictionary side-tab.

On the Data Dictionary side-tab, click Reference. The list of system reference table appears.

Search for and select the Miscellaneous Icons reference table, and click Codes on the side-
tab. The list of available icons appears:

o DN~
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District

Pages

Options Re

Student Staff

ports Help

Attendance

Reference Tables :: Miscellaneous Icons

Conduct

Grades

Assessment

Schedule

Global

Tools

Y

CIRIENIA )

==

N <| 1: alerticens/br_achievement.png - 0 of 155 selected (7 Enabled Codes
[ |Code Description Local State Fed Disabled NumericLevel
Security
[£] [slerticens/or_schisvement png Achievement N
Tables [ |aterticons/be_sdmissions.png \Admissions N
Extensions (@] fbr_ prg \Agronamy N
alerticons/br_srchitecture. png itecture
Reference lerticons/br_srchitect |Architec N
Detail
1= [ [slerticens/br_sris.png |Arts N
» Codes
— [7] [slerticons/or_st_cless.png |Art class N
Calculated [ |alerticons/br_sttendance_list prg |Attendance list N
Fields [ |aterticonsibr_backpackz png Backpack N
[ |alertioansibr_biclogy. prg Eiology N
Forms
[£] [sterticens/or_blackbosrd.png Blackboard N
Warkflows [ |aterticons/be_calculater.png |Calculator N
Widget =] /br_chemistry. png IChemistry N
Definitions [ |aterticans/tr_dlsssmate.png Clazsmete N
System Status |18 i (Classroom N
[£] [slerticens/or_coliege. png (College N
Logs
[ |slertloons/br_computing.png Computing N

icons.

7. Click the Reference side-tab.

Pages

Options Re

District

Student Staff

ports Help

Attendance

Conduct

Type or paste the icon name in the Code field:

Grades

Assessment

Schedule

Global

Tools

Copy and paste the name of the icon you want to add to your reference table for Other alert

Search for and select the Alert Icons reference table, and click Codes on the side-tab.
On the Options menu, click Add. The New Reference Code page appears.

Admin

Reference Tables :: Alert Icons :: New Reference Code - Common
Cancel Default Template -
Users
General | [
Security
Tables Code * slertlcons/br_blackboard. png
Extensions Description
Reference Local code
Details
» Codes state
Fields Federal code
Calculated Dependent Code
Fields System
Forms Disabled =]
Workflows Sequence number 0 %
I tegory?
Widget Definitions e o
Category -

System Status

Template Context

Logs

Organization |

Localized Description 1 ‘

11.

the Icon drop-down menu when a user creates and Other alert.
12. Click Save. Now, this icon is available for users to select when they create an Other alert:
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Sequence Number a
Margaret must sit near the black or - =
white board.
Description
- - H
Auto-saved at 9:09 PM [

Custom Alert Icons

When you create an Other Alert for a student, it is possible for your school to set up custom alert
icons for users to choose from.
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Code Description
alertlcons/br_achievement.png Achievement 1
alerticons/cl_achievement.png Achievement 2
alertlcons/br_admissions.png Admissions 1
alertlcons/cl_admissions.png Admissions 2
alertlcons/br_agronomy.png Agronomy 1
alertlcons/cl_agronomy.png Agronomy 2
alertlcons/br_architecture.png Architecture 1
alertlcons/cl_architecture.png Architecture 2
alertlcons/br_art_class.png Art class 1

alertlcons/cl_art_class.png

Art class 2
alertlcons/br_arts.png Arts 1
alertlcons/cl_arts.png Arts 2

alertlcons/br_attendance _

. Attendance list 1
list.png

alertlcons/cl_attendance

. Attendance list 2
list.png
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Code Description Icon
alerticons/br_backpack.png Backpack A1 ‘
alertlcons/cl_backpack2.png Backpack A2 iy,
alertlcons/br_backpack2.png Backpack B1 3

alertlcons/br_biology.png Biology 1

alertlcons/cl_biology.png Biology 2

i
—
alertlcons/br_blackboard.png Blackboard 1 H

alertlcons/cl_blackboard.png Blackboard 2
alertlcons/br_calculator.png Calculator 1 5
alerticons/cl_calculator.png Calculator 2
alertlcons/br_chemistry.png Chemistry 1
-~

alertlcons/cl_chemistry.png Chemistry 2 (=

-
alertlcons/br_classmate.png Classmate 1 ¥
alertlcons/cl_classmate.png Classmate 2 i ﬂ;‘“‘.
alerticons/br_college.png College 1 &
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Code Description
alertlcons/cl_college.png College 2
alertlcons/br_computing.png Computing 1
alertlcons/cl_computing.png Computing 2
alertlcons/br_desk.png Desk 1
alertlcons/cl_desk.png Desk 2
alertlcons/br_diplom.png Diploma A1
alertlcons/cl_diplom.png Diploma A2
alertlcons/br_diplom2.png Diploma B1
alertlcons/cl_diplom2.png Diploma B2
alertlcons/br_economics.png Economics 1
alertlcons/cl_economics.png Economics 2
alertlcons/br_electricity.png Electricity 1
alertlcons/cl_electricity.png Electricity 2

alerticons/br_elementary

school.png Elementary school 1

Icon

r

2 W e

II:'l:I

N el
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Code Description Icon

alertlcons/cl_elementary Elementary school 2

school.png &
alertlcons/br_engineering.png Engineering 1 .:h'ﬂ ,;"

IIP
alertlcons/cl_engineering.png Engineering 2 e H':
alertlcons/br_exam.png Exam 1 -
alertlcons/cl_exam.png Exam 2 z— x
alertlcons/br_e_learning.png E Learning 1
alertlcons/cl_e_learning.png E Learning 2 ||- 5 ||
alertlcons/br_foreign .

Foreign language 1

language.png P
alertlcons/cl_foreign . =
P Foreign language 2 .__.{j
alertlcons/br_forum.png Forum 1 :41:
alertlcons/cl_forum.png Forum 2 tp=pe=ri
alertlcons/br_geography.png Geography 1 Q

&
alertlcons/cl_geography.png Geography 2 y

#

alertlcons/br_geometry.png Geometry 1
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Code

alertlcons/cl_geometry.png

alertlcons/br_graduated.png

alertlcons/cl_graduated.png

alertlcons/br_graduation.png

alertlcons/cl_graduation.png

alertlcons/br_high school.png

alertlcons/cl_high_school.png

alertlcons/br_history.png

alertlcons/cl_history.png

alertlcons/br_homework.png

alertlcons/cl_homework.png

alertlcons/br_ink.png

alertlcons/cl_ink.png

alertlcons/br_kindergarden.png

Description

Geometry 2

Graduated 1

Graduated 2

Graduation 1

Graduation 2

High School 1

High School 2

History 1

History 2

Homework 1

Homework 2

Ink 1

Ink 2

Kindergarten 1

Icon

¢ L) @ oy @ |

= 6

:
1]

L' HH

[T O {

A |

(]
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Code Description Icon
alerticons/cl_kindergarden.png Kindergarten 2
=
alertlcons/br_laboratory.png Laboratory 1 .
-
alerticons/cl_laboratory.png Laboratory 2 =
i
alerticons/br_laws.png Laws 1 ~1_:
alertlcons/cl_laws.png Laws 2 =
—

alertlcons/br_lesson

planning.png Lesson Planning 1 4
alertlc':ons/cl_lesson_ e . =
planning.png 1
alertlcons/br_library.png Library 1 E
=
alerticons/cl_library.png Library 2 Bunkin

alertlcons/br_locker.png Locker A1

alertlcons/br_locker2.png Locker B1

alertlcons/cl_locker.png Locker A2 | !' !' |
n

alertlcons/cl_locker2.png Locker B2

alertlcons/br_maths.png Math 1 (E)
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Code

alertlcons/cl_maths.png

alertlcons/br_middle_
school.png

alerticons/cl_middle_school.png

alertlcons/br_music.png

alertlcons/cl_music.png

alertlcons/br_nursery.png

alertlcons/cl_nursery.png

alertlcons/br_parent_
coordinator.png

alertlcons/cl_parent
coordinator.png

alertlcons/br_physical_
education.png

alertlcons/cl_physical_
education.png

alertlcons/br_physical_
sciences.png

alertlcons/cl_physical_
sciences.png

alertlcons/br_pre_schools.png

Description

Math 2

Middle school 1

Middle school 2

Music 1

Music 2

Nurse 1

Nurse 2

Parent coordinator 1

Parent coordinator 2

Physical education 1

Physical education 2

Physical sciences 1

Physical sciences 2

Pre schools 1
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Code Description Icon

alerticons/cl_pre_schools.png Pre schools 2 T
—_—

alerticons/br_project.png Project 1 fq‘

alertlcons/cl_project.png Project 2

alertlcons/br_recreation.png Recreation 1 ﬂ

alertlcons/cl_recreation.png Recreation 2

alertlcons/br_schedule.png Schedule 1 @
alertlcons/cl_schedule.png Schedule 2 ety
alertlcons/br_school.png School 1 ﬂ
=
oo
alertlcons/cl_school.png School 2 /9918

alertlcons/br_school__ School events 1

[ %] E

events.png

ETH
alertlcons/cl_school School events 2 -
events.png ALY
alertlcons/br_scientific_ Scientific calculator 1 e
calculator.png m
ClEtes el e uiig Scientific calculator 2 |:E-|
calculator.png T

\ 4

alertlcons/br_skills.png Skills 1

?A—"‘;
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Code Description

alertlcons/cl_skills.png Skills 2

alertlcons/br_social_

. Social studies 1
studies.png

alerticons/cl_social_studies.png Social studies 2

alertlcons/br_stethoscope.png Stethoscope 1
alertlcons/cl_stethoscope.png Stethoscope 2
alertlcons/br_student1.png Student A1
alertlcons/br_student2.png Student A2
alertlcons/cl_student2.png Student A3
alertlcons/br_student3.png Student A3
alertlcons/cl_student3.png Student B3
alertlcons/cl_student4.png Student B4
alertlcons/br_study.png Study 1
alertlcons/cl_study.png Study 2
alertlcons/br_subject.png Subject 1

Icon
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alerticons/cl_subject.png

alerticons/br_teacher.png

alerticons/cl_teacher.png

alertlcons/br_teacher_day.png

alerticons/cl_teacher_day.png

alertlcons/br_technology.png

alertlcons/cl_technology.png

alertlcons/br_training.png

alerticons/cl_training.png

alertlcons/br_transportation_
service.png

alertlcons/br_transportation
service.png

alertlcons/br_tutorial.png

alertlcons/cl_tutorial.png

alertlcons/br_university.png

Subject 2

Teacher 1

Teacher 2

Teacher Day 1

Teacher Day 2

Technology 1

Technology 2

Training 1

Training 2

Transportation service 1

Transportation Service 2

Tutorial 1

Tutorial 2

University A1

Managing Student Information

Code Description

[ <
0
(]
¥ =

© @

¥

i

U' 7
[F
L=

-73-



Managing Student Information

Code Description Icon
alertlcons/cl_university.png University B1 'Iit'lil'
——
s
alertlcons/br_university2.png University A2 ‘
alertlcons/cl_university2.png University B2 I%I
alertlcons/br_veterinary.png Veterinary 1 -ﬂ
I.'\. G I
alertlcons/cl_veterinary.png Veterinary 2 e

alertlcons/br_virtual_course.png Virtual course 1

=)
alertlcons/cl_virtual_course.png Virtual course 2

alertlcons/br_whiteboard.png |
Whiteboard 1 =

alertlcons/cl_whiteboard.png Whiteboard 1 _-"—"
alertlcons/br_ Whiteboard marker 1 "f
whiteboardmarker.png r
alertlcons/ el Whiteboard marker 2 I:#
whiteboardmarker.png W

Entering and Viewing Student Details
Enter or view details such as address, year of graduation, homeroom, or activities for each student.

To enter or view details for a student:

1. Logon to the District, School, or Staff view.
2. Click the Student tab.
3. Search for and select the student.
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. Click the Details side-tab. The Details page for that student displays the Demographics,
Addresses, Activities, Alerts, and Photo sub-tabs.

. Onthe Addresses sub-tab, at the Address line 1 field, do the following:

« Type an address.
« Touse the optional validation tool to ensure the address is entered in the correct format,

click E] to validate the format of the address.

o Click Q to select an address already in the district. If you select an address shared by
another person in the district, the Shared Address pop-up displays the people the address is
shared with. This will list students, staff, contacts, or any person. It can also be a family
address. Selecting an address shares this address between the students and other people at
that address, and joins this student to a family with the others at this address. If either

already has a family, that family is used. Otherwise, the system creates a new family for
both.

You are changing a shared physical address (i

Please review the list of people sharing the old address and Add those whose address should also be changed to
the new address.

Old physical address: New physical address:

37 Bruce Dr ?:E?;Hg};?r =il

R T L P 25 Hingham, MA 02043
Adams, Laura {Student) Adeerman, James Cameron (Student
Adams, Josephine [(Student)
Adams, Margaret Ann {Contact)

If you change an address, the address is listed in the Address Changes widget in the School
view for all schools with students that share that address.
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6.
7.

8.

o Click the Shared Address icon H to view who this address is shared with. Confirm that
the people listed with the address are correct. You can click Clear to delete this address for
the current student, or you can click Detach to make a copy of the address for this student,
separating the student from others who share it.

An X appears over the shared address icon to indicate that an address is not shared.

You can import the student's photo on the Photo sub-tab.
Click each sub-tab, and enter or view the information.

Click Save.

Protect Student Demographic Information

Sometimes, a student has special circumstances that must be kept private. For instance, you
might not want another school to view the demographic information of a student who is currently ina
youth custody center.

In these situations, you can flag an active student as “private”. That way, the student’s
demographic information will not appear in a student search at a school or district that is not
associated with that student.

To flag a student as "private":

A w0 DN~

o

Log on to the District or School view.
Click the Student tab.
Search for and select the student.

Click the Details side-tab. The details page for that student displays the Demographics,
Addresses, Activities, and Photo sub-tabs.

Click the Demographics sub-tab.

6. Select the Private checkbox.

7.

Click Save.

If a private student is cross-enrolled at a secondary school, users at that school and district can
view the student’s information. The student must be associated with the secondary school before
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he or she is marked private; otherwise, the private flag will prevent the secondary school from
finding them in Aspen and enrolling them.

If a cross-enrolled private student withdraws from their primary or secondary school, they are still
marked private at the school they still attend.

View Changes to Student Demographic Information

If a new student enrolls in your school, or a staff member changes audited demographic
information on a student’s record, Aspen lists the changes on the Student Changes widget on your
School view's Home page. (The Root Organization specifies which student fields can be audited
in the Data Dictionary.)

To use the Student Changes widget on the Home page:

At the Choose a time period drop-down, select one of the following to determine how many
records you want to view:

« Today

« Last 7 days
o Last 30 days
« Last 60 days

Student Changes Edit
Today -
LASID Student Field Date/Time Changed  Changed By
2018085042 Aldred, Alana Athletic Emergency Form Winter, . (4)02/04/2014 2:20 AM Systemn, Admin
2018040108 Barresi, Julia Enrcliment status 03042014 2:02 AM  Support, Aspen
2018040108 Barmresi, Julia Enrcliment status 03042014 8:50 AM  Support, Aspen

For each change, the following appears:
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« LASID

« Student: Click the student’s name and a pop-up appears, listing the user who changed the
record, the type of change, the date and time it was made, the field changed, and its previous
and current values.

« Field
« Date/Time Changed

« Changed By: Click the user name to view the details of who changed the record, including their
school and school phone number.

To customize how the student changes appear:

1. Click Edit at the top of the Student Changes widget. The Student Changes page appears:

Student Changes

Filter students by @ guery D) Snapshot

Selact filter Q,

|_ssve [ concel |

2. Atthe Filter students by field, you can select Query or Snapshot if you want to view changes
for specific students only. For example, a guidance counselor might create a snapshot of his or
her students to watch for address changes.

3. At the Select filter field, click Q to select the query or snapshot you want to filter by, if any.
4. Click Save.

Create Medical, Legal, and Other Alerts

Use alerts to let users know about a student’s legal situation, medical condition, or any other

i3

information users should know about a student. After you enter an alert, the Legal Alert or

Medical Alert T icon appears next to the student’s name on the Student pages in Aspen. Only
users with appropriate privileges can see these icons.
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To enter Medical, Legal, or Other Alerts:

Log on to the District or School view.
Click the Student tab.
Search for and select the student.

Click the Details side-tab. The Details page for that student appears.
Click the Alerts sub-tab. The page displays any Legal, Medical, or Other alerts already created
for the student:

o~ DN~

Global  Admin

o < fafir ]

Defauit Template B

Marks  Assessment  Timetables

Attendance Conduct

Pages School Student Staff

Options Reports Help
Student List :: 12-Adams, Abagail § [E2) [\
[Lseve [ conse

Demographics | Addresses Ethnicity Alerts Photo

Legal

[[oeats Dencrpion |

No matching records |
e
Medical
Seqhlo Description
o Grace is prone to nose bleeds
1 Grace is allergic to peanuts
e

Seqlio Description lcon
No matching records

6. Do one or more of the following:

« Click Add below Legal to add a Legal alert.
« Click Add below Medical to add a Medical alert.
« Click Add below Other to add an Other alert.

The appropriate dialog box appears.

7. Type the Sequence Number for the alert you are creating.

8. Type aDescription of the alert.
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9.
10.

Click Save. The system displays the appropriate icon next to the student’s name.

To view the alert, click the icon.

Import Student Photos

You can include student photos in the students' details. Either add photos one by one, or import all
student photos at the same time (such as after you receive a disk of photos from the photographer).

Click here for troubleshooting tips.

To import an individual student’s photo:

N ook w2

Log on to the School view.

Click the Student tab, and search for and select the student.
Click the Details side-tab.

Click the Photo sub-tab.

Click Import.

Find and select the photo.

Click Save.

To import all student photos:

a A~ 0N~

w N =

Log on to the School view.

Click the Student tab.

On the Options menu, click Import Photos. The Import Photos dialog box appears.
Click Browse to find the zip file containing the photos.

At the Filenames based on field, select if you want the system to match photos to student
records by LASIDs, SASIDs, or personal identifiers (such as Social Security numbers).

Click OK.
If you're having trouble importing photos of students or staff into Aspen, check the following:

« The district preferences should list the file type(s) of the photos that you are importing.

. Logonto the District view.

Click the District tab.
On the Setup side-tab, click Preferences. The general preferences page appears:
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— _ R EEEREEEH————wwss
Pages [ District Student Staff  Attendance Conduct Grades  Assessment Schedule Global Tools  Admin

Options Repaorts Help
Organization Setup :: Aspen Public Schools |« « > >
Cancel Category: | Gereral v
seareh Suppensd Locsles
results
. —
ELLLRETER | Snapshot maximum size
(o2
. ‘Search timeout 120
Organizations
. Lo
@ppmed photo types. [ieg ™
Senoots Lot
Audit enabled
Events Auto save interval (minutes) Locale 5

Address Format
People Required session days Address Format

Address Line 1

i
i
i
o

Grid Codes List Options.

Address Line 2

Addresses Records per page 5

Address Line 2

o
a
§
£
i
)

Pages per window

=

fope

Contacts

4. At the Supported photo types field, confirm that the photo file type(s) you are importing are lis-
ted here. The default photo type value is set to jpg. You can import only images of the types that
are entered here.

« The photo files must be stored directly in a zip file, not in a directory within the zip
file.

« |f the photos do not import, they might exist in a directory within the zip file. For example, the
zip file called studentphotos.zip might contain a directory called Seniors, which contains
all the senior students' photo files. These photo files should be zipped without putting them
in a directory.

« The zip file should only contain image files.

« Each photo file within the zip file should be named based on a student/staff identifier field.

« The photo files can be named based on the LASID, SASID, or MEPID. When importing mul-
tiple students' photos, this identifier needs to match the selection in the Import Photos dia-
log box:

5. Logon to the School view.
6. Click the Student tab.

7. Onthe Options menu, click Import Photos. The Import Photos dialog box appears:

Import Photos

Zip file [ | Browss... |

IFiIenamEE based on | Local identifier J&°4 |
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8. Atthe Filenames based on field, select the identifier the photo file is named so the system can
match the photos to the student records by the identifier.

You can easily find all students or staff in your district or school who do not have a photo in their
Aspen record by using a query.

Search for Students or Staff Without Photos

You can easily find all students or staff in your district or school who do not have a photo in their
Aspen record by using a query.

To search for students or staff without a photo in their Aspen record:

Log on to the District, Intermediate Organization , or School view.
Click the Student tab.
From the Options menu, click Query.

E

In the upper-right corner drop-down, select Direct SQL Mode:

New Query Direct SQL Mode  w

SELECT * FROM STUDENT

WHERE STD_PSN_OID NOT IN

(SELECT PSN_OID

FROM PERSON, PERSON_PHOTO
WHERE PSN_PHO_OID_PRIMARY = PHO_OID)

?hjsmedmnn Active Students - E:rfdr":i'ﬁ to inease
[ search | | cancel | [New|[ Savess.. |[ Seleat..

5. Under SELECT * FROM STUDENT, copy and paste one of the following queries in the field:

To find students without photos:

WHERE STD PSN OID NOT IN
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(SELECT PSN OID
FROM PERSON, PERSON PHOTO
WHERE PSN PHO OID PRIMARY =
To find staff without photos:
WHERE STF PSN OID NOT IN
(SELECT PSN_OID
FROM PERSON, PERSON PHOTO
WHERE PSN PHO OID PRIMARY =

Click Save As.

In the Save As dialog box, enter a Name for the query.

Click Save.

Click Search. The query can now be run from the Student tab.

© © N o

Assign Next School for Students

In the District view, automatically assign students to schools for the next school year. The system
uses a student's grade level, and address grid code, if enabled in your system.

To assign next schools for students:

1. Logontothe District view.
2. Click the Students tab.
3. Select the students you want to assign next schools for.
4. Onthe Options menu, click Show Selected.
5. Onthe Options menu, click Assign Next School. The Assign Next School dialog box
appears:
Students to update 4
Cnly if blank W

e

The number of students to update, based on the students you selected, appears.

6. Select the Only if blank checkbox if you want the system to assign a next school for students
whose Next School Name fields are blank.
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7. Select the Reset grid code variances checkbox if you want the system to update the values in
the selected students’ Next School Name fields based on their address grid codes, regardless
of their current schools.

8. Click OK.

Enter or View Student Contact Information

Enter or view contact information for each student.

It's best to enter the contact information, and when applicable, share the contact among students
when first entering a student's details. If it's not possible, you can always enter and share the
contact at a later time.

To enter or view contact information for a student:

Log on to the District, School, Staff, or Health view.

Click the Student tab.

Search for and select the student .

Click the Contacts side-tab. The student’s Contacts page appears.
Do one of the following:

o~ 0N~

« Toview information for an existing contact, select the contact, and click Details on the
Contacts side-tab.

« Toadd anew contact, on the Options menu, click Add. The New Student Contact page
appears:

]
Pages District |'SHdent!| Staff Attendance Conduct Grades Assessment
Options Reports Help

([ <o f>Jir]

6. Inthe Last Name field, type a contact name. If the contact name already exists in the system, a
pick list with the matching name(s) appears.

7. If you select a contact already entered for another student, the contact is shared. The information
that is shared for that contact automatically appears in the Shared Contact portion of the page.
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If you update or edit this shared contact information, the system updates the information for all
students who share that contact.

8. Click ‘ﬂ. to see the other students associated with this contact. Click Clear to stop sharing
this contact with other students.

9. Customize your preferences for the contact with the following fields:

Reference table Description

Enter a number to indicate the contact’s priority. O is
considered the highest priority. In case of an

Emergency priority emergency, the contact with an emergency priority of 0
will be contacted first, 1 will be contacted second, and
soon.

. . Click this drop-down and select the contact’s relation to

Relationship

the student.

Select this checkbox if the contact lives with the

Contact lives with student
student.

Select this checkbox if the contact is mailed the

Receive grade mailing student's grades

Select the checkbox if the contact is mailed the

RESRTS G ) student’s conduct incidents.

Select this checkbox if the contact is mailed some other

Receive other mailing notification regarding the student.

Receive email Select this checkbox if the contact receives emails.

10. Click Save.

View a Student's Current Location

If your school’s schedule is built with your school’s bell schedule, your users can view a student’s
Quick Status on the Student List or in the gradebook.
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To view a student’s Quick Status:

1. Do one of the following:

« Logonto the District, School, Special Education, or Health view. Click the Student tab.
Select a student.

« Log on to the Staff view. Click the Gradebook tab, select a class, and click the Scores side-
tab. On the Scores side-tab, click a student’s name.

2. Click the Quick Status Alerticon Q next to the student’s name. The Quick Status dialog box

appears:
Student Adsm, Kathleen
Time G/25/2008, 8:26 AM
Current pericd A [B:00 AM - 2:30 AM]
Class 158230003 - Standard Biclogy Ji'Sr
Teacher Bardsn, Yenitza
Location 080 @ Crow Point High School Morth
HNext period B [3:30 AM - 11:00 AM]
Class 16211-0004 - Algebra |
Teacher Barboss, Filomena
Location 352 @ Crow Point High Scheel North
Daily attendance AfF)
Yearto-date attendance
Unexcused absences 10
Excused absences 0
Tardies 28
Term-to-date attendance Term 4
Unexcused absences 1
Excused absences 0
Tardies 2

The student’s name and current date and time appear.

Then, the student’s current class information appears, including class name, teacher, and
location. The student’s next class information also appears. If you check a student’s status
during a class period that overlaps with another, the box displays a drop-down menu. Select the
class you want to view.

At the bottom, the box displays a summary of the student’s attendance, including:
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« Today’s attendance, if any. If the student has been absent for multiple days in a row, the
number of consecutive absences displays next to the code. For example, if the student is
absent for the third consecutive day, A(3) appears next to Daily Attendance.

« Year-to-date attendance, including unexcused absences, excused absences, and tardies
« Term-to-date attendance, including unexcused absences, excused absences, and tardies

Enter or View Class Attendance on the Student Tab

To enter or view daily attendance for a specific student on the Student
tab:

1. Inthe District, School, Staff, or Health view, click the Student tab. The Student List displays
the list of students at your school.

2. Find and select the student you want to enter or view an attendance record for.
3. Click the Attendance side-tab, then click Daily Attendance or Class Attendance. A list of the
student’s attendance records appears.

« Click an attendance record to view its details.

Enter or View Conduct Incident for Specific Student

You can view, edit, or enter a conduct incident for a specific student:

« from the Home page; or
« onthe Student tab.

To view, edit, or enter an incident for a specific student from the Student
tab:

1. Log on to the School, Staff, or Health view.

2. Click the Student tab.
3. Search for and select the student.

4. Click the Conduct side-tab, then click Incidents. A list of any conduct incidents entered for the
student appears.

5. Do one of the following:
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« Click the value in the Code column to view the details of a conduct incident.

« Onthe Options menu, click Add. The New Student Conduct Incident page appears. Enter
the conduct incident. Then, click the Actions sub-tab to enter any actions. Be sure to click

Save,or your entry will be lost.

Entering and Viewing Transcript Information

Depending on your user role privileges, you might be able to view and edit student grades after they
have been posted to transcripts.

You can also promote a student mid-year, and create a record for a transfer course.

To view and edit posted student grades:

1. Logon to the District, School, Build, or Staff view.

2. Click the Student tab.

3. Select the checkbox next to the student’s name.

4. Click the Transcript side-tab. The Transcript page displays a record for each course grade, each
school year:

Pages | School Student ™ Staff Attendance Conduct Grades  Assessment Schedule Global  Admin
= I = BE ®

Stuent List :: 11 - ams, Tyler AIATO Q ) EE@E}E

Current Year - HS Transcript Definition

00f8 selected &7

Final Credt Fiekla039

7es 025

a2 los

Transcript
Details.

Credit Summary 2011 1 Chemistry C & Lab
=

Concart Chair

Grade Point

Summary Academic Support 1112 E

Programs of
Study
Graduation
Summary

5. Select arecord.
6. On the Transcript side-tab, click Details. The first section of the page displays the details of the

course:
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[ ]
Pages  School Student ~ Staff Attendance Conduct Grades  Assessment Schedule Global Admin

Options Reports Help El
Student List :: 11 - Adams, Tyler :: Chemistry 4ila ¥ @ Q | «| Q » | P
[ save | cancel Defsut Template v
Updste Grades: [ ] Updste GPA: [ Updste Renk: [[| Updste Credits:
Year ID (O | School > Name Crow Faint High Schoal
Grade level 11 Cweride || School Hame A
Humber * SCI21204 Q el
Transcript o )
» Details Description Chemistry
Credit Teacher Alices, Jake; Uthman, James QxR
Summary Section number 0oz School Comment
Grade Point | creqit 0.0
Summary
Final Grade Q
Programs of
Study Excluded from rank 4
Graduation S Hide on transcript
Summary Class Type Q; Hide on report card
Assessments
B User description
Academics
Course description
SEIILE Equivalent Course

Promoting a student mid-year

If you are promoting a student mid-year, the system determines which transcript records
should appear with which grade levels on the transcript, based on the student's promotion
date. For example, if you promote a student from grade 11 to grade 12 after Semester 1, the
student's posted grades for Semester 1 should appear for grade 11 on his or her transcript.
Semester 2 grades would appear for grade 12.

If there is an exception, and you need to manually align the transcript records to appear for the
correct grade level, select the transcript record, and select the Override checkbox next to
"Grade level". The "Grade level" field displays a drop-down:

Year ID 2010-2011 Q%
Grade level 12 Overide
Humber * 031 Q

Select the grade level you want the grades that currently exist for this course to appear for on
the transcript. Then, any subsequent grades posted after the student's promotion date will
appear with the student's new grade level.

Creating a record for a transfer course

If you are creating a record for a transfer course, go to the second section of the page.
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Select the User description checkbox to specify the detailed course description for the record.

Click Qv at the Equivalent Course field to select a course from the current course catalog
that is most similar to the transferred course.

The system treats this record as the equivalent course when it calculates a student's
graduation status.

The Grades and Comments section of the page displays a list of the grades and transcript
information the student earned in the course:

Grades and Comments |T::“ 5| ﬁr =
a
1st Quarter Interim Q,
15t @ Interim Comment rd
p— I[N
15t @ Comment 1
15t @ Comment 2 |:|
2
2nd Quarter Interim Q,
2nd @ Interim Comment rd
S —
2nd @ Comment 1 |:|
2nd @ Comment 2 |:|
Mid Term Exam I:lQ
Mid Year Average I:lQ

7. Onthe right side of the page, filter the information that appears by Term and Type (term or pro-
gress).

8. Edit the grades and comments, as needed. Click Q to select a grade from the grade scale, or a
comment. If a comment column is a text comment, click on the first few words in the comment
to edit it.
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Depth Control Term Type
(Grades and Comments << 5|5 [An 9 [ =
T
Hm 292
[l Reading N /= https:/iwww.x2dev.net/?multi=falseffields=rb.... |Z||E||X|
Comprehension @ I ]
ord Analysis Q 5 records 7
Writing/Grammar ICI Q Name Id Cutoff
) (%) Basic B 2.9
Study Skills D Q oy X e
Spetiing:Word Sludy, Q O [a WA 0.0
[ wiriting B () [Moviee N 19
[ speaking/Listening/Viewing B () |secure + 39
T Etni Q ===
T1 C " a’? . i ZH

9. Enter or edit any information on the page. In the Staff view, you can only view a student's tran-
script.

10. Click Save.

View and Adjust a Student's Credit Summary

You can view an individual student’s credit summary, including how many credits he or she earned
each year in your school, and any adjusted credits.

You can also adjust credits for the student.
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To view a student’s credit summary:

1. Log on to the District or School view.
2. Click the Student tab, and search for and select the student.

3. Click the Transcript side-tab, then click Credit Summary. The student’s credit summary
appears. For each year and grade level, the page displays the number of credits that appear on
the student’s transcripts, the number of manually adjusted credits, and the total number of cred-
its the student earned that year.

4. To manually adjust the total number of credits in a year, click # inthe Adjusted Credits

column header. Enter the adjusted value, and click v .

View and Adjust a Student's Grade Point Summary

You can view the summary of a student’s GPA to see how the GPA is calculated.

To view a student’s grade point summary:

Log on to the District or School view.
2. Click the Student tab, and search for and select the student.

3. Click the Transcript side-tab, then click Grade Point Summary. The student’s grade point sum-
mary appears:

Pages School Student Staff  Attendance Conduct Grades  Assessment Schedule Glebal  Admin

Options Reports Help 2
Student List :: 11-Adams, Tyler 418 ¥ @) A e ][] [Q ][> ][p
GPA  Unweighted GRA v Grade Term Q1 -
Details
Transcript Points | Adjusted Points [Total Points Transaript Adjusted Courses Total Courses GPA
- School year Grade level Courses
Contacts rd &
2010-2011 02 25.0000 0.0000 25.0000 7.0000 0.0000 7.0000| 3.5714
SETIETE 20112012 10 24,5000 0.0000 24.5000 6.5000 0.0000 6.5000 3.7692
Conduct 20122012 1 2.8750 0.0000 2.8750 1.5625 0.0000 1.5625 2.4200
Total 53.3750 0.0000 53.3750 15.0625 0.0000 15.0625 3.5436
Transcript
Credit Course Breakdown
S y
School year Grade level Number Course description Academic level ‘Grade Column Grade Points. Weight
I(jrade Point 1,444 (] 011 English 9 € cP Final Grade 30 4.0000 |1.0000
ry
2011 03 093 Writing Seminar std Final Grade 33 2.0000 |0.5000
F;trl?g;ams of aon (] 194 World Cultures € cP Final Grade 27 3.0000 |1.0000
2011 (] 210 Honors Geometry cP Final Grade 38 3.0000 [1.0000
Graduat
o 5 2011 o3 394 Physical Science C cP Final Grade 30 4.0000 |1.0000
(] 434 Spanish 1 Std Final Grade a7 3.0000 |1.0000
Agzessmants

4. Atthe top of the page, select the GPA and the grade term as of which you want to view GPA
information.

The system calculates a basic GPA by adding the total points a student earns and dividing
that by the total number of courses the student completed (GPA = Total Points/Total
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Courses.) Therefore, for each school year, the page displays two sections of information that
the system uses to calculate the student’s GPA for that year.

The first section displays the number of points the student earned on his or her transcript,
any adjusted points, and total points. The other half of the row displays the number of
transcript courses, any adjusted courses, and the total number of courses.

5. To adjust the number of points, click in # the Adjusted Points column header. To adjust the
number of courses, click # in the Adjusted Courses column header. Enter the value, and

click E .

6. The Course Breakdown section shows the breakdown of points the student earned for each
course on his or her transcript. This is a good area to check when troubleshooting issues with a
student’s GPA.

Define Different Credits for Students in the Same Course

Sometimes, on transcript records, you might need to enter a different number of maximum credits
earned for students who took the same course.

For example, assume you create an English course to add to the transcripts of students who
transfer from another school. Some students might earn 3 credits if the course at their school was
a semester course. Other students might earn 5 credits for a trimester course. If you type 3 in the
Credit field for one student’s transcript, you do not want the system to calculate a lower rank and
GPA than it does for students who earned 5 credits for the same course.

To have the system calculate credits correctly if you enter different
maximum credits possible for the same course:

1. Enable the Potential credit override field in the Data Dictionary.
2. Add the field to the student transcript template(student.std.list.trn.detail).

Note: If your district uses a custom GPA procedure, your Aspen system administrator needs
to edit the Java source of the procedure to accommodate the potential credit override.

Managing Graduation Requirements

Track your students’ progress in completing graduation requirements at your school. Your school
can create several programs of study, which consist of several requirements that students must
meet to complete the program.

Then, you can track the progress of each student on the Student tab, Transcript side-tab. By
default, the system tracks the progress of each student for each program of study defined by your
district.

You can also print a report of students who have met or need to meet the requirements in their
programs of study.
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Creating and Managing a Program of Studies

Create and manage programs of studies. These programs contain all courses required for students
to complete them.

To create a program of study:

1. Define the shell of the program, including the program name, total number of credits, diploma
type, and description.

2. Define its requirements. The requirements are the actual categories of content that students
must complete to finish the program of studies. For example, an academic program of studies
probably contains a Foreign Language requirement.

3. Associate the courses available for a student to take to count towards completing a requirement.
For example, students might be able to take 20 credits of French, 20 credits of Spanish, or 20
credits of Italian to complete the Foreign Language requirement.

After you create a program of study, define all of its requirements, and associate courses with each
requirement, you can view student progress in completing it.

Define Details for a Program of Studies

A program of studies is the shell that contains all of the requirements students assigned to that
program must complete.

When creating a program of studies, you first define the details.

To define the details:

1. Logontothe District view.

2. Click the Schedule tab, then click the Programs of Study side-tab. A list of any previously cre-
ated programs appears. You can click an existing program to view its details:

Pages District Student Staff  Attendance Conduct Grades  Assessment Global Toels  Admin

(Options. Reparts Help Y E 82 = | u

Programs of Study
e 0 of 2 selected &7 Active
P £ [ Hame Credit  |DiplomaType Description
rograms o
Study [] |HS Gradustion Reguirements 1100 Geners | Gradustion requirements for general education stud
Details D HS Graduation Requirements 2011 - 2013 110.0 Genersl 1] Gradustion requirements for geners| education stud
Requirements
Commit
Controls

3. Onthe Options menu, click Add. The Program Studies page appears:
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Pages District Student Staff  Attendance Conduct Grades Assessment Global Tools Admin

Options Reports Help

[A
Programs of Study :: HS Graduation Requirements I« « E !E
| Defauit Tempiste ~|

Name * |HS Gradustion Requiramants]

Courses

Programs of

Stud
o Total credit * 110.0
» Details
oipioma type

Graduation requirements for general education students.

Requirements

u]

Commit
Controls

Description

Obsolete

od

Hide

4. Type a name for the program.
5. Atthe Total credit field, type the total number of credits needed to complete this program.

6. Atthe Diploma type field, select the type of diploma a student receives upon completion of
this program.

7. Type a Description.
Select the Obsolete checkbox if the program no longer applies to students.
9. Select the Hide checkbox if you want to hide any obsolete programs on the list of programs.

At the bottom of the page, any requirements already defined for the program appear:

Requirements
Expand All | Collapse All

Code Type Required unit |Description

Art \Credit 2.5 |Art including fine arts and performing arts

English (Credit 200 4 yesrs of English

English \Other 10 Pass MCAS ELA exam {minimum grade: 210}
Forsign \Credit 50 1 year of a foreign language - French, Spanish, or..
Language

Resith Credit 25 1 semester of health education

Education

Math (Credit 15.0 2 years of mathematics

Math \Cther 1.0 Pass MCAS Msth exam {minimum grade: 210)
Music (Credit 25 Musicincluding thecretical {classroom) and practi...
Cccupational | 25 1 semester of occupationsl sducstion

Educstion

P Credit s 2 semesters of physical educstion; waivers may be ..
Education

Sciencs |Credit 15.0 3 years of science

Social Studies |Credit 15.0 3 years of socisl studies induding humanities and...

Any requirement with a type of Requirement Group or Program Studies can be expanded to
view the individual rules for that requirement.

10. Define the requirements for this program.
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Define and Manage Program Requirements

Define the requirements within a program of study.

To define requirements:

. Logontothe District view.
2. Click the Schedule tab, then click the Programs of Study side-tab.

3. Select the program of study you want to define requirements for, and click Requirements on the
Programs of Study side-tab.

4. Onthe Options menu, click Add. The New Graduation Requirement page appears:

Pages District Student Staff  Attendance Conduct Grades Assessment Schedule Global Tools  Admin

Options Reports Help
Programs of Study :: HS Graduation Requirements :: Social Studies E E > »|
[ Dt Temsine 5
Programs of | Type
sl Code
Details
» Requiremen t= | Required unit ]

0y

R 3 years of social studies including humanities and history

Description

Requirement List Relation [ And W]
Code Required unit Type Description
[1|Engtish 10 Other Pass MCAS ELA exam (minimum grade: 210)
[ |English 20.0 Credit |4 years of English
Delete

5. Atthe Type field, select one of the following to determine the type of requirement:

« Requirement Group. The Requirement List box appears at the bottom of the page.

Click Add to add the requirements that must be met to complete this requirement. For
example, if you are defining the High School Elective requirement, you might add the Fine
Arts, Computer Science, Physical Education, and Music requirements. After you add one
requirement, select And or Or to determine the relationship between the requirements. Select
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And if a student has to meet all of the requirements, or Or if they can meet any of the
requirements.

o Credit. Then, type the number of credits a student must earn in the courses for this require-
ment.

o Programs of Study. The Sub programs of study lookup appears. Here, click Q to
select another program of study that must be completed to complete this program of study.
For example, you might indicate that students must complete the Technology program of
study to complete the Academic program of study.

« Other. Click Define to define the Evaluation Definition. Like a query, select the table, fields,
and operators to define the requirement. For example, your district might determine that stu-
dents must score greater than 70 on a student assessment. At the Evaluation field, click

Q to select the field that stores the value the student must have to fulfill the requirement.
Selecting the field displays the actual value the student has in that field on the Graduation
Summary page.

6. Click Save. Now, you can attach courses to the requirement.

Attach Courses to Requirements

After you create a program of study and define a requirement for that program, attach the courses
to the requirement.

To attach courses to a requirement:

1. Logon to the District view.

2. Click the Schedule tab, then click the Program Studies side-tab. The list of programs
appears.

3. Select the program, and click Requirements on the Program Studies side-tab. The list of
requirements appears.

4. Select the requirement, and click Courses on the Program Studies side-tab.
5. Onthe Options menu, click Add. The Graduation Requirement Course pick list appears:
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Course Number

School Year 2008-2007 w

School Lewvel | All W

Department All |

2: 0071 LANGUAGE ARTS 7 v 0 of 1118 selected /7
|:| Year ID |CrsHo |Description EquivalentCode

[] |2008-2007 0071 LANGUAGE ARTS 7

[] |2o08-2007 0072 |LAMGUAGE ARTS 7

|2008-2007 {0075 |MODIFIED LANGUAGE ARTS 7
2008-2007 10080 .L-'-‘\HEUAI":EAF{TE B8 {H)

|2006-2007 |oog1 LANGUAGE ARTS 8

2008-2007 |o0e3 |ALT LANG ARTS
2008-2007 0085 MODIFIED LANGUAGE ARTS 8

2008-2007 0121 MATH &

O

O

D ! !

|:| 2008-2007 |ooe2 |LANGUAGE ARTS 8
[

]

O

]

2008-2007 D122 IMATH &

Cancel

6. If you know the specific number, enter the Course number, and click OK. Otherwise, you can
filter the courses in the list by School Year, School Level, and Department.

Select all of the courses that you want to apply to the requirement, and click OK.
8. If youwant Aspen to award only a specific number of credits eared for the course to apply to the

requirement, select Modify List on the Options menu. Click the # atthe top of the Partial
Credit column. Type the number of credits you want to apply towards this requirement once stu-
dents complete this course.

For example, assume you are defining a Humanities requirement. To fulfill the Humanities
requirement, students must eamn .5 credits from an English course, and .5 credits from a Social
Studies course. The student actually earns 3 credits for each course (6 credits total), but only .5
for each apply to this requirement.

Viewing Programs of Study for a Student

View the programs of study for a student. Use these programs and students' completion of these
programs to determine their readiness for graduation. By default, all programs of study created in
the District view apply to all students.

You can also determine requirement waivers — reasons a student might not have to complete a
requirement within a program of study.
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To view programs of study for a student:

1. Log on to the District or School view.

2. Click the Student tab.
3. Find and select the student.

4. Click the Transcript side-tab, then click Programs of Study. Any programs already assigned
to the student appear.

5. Toview the details, click the name:

Pages School Student Staff  Attendance Conduct Grades Assessment Schedule Global Admin

Options Reports Help

Student List :- 12 - Adams, Tyler :: HS Graduation Requirements 48 % (Dlier /A 4 L |

[ Default Tempiate ~|
Details

Contacts |Hs Gradustion Requirements| | Q x
HS Gradustion Requirements 110.00

for genstal students,
Attendance

Genaral

Conduct

Graduation requirements for general education students.
Transcript

Credit
Summary

Grade Point | Description
Summary

Programs of
Study
» Details

Graduation

Primary program study O
Summary

Requirement Waivers

Schedule (Code Required unit  |Type |Description Credits waived Reasons for the waiver
Membership Religious
[ [Heattn Education |25 Credit |1 semester of health educstion
Transactions
Delste
Documents ;]

The total number of credits the student needs to earn, the type of diploma the student eamns,
and the description appear.

6. Select the Primary program study checkbox if more than one program is assigned to the stu-
dent, and you want to determine which is primary.

7. Inthe Requirement Waivers box, you can define any exceptions to the requirements in the pro-
gram. Click Add to add a waiver.

8. Click Save. Then, view the student’s progress in fulfilling the requirements associated with
their programs of study.

View Graduation Requirement Status for a Student
You can view a student’s status in completing a program of study.
To view a student’s status:

1. Logon to the District, School, or Build view.
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Click the Student tab.

Find and select the student.

Click the Transcript side-tab, then click Graduation Summary.

At the Programs of Study field, select the program you want to view the status for:

S S N

Pages School Student Staff  Attendance Conduct Grades Assessment Schedule Global  Admin

Options Reports Help

Kl
.
Student List :: 12-Adams, Abagail ¥ (2] /A >
E———
N
_— >
Programs of swty | 5 Gmauation requimens + |
Hame JU—
Locel denifir 2tz
Transcript | oraetever A
Credit
Summary
oie — Reired it Credt waived Ss
Grade Point e 1 year Business earming & aedits 9 00 e
Summary
f— 4 y2ars of English earning 4 aedits 20 el 15 % complated
Programs of
Study cnglisn VICAS ELA pessing score 00 4100 v
f— English electives 10 00 0% completed
Fine Arts 1 year of any IAFFA eaming 1 aredit 1.0} 0.0 0% completed
e e 20 o 2% compiees
Fine Arts 20) 00 v 0 % completed
Physical Education |4 years of Physical Education earning 3 gedits 2.0 20 v &7 % completed
Science 2 years of Science saming 4 credits 40 05| 13 % completed
Socisl Studies 3 years of Sodial Studies eaming 3 oedits 2.0} 1.5 50 % completed
Testing - Assessmants LICAS Msth Grade 10 (Level: Advanced or Proficient) 10 0% completed
Testing - Assessments LICAS ELA Grade 10 (Level: Advanced or Proficient) 10 v
= o m m 205 comptetes
Course Breakdown
p— s oo oo o | —— : o]
sines
1 year Business saming § aredits o matching records
g
O e £ e e [= [ foateseion 2 | v oeio)
craion e —

6. Atthe top of the page, click Printer Friendly Version to print the information.

The top of the page displays the Code, Description, Required unit, Credits waived, Unit
completed, Excluded, and Completed Status for every requirement in the program.
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The bottom of the page provides the Course Breakdown, which breaks each requirement into
the courses attached to it, and the student's status in completing those courses:

Course Breakdown

Requirement School Year Grade level Humber Description Equivalent content code Included|Credits Gained (Credits Total)|

Mo matehing records.

4 years of English caming 4 aredis 20102011 12 042 College English 12 v 0.6(1.0)
V-E\r::gi‘.‘;hEL; Ppassing score Nc matching records
Eraion cesies No matening recorss
et ot any e aring 1 i Ho g recorss

Fine Arts 20102011 12 042 Gollege English 12 0410
Physical Educstion [2002-2009 10 938 Adaptive PE
4 years of Physical Education esming 3 redits

10
[2009-2010 11 38 Adsptive PE 10
Science —— -

e T '2008-2009 10 o84 Modified Chemistry Science

Social Studies '2008-2008 10 587 Intro to Horticulture Science
cisl Studies earning 2 aradits

(AN ENENIEN

l2010-2011 12 122 Fychology 19

ents
e 10 (Level: Advanced er Proficient) Mo meiching records

Testing - ments o maten .
WCAS ELA Grade 10 (Level: Advanced or Proficient) o matehing records
WL - French Mo matehing records
WL - Latin No matehing records.

WL - Spanish No matehing records

The Course Breakdown also displays columns, or fields, of information about each course
attached to a program requirement. Some of these fields appear by default, while others can
be specified to appear by your system administrator. The following fields are included by
default:

« The Equivalent content code column displays the content code assigned to that record if
the student transferred the credits from that course from a different school.

« TheIncluded column indicates if the units eamed in the course apply to the credits gained
total.

« The Credits Gained (Credits Total) column displays the number of credits earned by the
student that count towards the requirement total. For example, if 0.4(1.0) displays, the stu-
dent earned 1.0 units for the course, but only 0.4 credits are counted toward that requirement
total, as needed.

Your administrator can also specify any transcript definition column to appear as an additional
field in the Course Breakdown section.

Run the Graduation Progress Report

Run the Graduation Progress report to view a list of students and their status in completing
graduation requirements:
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Aspen Public Schools

Graduation Progress

Crow Point High School

Page 1 HS Graduation Requirements
Credits Status

Student Name ID YOG Require Waived Gained In Completed
Adams, Abagail 242852 2011 23.00 0.00 4.0 0.00 20.0%
Adams, Tyler 224740 2012 23.00 0.00 13.25 1.50 45.0%
Agurkis, Adam 293663 2012 23.00 0.00 6.0 4.00 4.0%
Agurkis, Tommy 267394 2011 23.00 0.00 13.0 4.00 61.0%
Ahearn, Jack 213856 2012 23.00 0.00 8.0 525 4.0% ®
Ahearn, Mia 286396 2011 23.00 0.00 10.0 0.00 43.0%
Ahern, Iszabella 226984 2011 23.00 0.00 2.0 3.00 4.0%
Ahern, Rebecca 286369 2013 23.00 0.00 3.0 5.50 0.0%
Alarcon, Jason 243917 2014 23.00 0.00 1.0 5.00 0.0%
Alford, Mary 216695 2014 23.00 0.00 1.0 5.00 0.0%

To run the graduation progress report:

Log on to the School view.
2. Click the Student tab.

3. Onthe Reports menu, click Graduation Progress. The Graduation Progress dialog box

appears:

Graduation Progress

School
Program of 5tudies

Requirement
Students to include

Search walue

Cnly show students
with...

...percent complete
Sort student by
Create snapshots
Snapshot name
Snapshot owner
Create history

Format

Crow Point High School

HS Graduation Regquirements q

0,

YOG -
2013

Less than -

20

Mame

J

Seniors Need Credits

User -

Adobe Aoobat (PDF) -

Cancel

4. Use the following table to enter information in the fields:
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Field Description

School The school you are currently working in appears.

Click Qw to select the program of studies you want to

Program of Studies
run the report for.

To run the report for a specific requirement within the

Requirement program of study selected, click Q, toselect the
requirement.

Select one of the following to determine the students you
want to include:

Students to include o All

« Current selection
« YOG

If you selected YOG at the Students to include field,

Search value type the year of graduation.

Select one of the following operators to determine the
students to include on the report:

o Lessthan
« Equalto

o Greaterth
Only show students with... reater than

AND ...percent complete Then, at the ...percent complete field, type the number
that represents the students you want to view on the
report.

For example, you might want to view students who are
more than 75% complete in fulfilling the requirements in
the program of study you selected.

Select one of the following to determine how the report
sorts the included students:

Sort student by N
o Name

« YOG

Select the Create snapshots checkbox if you want
Aspen to automatically create a snapshot for the group of

students that appear on this report.
Create snapshot

Snapshot name If you select this checkbox, type the name of the
Snapshot owner snapshot in the Snapshot name field.

Then, at the Snapshot owner field, select one of the
following to determine the owner of the snapshot:
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Field Description

o« User
e School
« District

Select this checkbox to store the information Aspen
compiles in this instance of the report so that it is readily
available when you run the Graduation Progress Chart

report.

Format Select the format you want the report to appear in.

Create history

5. The report appears in the format you specify.

Graduation Progress Chart Report

The Graduation Progress Chart report displays a bar graph showing the percentage of students who
have met the requirements for a program of study:

Aspen Public Schools Crow Point High School

Graduation Progress Breakdown
Page 1

| . __ 7
300~
277

0 L2}
%
School Id

o
(=]
o

~ @
o o
o o

Number of Students
£ w o
(=] o (=]
o o o

~N
o
o

=
o
o

|- 025 (12575 W 757100|

The report shows a bar that indicates the number of students who have fulfilled one of the following
percentage ranges for the program of study and requirement you selected:

o 0-25(red)
o 25-75 (yellow)
o 75-100 (green)

The report also contains a table that analyzes the data in the graph.

To run the Graduation Progress Chart report:

1. Log on to the School view.
2. Click the Student tab.
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3. Onthe Reports menu, click Graduation Progress Chart. The Graduation Progress Chart dia-
log box appears:

Graduation Progress Chart

School Crow Peint High School

School year 201 CL

Program of Studies HS Graduation Requirements CL
Requirement CL

Students to include YOG -

Search value 2013

Exclude 9th grade v

Include schools All -

Search value

Break school in graph by School level

Recalculate history i

Format Adobe Aoccbat (PDF) -

4. Use the following table to enter information in the fields:
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Field Description

School The school you are logged onto appears.

School year Click the Q’ to select the school year you want to run the report for.
Program of Q

Studies Click the to select a specific program of study.

. If you want to run the report for a specific requirement only, click the
Requirement Q; )
to select the requirement.

Select one of the following to determine the students that appear on the

report:

Students to

include « All
o Current selection
« YOG

If you selected YOG at the Students to include field, type the year of

Search value graduation you want to include on the report.

Select this checkbox to exclude any students in Grade 9 from the report,

Exclude 9th grade because ninth graders often have a low number of requirements fulfilled.
Select one of the following:

. All
« School level: Type the level in the Search value field.

Include schools

« School type: Type the type in the Search value field.
Search value If you select School level or School type, type the specific value.

Select if you want to break the graph by one of the following:
Break school in
graph by « School level

o School type

Select this checkbox if you want the report to recalculate the values for the

IR DT graph. Otherwise, Aspen uses the data last compiled for the Graduation

tory Progress report.
Format Select the format in which you want the report to appear.

5. Click Run. The report appears with the information you selected.

Enter or View Student Assessments

Enter or view assessment information, such as the score a student receives on the PSATSs.

You can also enter assessment information for a group of students at one time.
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To enter or view assessment information for a student:

Log on to the District view.
Click the Student tab.
Search for and select the student.

Click the Assessments side-tab. Existing assessment records are listed.

a » b=

Tofilter the types of assessments, at the Assessment Definition field, click Q and select
the Assessment Definition you would like to enter or view. To view all types of assessments,
leave this field blank.

6. Do one of the following:
« Toview astudent’s scores for an existing assessment record, select the record, and click
Details on the Assessments side-tab.

« Toenter a new assessment record, on the Options menu, click Add. The New Student
Assessment page appears. Enter the information, and click Save.

Enter Assessment Information for Groups of Students

You can enter assessment information for groups of students at a time. You can also enter
assessment information one student at a time, if needed.

To enter assessment information:

1. Log on to the Intermediate Organization or School view.
2. Click Assessment, then Student Assessments.
3. Click Assessment Entry. The Assessment Entry page appears:

Pages School Student Staff Attendance Conduct Grades % Schedule  Global Tools  Admin

Options Reports Help

Assessment Entry

Printer Frienaly Version
Assessment
Definitions

Assessment Definition Students Date Range

et T Q % [ s B =

Assessment
Entry

0 of 0 selected &7 No Students Selected

Hame Grace [ oat= Rawscore Scalescore PertLvi Sohoot > Hame Hextskl > Name

No matching records

4. At Assessment Definition, click Q and the Assessment Definition Pick List appears. Select
the assessment definition you want to enter information for.

5. Click OK.

6. At Students, click Select. The Assessment Entry Multi-Add pop-up appears. If your root organ-
ization has specified that you can enter assessment information for secondary students in its
Membership preferences, select Include Secondary Students to enter their information.

7. Specify the group of students you want to enter information for. If you select:

« Course, the Course pick list appears.
« Section, the Section pick list appears.
« Homeroom, the Homeroom pick list appears.

-107 -



Managing Student Information

« Grade level, the Grade Level pick list appears.
« Group, the Group pick list appears.

« Query, the Query pick list appears.

« Snapshot, the Snapshot pick list appears.

« Selection, the Student pick list appears.

When you click the selection, the number of students in that group appears at Selected students at
the bottom of the pop-up.

8. Click OK.

The Assessment Entry page appears, listing the students in the selected group. For each student,
any existing assessment records for this assessment definition appear. Otherwise a blank
assessment record appears for data entry.

9. You can manage your field set to customize the columns that appear on the list. It is recom-
mended that you include a Date column and enter the date of the assessment record. Today's
date is the default value.

10. Enter the assessment information for each student. Aspen automatically saves the assessment

record once you enter it. If a student already has an assessment record, click B in the student's
row to enter another one.

To delete an assessment record, select the checkbox in that row, then click Delete on the Options
menu. To change a field’s value back to its previous value, click it and select Revert Current Cell
on the Options menu.

At the top of the page, click Printer Friendly Version to print the assessment information.

View the Details of Your Students' Other Classes

Users in the School view, Special Education view, and teachers in the Staff view can view the
details for a students' other classes, such as their attendance summary and average summary.
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To view the details of your students' other classes:

1. Do one of the following:

« Logontothe Staff view.
« Logonto the School view.
« Logon to the Special Education view.

2. Click the Student tab.

3. Select a student, and click the Academics side-tab. A list of the student’s current classes
appears.

4. Select aclass, and click Details on the Academics side-tab:

My Info Student  Attendance Gradebook PD Tools

Reports Help

RN EY IR

‘ Default Template v ‘

Details

Contacts
Attendance

Conduct

Academics
> Details

00422001
Global Voicss

Casserly, David

Schedule term

Schedule

Classroom

Fr
A[2-3.58)

B204

Attendance Summary

Average Summary

| Type

Year

Category

Wieight

| Absent

Class participation

1543

80.0 8-

27.0 B+

75.0C

Tardy

Classwork

13.8%

88.0 B+

92.0 A-

9.0 B+

2508

CRERERL
BRI

=R =

Dismissed o Homewark 28.3% l61.0D- [580F [21.0F [88.0B+

Projects 10.3% lB00D- [7B0C [700C

Quizzes 13.6% 710G [730C  [270F  [s40A

Writing 126% 8205 |1000A+ (300B- |7EOC

100.0% 770C+ |[740C (81.0D- (26.08B

The top of the page lists the details of the course section, including schedule and room.
The Attendance Summary lists the student’s attendance records by term.

The Average Summary lists the student’s grades by assignment categories.

Working With and Viewing a Student's Schedule

You can view a student’s schedule in the District, School, and Build views. In the Build and School
views, you can also do the following:

« Enter astudent’s scheduling parameters.

« Email all of the teachers on a student’s schedule.
« Make changes to a student’s schedule.

« View astudent's change history.

« View the student’s schedule matrix.

« Manage student requests for next year.

View a Student's Schedule

You can view a student’s schedule. This way, you can quickly see where a student is at any time
of the day.
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To view a student’s schedule:

o s~ 0N~

Log on to the District, or Staff view.

Click the Student tab.

Search for and select the student.

Click the Schedule side-tab. The student’s current schedule appears.

To view the details for a course, select the course, and click Details on the Schedule side-tab.

Email a Student’s Teachers

You can send an email to all of a student’s current teachers.

To send an email to a student’s teachers:

A O~

Log on to any viewexcept the Build view.

Click the Student tab.
Select a student, and click the Schedule side-tab. The student’s schedule appears.

On the Options menu, click Send Email. The Mass Email pop-up appears:

From: joe.administrator@aspenschools.org
To: amiller@webfoot.com, dsarno@blueyonder.com, kdelpidio@msn.com, mgrigorenco@woarldmail.com, mn
Subject:

Aftachment: Browse

He Ba B9 BE0 && x x> EHsoue @
|| Size'™=] A AT B I U ZiZEE E E = E 7
4
| send || cancel |

5.

In the To field, email addresses for this student’s teachers appear. You can add to or remove
email addresses.

6. Type the Subject and email text.
7. Click Send.
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View a Student Schedule Matrix

Use the Student Schedule Matrix to view where a student is during the current period and day.

To view a student’s schedule matrix:

Log on to the School, Build, or Staff view.
Click the Student tab.
Search for and select the student.

MDD~

Click the Schedule side-tab, then click Matrix view.

Pages School Student Staff  Attendance Conduct Grades  Assessment Schedule Global  Admin

Options Reports Help A =

Student List :: 12 - Adams, Tyler *{" (@) gy =/ (7)) ][ <] a ][> ][>
Matrix view %
Details
- 0 of 10 selected &7 All Records
Contacts
D Course Description Schedule Term Clssrm Teacher
Attendance [ |ose12-002 Class Guitar A1.4) Fr D10S Davis, Alec
BT ] 00422001 Global Voices A[2-2,56) FY BI04 Cassery, David
[T] |os002-001 Intro. to Business B{1-2,4-5) FY c107 Mogenagle, Katherine
Transcript -
[F] 07911003 Learning Center B{2.8) Fr E201 Chambers Maher, Hannah
Assessments || EIEELERDE Fhysics Ci1,3-4.8) Fr H102 Alices, Jake; Biandy, Haylee
D 02313002 Personal Finance C(2.5) D{1.4) FY C107 Mogonagle, Katherine
Details [ |o1524-001 Fsychology D{2-3,5-6) FY 4208 Fetitti, Klaus
Work [ 00101011 Directed Study E1.4) FY D108A Fisera, Jurgen
P
N [F] [o0012-002 Community Service E{2.5) Fr HR1 Shi, Yubin
Attributes
[F] 02251002 Cross Training E{3.6) Fr GYMA Morgan, David
Change
History
Conflicts
Requests
Graduation
Progress

5. The student’s schedule for the current term appears in matrix format:
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Pages

Options

EET
Contacts
Attendance
Conduct
Transcript
A m

Schedule
Details

Workspace

Attributes

Change
History

Conflicts
Requests

Graduation
Progress

Membership

Documents

Snapsh

School

Reports

Student

Staff
Help

Attendance

Student List :: 12 - Adams, Tyler %’ @) igp - (=)L

Conduct

Grades

Assessment Schedule

Global Admin

L JlaJla ][> Jir]

<< List view

51

(C-C Block

E-E Block

03103005

Physics

Alices. J: Brandy, H
H102

00101011
Directed Study
Pisera, Jurgen
D108A

01524001
Psychology
Petitti. Klaus
A209

02102008
Physics

Alicea, J; Brandy, H

H102

Petitti, Klaus

03103005

Physics

Alices. J; Brandy. H
H102

1-1 2.2 -3 4.4 5-5 6 -6
08612002 00422001 00423001 02612002 00422001 00423001
Class Guitar Global Voices Global Voices Class Guitar Global Voices Global Voices
Davis, Alec Casserly, David Cassesly, David Davis, Alec Casserly, David Casserly, David
A-A Block D105 8204 B204 D105 B204 B204

01524001
Psychalogy

03103005
Physics
Alices. J; Brandy. H
H102

00012002
Community Service
Shi, Yubin
HRA

09251002
Cross Training
Margsn, David
GYM A

00101011
Directed Study
Pisera, Jurgen
D108A

Petitti. Klaus Petitti. Klaus
A209 A208
00012002 08251002
Community Service Cross Trsining
Shi, Yubin Margan, Devid
HR1 GYM A

The matrix color-codes the sections so that they are easy to see on a rotating schedule, and
highlights where the student currently is.

6. At the top of the page, if the student is a secondary student, the School field appears. Select the

7.

school you want to view the schedule for.

Also at the top of the page, the Time field appears. Select the term you want to view the sched-
ule for, or select Today. If you select the full year, the system separates courses that take place
during the same period but during different terms with a dashed line.

Define Student Scheduling Parameters

Before you build your schedule, you need to define scheduling parameters, such as which students
to schedule, and scheduling priorities for your students.
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To copy student scheduling parameters from the previous year's schedule, on the Options menu,
click Refresh. Or, click Mass Update on the Options menu to define most of these scheduling
parameters.

To define student scheduling parameters:

1. Do one of the following:

« Log on to the Build view. Click the Student tab. Then, select the student you want to define

preferences for.

« Logontothe School view. Click the Student tab. Select the student you want to define pref-
erences for, and click the Schedule side-tab, then click Attributes.

The student scheduling parameters appear:

Pages Scenario = Workspace Courses

Help

Students :: 210068 - Aaronson, Grace

Rules

Global

IR 8 O N

=

Default Tempiate -

First name * Grace

Widdle name W

Last name * Asronson

Suffix -

Transcript

Gender Fo
Year of graduation 2012

Grade level 1

Enroliment status

School > Hame

Hext Schoal > Hame.

Hext Homeroom

Frefieg
Crow Point High School
Crow Point High School

a3

Include in scheduling

Exclude from studies.

‘Schedule priority 20

‘Schedule weight 10

Lock schedule

Balance code.

static team

House

Static house.

Platoon

Unavailable schedule

e

2. Use the following table to enter information in the fields:
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Field Description

Select this checkbox to include the student when you build the
schedule.

Include in |

scheduling Note: By default, the system includes every student. Therefore, you

need to deselect the students you do not want to schedule.

Select this checkbox if you do not want to schedule the student in
study halls. For example, this student might go to the vocational
program in another school during afternoon periods.

Exclude from
studies

Type a number to indicate the student’s scheduling priority.

For example, you might search for and select all students who will be

seniors next year. Then, you mass update this field to contain the

value of 10. You do the same for juniors (20), sophomores (30), and
Schedule freshmen (40). This way, the system schedules seniors, then juniors,
priority then sophomores, then freshmen.

Note: You can create subgroups within groups, such as 5 for AP
seniors, and 35 for freshmen. The lower the number, the higher the
priority.

Type a number to determine how many seats this student requires in a
section.

Schedule weight g, yerauit, students have a schedule weight of 1. You might define a

weight of 1.5, or 2 to determine specific students fill more than one
seat due to his or her IEP requirements.

Select this checkbox if you want the schedule the system builds for
this student to stay the same each time you run a load.

HEES ML Note: Use this checkbox if you have manually made changes to the

student's schedule, or the schedule for this student is perfect, and
you will be reloading.

When building the master schedule, the system automatically

balances sections by the number of students. If you want to balance

section counts by ethnic code, gender, or grade, select that option on

the course scheduling parameters page. To balance section counts
Balance code using a different balance value, enter the value here.

For example, assume the ninth graders in your high school are coming
from several schools in your district. You might enter the students'
previous middle school as the balance code to ensure that sections do
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Team

Static Team

House

Static House

Platoon

Unavailable
schedule

not fill with students coming from the same middle school.

If you enter balance codes for students, when you define course
scheduling parameters, select Other at the Section balance type
field. Then, when you build and load the schedule, the system spreads
students with the same balance code across all sections.

Select a team if you want to assign this student to a team.

If you select a team for this student, the system selects this checkbox
automatically when you save the record..

Select a house if you want to assign this student to a house.

If you select a house for this student, the system selects this
checkbox automatically when you save the record.

Select a platoon if you want to assign this student to a platoon.

If the student cannot attend classes during specific periods, click Edit
Schedule to determine the terms, days, and periods the system
cannot schedule that student. A schedule matrix appears.

Select the term, then click in the days and periods the student is
unavailable. Click OK.

Note: If you do not select a team, house, or platoon for the student but you build a
schedule that uses them, the system makes a random assignment if a student requests
a course section assigned to a team, house, or platoon.

3. Click Save.

Making Changes to a Student's Current Schedule

During the school year, you might need to add course sections to and drop course sections from a
student’s schedule. To make these changes, click the Student tab. On the Schedule side-tab,

click Workspace.

There are two ways to make changes to a student schedule:

1. Usethelist view:
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Pages School Student Staff  Attendance Conduct  Grades Assessment Schedule Global Admin

Reports Help
Student List :: 11 - Aaronson, Grace 4t
Details Student Schedule (100% scheduled - Class credits: 7.0) 0ol 7 selected (7
Course Description Term Schedule Unrotated Schedule Teacher Clssrm SecType Team House Platoo|
03203 [College English 11 |FY IAF) Brabants, Nicole (218
Conduct 03102 (American Litesature. |y 2087 Stevens, Jenna (212
Transcript 11002 American Studies 2 |, 3(A-F) Gold, Ann 202
05002 Humanities H Fr [4taF) |O'Brien, Rene 224
23103 Algebra 3Tigc  |FY S(AF) (Cabral, Elizabstn (208
Schedule 03101 g"“"”‘" Literature |, IBLA-F) Fhillips. Thomas 215
IWorkspace
#1401 French 4 Fr [7iaF) Kheng, Branden (103
Attributes
Change Course lgnars wamings(Add |
History
.
Conflicts
Requests
Course Requests
Graduation
Progress
Description SecType  [SectNo [TPvview  |Perinds per cycle Staff>Name  |TermCode  |Atemats? AP [nclusion?  [Al1 > Crshl
American Literature G 11 8.0000 N o N
College English 11 11 '8.0000 N o N
American Studies 2 H 11 8.0000 N o N
Algebra 3iTrig C 11 /8.0000 N o N
<< List view|
Detail Course Requests Student Schedule (100% scheduled - Class credits: 7.0)
Course Allow over max
Conta
i Term code - Work mode Manusl Allow Allow el
T 031 American Literature C il A
022 College English 11 A B C D E F
Conduct 110 American Studies 2 H 03203 X | 03203 I | 03203 X | 03z03 I | 03203 X |o03z03 I
Cellege English College English Cellege English College English Cellege English Collzge English
231 Algebra 2/Trig C 1 1M & 11 & 1 & 11 & 1 & 11 &
. Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N
386 Forensic Soience. 218 218 218 216 218 218
357 Intro to Human Anatomy & Physiology 03103 X [o03103 T | 03103 T [o0s102 T [o0s103 1 [o0s102 I
American American American American American American
Alternate 2 Literature C & Literature © & Literature C & Literature & Literature © o Literature © &
028 SAT Prep Eng Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J
212 212 212 212 212 212
Attributes 021 American Literature & 11002 X | 11002 T | 11002 X | 11002 T | 11002 X | 11002 ]
412 French 4 American Studies American Studies American Studies American Studies American Studies American Studies
Change History 3 2w & & 2n & &) & &)
451 Latin 1 Gold, A Gold, A Gold, A Gold, A Gold, A Gold, A
Conlflicts 202 202 202 202 202 202
B 05002 T [ 0500z I | 05002 1 [o0s00z I | 05002 1 [ 0500z I
equests iti H ities H H ities H H
4 | Gpien.n &' | Genen. r & | Genen. 7 &' | Genen. 7 & | Genen 7 @ | Gonen.r &
Graduation Show courses excluded from scheguling : oo Jhnen. oonen Janen Jnen.
—_— 23103 T [z3102 RS I [z3102 REES RS
Numbar § | AEsTigC g | AgebeTigs o | Algsba3TrigC oo | AlgsbradTigC o | AlgetiadTigS  f | AlgebdTigC o
Cabral, E bral, E Cabral, E Cabral, E Cabral, E Cabral, E
309 209 309 209 209 209
03101 T [oz101 I [o0z101 T [oz101 T [o0z101 T [oz101 I
American American American American American American
e 6 | Litersturec &' | st & | Cetea e &' | atre ¢ & | et & | eratore &
Documen! Phillips, T Fhillips, T Phillips, T Phillips, T Phillips, T Phillips, T
215 218 215 215 218 215
Sna 41201 T [ 41401 I [ 41401 T [ 41401 I [ 41401 T [ 41401 I
Francn 4 French 4 Francn 4 French 4 French 4 French 4
7 | dnang.® & Khang, B & Khang. B & Khang, B & Khang, B & Khang. B &
103 103 103 103 103 103
coem [
[(setest. | [Dopan | [Loacan | [ Reschedule.. |

3. Ineither view, click Post to post changes to the student’s schedule.
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Update transcripts to new section

Current transcript record Mew transcript record Update

00204002 English 11 00203003 English 11 v

When you add course sections to a student’s schedule, you can enter a specific course and
section number, or the system can help you find a course section that is available during a
certain period, or in a specific department.

Also, the system can reschedule a student. When you click Reschedule, the system deletes
the student’s schedule and attempts to schedule him or her in as many requested courses as
possible.

You can also update course requests.

Make Student Schedule Changes Using the Matrix

Make changes to a student’s schedule using the Workspace matrix. The Matrix view provides a
more visual tool for making schedule changes because you can drag and drop course requests to
any available matrix cells.

To make student schedule changes using the Workspace matrix:

Log on to the School view.
Click the Student tab.
Click the Schedule side-tab.

On the Schedule side-tab, click Workspace. Either the List view or Matrix view appears. If you
are not on the Matrix view, click Matrix view in the upper-right comer of the page. The Matrix
view appears:

A w0 DN~

<= Listview
Details Course Requests Student Schedule (100% scheduled - Class credits: 7.0)
Course Allow over max
Contacts A A
Primary Termoode  FY - Work mode Manual Ea e o I
031 Amarican Litersture C
Attendance x
I 022 College English 11 A B (] D E F
Conduct I 110 American Studies 2 H 03203 03202 03203 03202 I | ozz03 X | o3z03

H I H I
College English College English College English College English College English College English
Transcript T 231 Algebra 3Trig © 11 11 11 & 11 11 & 11
Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N
T 356 Forensic Science

218 218 218 218 218 218
Assessments
I 357 Intro to Human Anatomy & Physislogy 03102 X [ 0310z I |o0z103 X [ 0310z X | 0z102 X |oatoz F3

American American American American American American

Schedule Alternate 2 Literature © & Literature & Literature C & Literature ) Literature C & Literature G )

Workspace T 026 SAT Prep Eng Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J
212 212 212 212 212 212

Attributes K 031 American Lilerare G 11002 1 | 11002 T | Mooz 1 | 11002 T | Mooz 1 | 11002

I 414 French 4

OEEO |EEE@EEd

American Studies American Studies American Studies American Studies American Studies American Studies
2H & | 2n [ p & | 2n o p & | 2h )

Change History

I 451 Latin 1 Gold, A Gold, A Gold, A Gald, A Gold, A Gold, A
Conflicts 202 202 202 202 202 202
B i 05002 3 | oso0z I | os002 3 | oso0z I | os002 3 | os002 I
equest Humanities H Humsnities H Humanities H H Humanities H H
4 : & : & :
ClBrien, R OBrien, R O'Brien, R C'Brien, R O'Brien, R O'Brien, R
) Shaw cluded from schedul . 8 : 8 : 8
Graduation [F] Show coursss sxcludsd from scheduling o o o o o o
Progress — 23103 3 [ 23103 % | 23103 3 [ 23103 I | 23103 3 [ 23103 ]
Number Add Algetrs 3/Trig C Algebra A/Trig © Algebra 3Trig C Algebra A/Trig © Algebra 3/Trig Algebra A/Trig ©
Membership 5 Cabral, E Cabral, E Cabral, E & Cabral, E Cabral, E & Gabral, E
Seiet... | [Drop Al | [Update 208 208 08 208 08 208
Transactions 03101 3 | 02101 I | 02101 I | 02101 I | 02101 3 | 02101 1
American American American American American American
6 Literature C & Literature C & Literature C & Literature C & Literature C & Literature C &
Documents Phillips, T Philligs, T Phillips, T Philligs, T Phillips, T Philligs, T
215 215 215 215 215 215
Snapshats 41401 I | 41401 I | 41401 X | 41401 I | 41401 X | 41401 I
Franch 4 French & Franch 4 French & Franch 4 French &
7 Knang, B Khang, B Khang, B & Khang, B Khang, B & Khang, B
103 103 102 103 102 103
Course. Add| [ ignore wamings
[(setect.. | [Drop Al | [ Lesxall | [ Reschedule.. | Post| [ Revert
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The course requests appear on the left side of the page, while the student’s current schedule
appears in a matrix format on the right side of the page.

On the Course Requests side of the page, primary and alternate requests are separated. You
can click, drag, and drop requests between the primary and alternate requests to switch a
request from primary to altemnate, or vice versa.

In the Course Requests area, you can do the following:

Click ¥ toremove arequest from the list.

Click a course number to view details about the request. Requests that are not scheduled
appearin red.

Select the Allow over max checkbox next to a course request if the system can ignore max-
imum enrollment numbers for that course when you reschedule.

Select the Show courses excluded from scheduling checkbox to show any of the stu-
dent’s requests for courses that are not scheduled.

To add course requests, you can either enter a list of specific course numbers and click Add,
or click Select to select courses.

Click Drop All to delete all course requests.

Click Update to add any courses the student is currently scheduled in to the list of course
requests.

To schedule a course request, click and drag the request to the matrix. As you hover over the
request, the available sections for the request are highlighted in the matrix. If you drag and
drop the course over to the schedule, the matrix displays when the course will be taken each
period and day in the schedule.

On the Student Schedule side of the page, the student’s current schedule appears:
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List wiew
Student Schedule (100% scheduled - Class credits: 7.0)
Allow Allow all
Term code FY - Work mode  Manual conflicts I:‘ over max I:‘
Dazo3 I | 02202 I | 02202 I | 02202 I | 02202 I | 02202 I
College English College English ‘College English Caollege English College English Callege English
1 11 & 11 & 11 & 11 & 11 & 11 &
Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N Brabants, N
216 216 216 216 216 216
031-02 % | 02102 % | 03103 % | 02102 % | 02103 % | 02102 H
American American Amersican American American American
2 Literature C "1‘? Literature C Literature C Literature C Literature C Litersture C
Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J Stevens, J
212 212 212 212 212 212
110402 110-02 110402 110-02 11002 110-02
American Studies American Studies American Studies American Studies American Studies American Studies
3 2H & 2H 2H 2H 2H 2H
Gold, A Gold, A Gold, A Gold, A Gold, A Gold, A
202 202 202 202 202 202
050-02 I | 050-02 I | 0s0-02 I | 05002 I | 05002 I | 050-02 I
Humanities H Humanities H Humanities H Humanities H Humanities H Humanities H
4 OBrien, R é‘ OfBrien, R O'Brien, R O'Brien, R O'Brien, R OfBrien, R
224 224 224 224 2324 224
23103 23103 231403 23103 23103 23103
Algebra 3/ Trig C Algebra 3 Trig C Algebra 3 Trig C Algebra 3/ Trig C Algebra 3 Trig C Algebra 3 Trig C
] Cabral, E é‘ Cabral, E d‘ Cabral, E é‘ Cabral, E é‘ Cabral, E é‘ Cabral, E é‘
308 309 08 309 309 308
02101 I | 02101 I | 0210 I | 02101 I |0z2101 I | 02101 I
American American Amesican American American American
6 Literature C "1‘? Literature C Literature C Literature C Literature C Literature C
Phillips, T Phillips, T Phillips, T Phillips, T Phillips, T Phillips, T
215 215 216 215 216 215
41401 T | 41401 T | 41401 T | 41401 T | 41401 T | 41401 H
French 4 French 4 French 4 French 4 French 4 French 4
7 Khang, B é‘ Khang, B Khang, B Khang, B Khang, B Khang, B
103 103 102 103 103 103
Course I:l Ignore warnings
[(Select.. | [ Dropan | [[Lockan | [ Reschedule.. | Revert

At the top of the Student Schedule side of the page, do the following:

« Select the Term code to determine which term you want to view the schedule for.

« At the Work mode field, select Manual to manually drag and drop courses between periods
and days on the matrix to find the best place for each course on the student’s schedule.

« Or, select Auto-Shuffle to have the system determine the next best place to put a course in
the student’s schedule, as you move course requests onto the schedule.

« Select the Allow conflicts checkbox to if you want to schedule the student in any course
section you select, despite any conflicts with course sections on his or her schedule.

« Select the Allow all over max checkbox to allow the student to be scheduled in any class,
even if the maximum enroliment has been exceeded.

« Select the Allow over inclusion ratio/count checkbox if you want to schedule the student
in any inclusion section of a course you select, even if the maximum ratio or count for inclu-
sion students has been reached.

Then, within each cell, view the current course scheduled for that day and period. Click ¥ to

drop a course, or click @' to lock or unlock the course on the student’s schedule.
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If a cell is empty, meaning no course is scheduled during that period and day, you can do the
following:

« Click, drag, and drop a course from the list of student’s course requests.

« Click inthe empty cell. The Schedule Master pick list appears, from which you can add a
course section.

« Type anumberin the Course field at the bottom of the page, and click Add. Select the
Ignore warnings checkbox if you want to schedule the student in the course despite any con-
flicts.

« Click Select to select a section from the Master Schedule pick list.
« Click Drop All to clear the student’s schedule.

« Click Reschedule to create a new schedule for the student based on the list of course
requests. If you want to reschedule, you can click Lock All to lock any sections currently on
the student’s schedule. The system reschedules the student around the courses you lock on
the student’s schedule.

8. At the bottom of the Student Schedule side of the page, click Post to save all changes you
made to the student’s schedule. Or, click Revert to return the student’s schedule to the schedule
that was previously saved.

Drop Courses from a Student's Schedule

You can drop courses from a student’s schedule at any time during the year.

To drop courses from a student’s schedule:

Log on to the School or Build view.

Click the Student tab.

Search for and select the student.

Click the Schedule side-tab. The student’s current schedule appears.

o DN~

On the Schedule side-tab, click Workspace. The Workspace displays the student’s schedule.
Click List view or Matrix view.

6. Do one of the following:

« Inthe List view, select the course, and click Drop.
« Inthe Matrix view, select the course on the matrix and click £ .

7. Do one of the following:

« Addacourse.
« Click Post to post the new schedule.
« Click Revert to revert to the old schedule (the student’s schedule after the last post).

Add Courses to a Student's Schedule

You can add a course to a student’s schedule at any time during the year.
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To add a course to a student’s schedule:

o~ DN~

Log on to the School or Build view.

Click the Student tab.

Search for and select the student.

Click the Schedule side-tab. The student’s current schedule appears.

On the Schedule side-tab, click Workspace. The workspace displays the student’s schedule.
Depending on how you last viewed a workspace for a student, either the List view or Matrix
view appears.

Do one of the following:

« Enter a specific course and section number in the Course field, and click Add.

« If you are using the Matrix view, click in an empty cell on the matrix. Select a section that is
available for that cell.

« Click Select to select a course section from the master schedule. The Master Schedule dia-
log box appears:

Course o Team [an | Requested only

Pericd | Al v House All ¥ | Valid sections only L4

Track ID | AN v Platoon All v Allow conflicts

Term | An v Order by ‘_c:a.rse v Allow all over max

Department |an w Use reserve seats v ﬂlfow R

| 5: 12224008 GEOMETRY H2 v|" 0 of 558 selected (7
I:‘ Course Description Teacher Term| Schedule Unrotated Schedule Total|Max Close?| SecType Te: :
D 13224-008|GEOMETRY H2 Regner, LINDSAY MELINA 52 [1{A-B) 22 (26 |Y

D 13224-007|GECMETRY H2 Regner, LINDSAY MELINA 52 [1{F-G) 25 [28 |Y

D 13234-001|GECMETRY Regner, LINDSAY MELINA 51 [1{C.D1) 21 [23 |Y

D 13224-004|GECMETRY FLEMING, ELAINE RODRIGUES DA CUMHAISZ  [1{A-B) 18 |23 Y

I:‘ 13234-005|GEOMETRY TURCHINETZ, CAITLYN ELIZABETH 52 [1{F-G) 19 [23 |Y
[1|12224-008/GEOMETRY Regner, LINDSAY MELINA 52 |1D2.EZ) 19 |23 |¥

D 13614-002|ADVANCED ALGEBRA H |FLEMING, ELAINE RODRIGUES DA CUMHA|S2  |1{F-G) 24 [25 |Y I}
D 136814-003|ADVANCED ALGEBRA H |TURCHIMETZ, CAITLYN ELIZABETH 52 [1C.D1) 17 |25 |Y i

You can limit the course sections to choose from by selecting values at the Course, Period,
Track ID, Term, Department, House, and Team fields. Select a value in the Order by field
to change the way course sections are sorted.

You can do any of the following:

« Select Requested only to limit the course sections to only the courses the student originally
requested.

« Select Valid sections only to limit the course sections to only courses that are open,
belong to the student’s team, and have the appropriate section type for the student.
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7

10.

« Select Allow conflicts to schedule the student in any course section you select, despite any
conflicts with course sections on his or her schedule.

« Select Allow all over max to allow you to schedule the student in a course that has already
reached its maximum enrollment number.

. Select the course sections you want to add to the student’s schedule.
8.

If you are using reserved seating, and the section has only reserved seats remaining, select the
Use reserve seats checkbox to open a space in the section for the student.

Click OK. If you did not select the Allow Conflicts checkbox, the system displays any warn-
ings about conflicts the course sections you selected have with the student’s current schedule.

Any course sections you add to the student’s schedule appear with an asterisk (*). This
means that you have not posted the course sections yet.

After you add the sections, click Post. The changes you made are now the student’s active
schedule.

Post a Student’s Schedule

When you add or drop courses from a student’s current schedule using the Workspace, you click
Post to post the new schedule.

If the date you click Post falls within the number of days set by your district for aligning courses
added to and dropped from a schedule, a dialog box matches any courses you dropped to courses

you added:
Sections deleted Sections replaced with
E2F-1 STUDY E : ¥
No match d Edit
=4 1[5; 3[?:' 5{2:‘ ma’ Ing recoras I

o9 (exr)

Us

By

e the dialog box to be sure the student’s new schedule is balanced.

default, the system aligns added and dropped sections by department.

Do one of the following:

« Click Edit to make an adjustment.
« Click OK to post the new schedule.
« Click Cancel to cancel the post action.
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Update Students' Course Requests on Their Schedule Page

Before you add and drop course sections from a student’s schedule, you can update their course
requests on the same page.

To update a student’s course requests:

o N~

Log on to the School or Build view.

Click the Student tab.

Search for and select the student.

Click the Schedule side-tab. The student’s current schedule appears.

On the Schedule side-tab, click Workspace. The Workspace displays the student’s schedule
and course requests. Depending on how you last viewed a workspace for a student, either the
List view or Matrix view appears:

Course Requests

I:‘ |Cr=No Description |SecType Alternate? |Alt 1= CraHo Alt 2= Cralo Allow ower max
D:423H" Han Chem Lab . ) N . | | F
|:|“512 [French N : O
E :802 eltness 1 N ' B
DESD‘I :Frosh."Soph FE H i ]
O [ iSpanish n N | O
D.332H :.Hon Algebra Il-Trig H i .}
D.423H i‘Hon Chemistry N .|:|
Ij:204H Han us Histary | N |:|
D.122H [en English Il N I F
Course number. Add

You can do the following:

« Enter a specific course number, and click Add.

« Click Select. The Pick Course dialog box appears. Select the courses you want to add to
the student’s requests, and click OK.

« Select the course requests you want to delete, and click Drop.

« Click Update to add any courses the student is currently scheduled in to the list of course
requests.

« Select Allow over max for any course you want the system to schedule the student in even
if the maximum enroliment has been reached.

Note: When you reschedule the student, the system deletes his or her current schedule
and creates a new one based on course requests.

Reschedule Students Based on Course Requests

After you add or drop student requests, you might want to reschedule the student. Doing so
deletes his or her current schedule and attempts to schedule the student in as many requested
courses as possible.
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To reschedule students:

1.
2.
3.
4.
5.

Log on to the School or Build view.

Click the Student tab.

Search for and select the student.

Click the Schedule side-tab. The student’s current schedule appears.

On the Schedule side-tab, click Workspace. The Workspace displays the student’s schedule
and course requests:

Pages School Student Staff Attendance Conduct  Grades Assessment Schedule Global Admin

Reports Help
Student List :: 11 - Aaronson, Grace AfA(ip](Ee] /4
Details Student Schedule (100% scheduled - Class credits: 7.0) 0of 7 selected 7
Contacts Course Description Term Schedule Unrotated Schedule |Teacher Clssrm SecType Team House Platoo|
Attendance 032-03 (College English 11 |FY 1(AF) Brabents, Nicole (218
Conduct 03103 (American Litesature |y 21A-F) Stevens. Jenns (212
Transcript 11002 [American Studies 2 |, 3(A-F) Gold, Ann 202
05002 Humanities H Fr 1A |O'Brien, Rene 224
23103 lMlgebia Trig & |FY S(AF) (Cabeal, Elizsbeth 208
Seliedulc 03101 é"‘g‘“" Literature |y IBIAF) Fhillips, Thomss (215
Workspace
I P 41201 Franch & Fr A Khang, Branden (103
Attributes
Change Course Ignare wummgs
History
=
Requests
Course Requests
Graduation
Progress
Humber  |Description SecType  |Sectlio |TPVView | Periods per cycle Staff»Name  TermCode |Akemate?  |AlPri |lnclusion?  |Alt 1> CrsN
American Literaturs C 11 €.0000 N o N
College Englisn 11 11 &.0000 N o N
American Studies 2 H 11 £.0000 N o N
Fl Algsbra 2Trig € 11 8.0000 N o N

In the List view, the student’s current schedule appears at the top of the page. In the Matrix
view, the student’s current schedule appears on the right of the page. Any course section that
has not yet been posted appears with an asterisk (*) next to the section number. You can add
and drop courses at any time.

In the List view, the student’s course requests appear at the bottom of the page. In the Matrix
view the course requests appear on the left of the page. Any request in red is a course the
system could not schedule the student in. You can add and delete course requests.

6. Toreschedule a student, verify that all of his or her course requests appear below Course
Requests, and click Reschedule.

124 -



Managing Student Information

The system deletes the student’s schedule and attempts to schedule him or her in the
requested courses. The system clears any student load conflict reasons, and replaces them
with new information.

All courses the system can schedule the student in appear at the top of the page with an
asterisk (*) next to the course number. The schedule is not permanent until you click Post.

View Changes to a Student's Schedule

A student’s schedule can go through many changes during the current school year. Courses might
be dropped or added, or both.

To view the changes made to a student’s schedule:

A w0 DN~

Log on to the School view.
Click the Student tab.
Search for and select the student.

Click the Schedule side-tab, then click Change History. A list of any changes made to the stu-
dent’s schedule appears.

To print a report of the changes, on the Reports menu, click Student Schedule Change His-
tory.
Enter the report parameters. The report displays in the format you specify.

View Graduation Progress for a Student

View a student’s graduation progress while entering requests to determine his or her progress in
completing graduation requirements.

To view a student’s graduation progress status:

A w N~

Log on to the School view.
Click the Student tab.
Find and select the student.

Click the Schedule side-tab, then Graduation Progress. The student’s graduation summary
appears.

In the Completed Status column, in addition to the percent of credits in progress and com-
pleted, view the total percent of credits the student is requesting for next year:
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Programs of Study High School e

Code Description Required unit|Credits waived|Credits completed|Credits in progress|Credits requested| Completed Status.
Engliah 5.0/ 20 50 0.0 50 v
Frashman |

Evgien 50| 0.0 0g 0.0|| 0% completed
dunior

Englfh 5.0 0.0| 0.0 0.0|| 0% completed

enior

English 50| 50 a0 0.0 v
Sophemare 1l
Fins & |
Fractical 50| 0.0 0.0 0.0|| 0% completed
Ars | ] 1

Foreign 5.0/ 0.0 0.0 0.0|| 0% complated
Langusge | | | | 1
|Health 25 2.5| 0.0 0.0 v

Education
Local History
& 25| 00 0.0 0.0{| 0% completad
Gavermment| |

Mathematics| 150 15.0| 0o 0o v
Fhysical | o [ I
|Educstion S|
Science 109] 0.0 0.0 00| 0% completed

2.5 0.0 0.0[| 50% completed

Socisl s 5 5 [
Studies 7.5 50 5.0 00|| 87% completed

us History 50| 0.0 50 0.0|| 0% completed

I I 37% completed
Total 100.0] 20| 5.0 5.0 5.0/42% in progress
42% requesting

Managing Student Requests for Next Year

As a counselor or administrator, Aspen includes several ways to manage student requests for the
next school year:

« Enter student requests in the School view. For example, if students at your school pass in
request sheets, they can be manually entered.

« Counselors can enter recommendations for students and groups of students, and convert recom-
mendations entered by teachers into requests for students.

« Students can enter requests online in the Student portal. Then, counselors or administrators can
edit and approve the requests.

« Counselors can review recommendations and requests for students in the School view.

Enter Requests for a Student Using the Options Menu

You can enter several course requests for a student using the Options menu.

For example, your students might submit request sheets to the guidance office, who enters
requests into Aspen.

To enter a student’s requests:

1. Log on to the School or Build view.

Note: In the Staff view, you can only view a student's requests.

2. Do one of the following:

« If you are entering the student's requests for next year, go to the Build view, and click the Stu-
denttab. Then, click the Requests side-tab.

« If you are entering requests for a student for the current year or next year, click the Student
tab. Click the Schedule side-tab. To enter requests for the current year, click Requests or
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Workspace. To enter next year's requests, click Requests, and be sure to click the Filter

icon ? and select Build Year.

3. Select a student, and click the Requests side-tab. The requests page for that student appears:

Pages School Student Staff  Attendance Conduct Grades Assessment Schedule Global  Admin

Options Reports Help Y 17|
Student List :: 03 - Abruzzese, Peter ' ﬂ E E E] E
Details 0 of 4 selected £7 Build Year
e 2011-2012 - Requests: 4 primary, 0 alternate - Scheduled: 0% - Credits: 0.0
SchoolCourse > Crsho SchoolCourse > Description SecType |Allernate?  [AltPri |AIt1>CrsHo  AlZ>CrsHo  TPYView |Periods per cycle Include in scheduling
Altendance 100183 Reading Gr 2 N o ] N
Conduct 400123 Science Gr 3 N lo o N
600023 (World Language Gr 3 N lo o H
Transcript
200123 [Wellness Gr 3 N lo o N
Assessments
School Course » Number =
Schedule
Workspace seieat. | [
Attributes Unsuailsble schecule: Edit Schaduls
Change )
History Course Request Adjustments
Conflicts ||5crm\ Course > Number School Course > Description Type Comment User > Name |
R | Ne matching records |
q
Details Delete.
Graduation
Progress

4. Do one of the following:

« Click Select on the page.
« Onthe Options menu, click Add.

The School Course Pick List appears:
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Grade level 11 -

Department All -

0 of 32
1. 028 SAT Frep Eng - selected 7

CrzMo  |Description Department

026 SAT Prep Eng English

030 American Literature Pre AP English

031 American Literature C English

03z Caollege English 11 English

033 English 11 English

110 American Studies 2 H Social Studies

110AFP |American Studies 2 AP Social Studies

111 American Studies 2 C Social Studies

113 American Studies 2 Social Studies

O00O00DOoOEDOoOoo

231 Algebra 3 Trig C Math

Also, note that if a student is associated with more than one school on the Schools side-tab for
the build year, select the school you want to request courses from at the top of the School
Course Pick List. If you select the student’s primary school, you can enter the student’s
requests for courses at both his or her primary and secondary schools. Alternatively, if you log
on to the student’s secondary school, you can only enter requests for courses at the secondary
school. The School Name column displays which school a request is entered for.

5. Tofilter the list of courses, select a specific department at the Department drop-down.

6. Select the checkboxes next to each course the student is requesting. You can click Next \) and

Previous ) to move from page to page to select many courses.
7. Click OK. The system adds all of the courses to the list of the student’s course requests.
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8. Click the course number of any of the requests to define if the request is an alternate, or to
identify alternate requests if the student does not get into that course. You can also identify a
specific section type this student needs for a course, such as Bilingual:

f::hnnl Course » NHumber EL-3RAL Q
Section type -

Is inclusion section?

Content term code -

Is optional?

Is alternate course?®

Alternate course priority EI_

Alternate course type -

School Course > NHumber | EL-3R&L

School Course =
Description

Alternate Course 1 = Q
Number
Alternate Course 2 = Q
Humber

3rd Grade Reading and Literature

Staff > Name Q,

Section Number

Term code -

The student’s request percentage appears at the top of the page. Use this percentage to
determine if the student has requested too few or too many courses.

Entering Requests for Teacher Recommendations

After teachers enter their recommendations for which courses their students should take next
year, counselors and administrators can do any of the following to accept the recommendations,
converting them into student requests.

« If your school uses online course requesting for students, students can view and accept the
recommendations in the Student view.

« Yourschool’s guidance counselors can enter their own recommendations for groups of stu-
dents at the same time.
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« Your school's guidance counselors can accept teacher and other staff recommendations and
turn them into requests for groups of students or for academic tracks, and specific track selec-
tions.

« Your school's guidance counselor can accept recommendations for each student, one-at-a-time,

while reviewing a student’s requests.

Add Course Recommendations for Several Students

As a counselor or administrator, you can enter course recommendations for several students at one
time for next year.

The recommendations appear in the Course Requests Adjustment area of each student’s Requests
page.

Then, you need to accept the course recommendations to turn them into requests for either groups
of students, or one student at a time.

To add course recommendations for several students:

1. Log on to the School view.
2. Click the Student tab.

3. Onthe Options menu, click Requests, then Add Request Recommendations. The Handle
Recommendations dialog box appears:

School Year Context = 20132014
Year |D
Type Recommended -
Students
Selection

@ Grade level

Snapshots

Selected students: 0

Course Mumbers:

Note: The school year defaults to the next school year.

4. Atthe Type field, select one of the following:
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Recommended: This creates recommendations for the courses you enter or select at the
Course Numbers field, and displays Recommended in the Type column.

Excluded: This creates recommendations for the courses you enter or select at the Course
Numbers field, and displays Excluded in the Type column.

Required: This creates required recommendations for the courses you enter or select at the
Course Numbers field, and displays Required in the Type column.

Requirement Waived: This creates recommendations for the courses you enter or select at
the Course Numbers field, and displays Requirement Waived in the Type column.

Select one of the following to determine which group of students you want to enter the recom-
mendations for:

Selection: A list of students appears. Select the students you want to enter recom-
mendations for.

Grade level: A list of grade levels appears. Select the grade levels you want to recommend
the courses for.

Snapshots: A list of snapshots appears. Select the snapshots of students you want to
recommend the courses for.

In the Course Numbers field, type the course numbers, separated by commas, or click Select
to select the courses from a list.

Click OK. The recommended courses appear in the Course Request Adjustment area of
each student’s Request page. The Type column displays if the recommendations are recom-
mended, excluded, required, or requirement waived.

To tumn the recommendations into student requests, do the following:

« Allow students to view the recommendations and enter requests in the Student view.
o Accept recommendations.

Accept Recommendations to Create Course Requests for Several Students

After teachers or school staff members enter course recommendations for their students for the
coming year, you can convert those recommendations to students’ request lists by accepting
them.

To add recommendations to student request pages:

Log on to the School view.
Click the Student tab.

On the Options menu, click Requests, then Accept Request Recommendations. The
Handle Recommendations dialog box appears:
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School Year Context =

2011-2012
Year IO .

Selection Mode Students -

Students

Selection
@ Grade level

Snapshots

Selected students: 310

Note: The next school year appears in the School Year Context Year ID field.

4. Atthe Selection Mode field, select Students to accept recommendations and create requests
for a group of students, or select Academic Track to accept recommendations for courses in a
specific academic track and track selection. Depending on what you select, you must select the
group of students you want to accept recommendations for (by selection, grade level, or snap-
shot), or the academic track and track selection (optional) you want to accept recommendations
for.

5. Click OK.

Approve Requests Entered by Students Online

When students enter their course requests for next year in the Student portal, you can manage
those requests in the School view.

To approve online student requests:

Log on to the School view.

Click the Student tab.

Click the Schedule side-tab.

Click the Requests side-tab. The student’s requests appear. You can enter and manage student

A O~

requests and adjustments.

5. Inthe upper-left corner of the page, click Entry mode>> to view and use the requests page the
student uses:
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Pages School Student Staff  Attendance Conduct Grades Assessment Schedule Global  Admin

Options Reports Help Y = (2]
Student List :: 10-Ahern, Rebecca ’ ﬂ EEE
[ —
De
Contacts 2013-2014 - Requests: 6 primary, 1 alternate - Scheduled: 7% - Credits: 5.0
Aftendance I 5 I
|
Conduct |2 stucents must select s minimum of five counses. |
Primary requests
Subject area SchoolCourse > Crsho SchoolCourse > Description SecType /Atternate? AltPri Alt1 = Crsho Alt2 = Crsho Credit
losa wiiting Seminsr N o os
[(Seie ] Erectives
ase Forensic Science. N o os
Seledt.. | Engiisn o3 Engiish 11 N o o
Sslect.. | Foreign Language 422 Spanish 3 N o 10
) Seleat.. J|uatn ©
Change History Seledt.. ||science jaz3. \Action Chemistry N o 10
Conflicts Seleat.. J|Social Studies 113 \American Studies 2 N ] 1.0
Requests.
Details Alternate requests
g'ﬂd"ﬂ“"" [ [subject area [schoolcourse > Crsho [schooicourse > Description [sectype Jatemate? Jareri a1 > crane Jarz>cretio lcreat |
rogress
|[s=lesi... | speciat Egucstion = |Acodemic Suppart 11-12 [ v [ = |sz0 10 |
Membership
[TEIEEEOTS Notes for counselor
Documi Mrs. Smith, | don't have the prerequisite 50 | cant request it but Mrs. Hope recommended Honors Trig. What should | do? -
sn.
Approved time: 111472012 12:26 P Last posted time: 1/14/2012 1226 Pt

6. You can edit any requests the student has made. Also, view any Notes for the counselor they
have typed.

7. After reviewing and making any necessary changes, to approve the student’s requests, select
the Approve checkbox at the bottom of the page. After you approve the student’s requests, he
or she can no longer make changes using the Student portal.

Review Course Recommendations and Requests for a Student

Counselors or administrators can review and accept recommendations, and create course
requests for one student at a time in the School view.

To review course recommendations and requests for a student:

Log on to the School view.
Click the Student tab.
Search for and select a student, and click the Schedule side-tab.

On the Schedule side-tab, click Requests. Any course recommendations entered by teachers
or staff members appear in the Course Request Adjustments area of the Request page:

> w0 N~
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Pages

Options

School

1
Student Staff

Attendance Conduct

Grades = Assessment

Schedule

Global

Admin

Reporis Help

Student List :: 07-Abbott, John 418 ¥ 22 () /A 1« <[ Q]»]»]
Entry mede not availsble:
Details
00f2 selected &7 Build Year
Contacts
2013-2014 - Requests: 2 primary, 0 alternate - Scheduled: 0% - Credits: 2.0
Altendance
D SchoolCourse » CrsNo SchoolCourse » Description SecType \Alternate? AltPri Alt 1= Crsho Alt 2 = Crsho TPYView Periods per cycle Include in scheduling

Conduct Hloz English © M o o M

Transcript 2 onors Geomety M o o M

Assessments  [FNRTSIIIEWN

f=ene e

S (o]

Schedule

availabiz sehedule: Ecit Sehaduls
Workspace
Attributes Course Request Adjustments
Change History | [] |School Course = Number

Conflicts

School Course > Description ‘Sehool Course > Depariment School Course > Grade level School Course > Acadenic level Type. Comment  [User > Name

[«
8

Honors Geometry natn o cF Recommended |Administrator, Jos.

Requests )43z Spanish 2
Details

(<]

World Langusge 10 st Required Agministrator, Jos.

s070 English 7 H English o7 H

nistrator, Jos

a
Graduation [ |msses

Speecnilang s
Progress

'Special Education 0s Woa

Membership RS
Transactions
Documents

Snapshots

5. To add additional recommendations, click Add.

6. To delete a recommendation, select the checkbox next to the recommendation, and click
Delete.

7. Toaccept recommendations and make them requests, select the checkbox next to each recom-
mendation, and click Accept recommendation. The recommendations now also appear as
Requests at the top of the page.

At the top of the page, you can add and manage requests for the students.

Working With Student Enrollment Information

Enrollment information is a vital piece of a student record. A student’s enrollment information might
include the dates and reasons for the following:

« When the student enrolls in your school.

« If the student completely withdraws from your district.
« If the student transfers from your school to another school in your district.

« If the student’s status changes from active. For example, a student who reaches the maximum
age at your school might become inactive.

« If the student is promoted or demoted to a different year of graduation.
« A student is associated with another school. See Create Secondary School Associations.

Also, you can view and manage any groups a student is a member of.

Register a Student

Register students in your district, or school from the Student List. You can register students who
are new or who are returning to your school.
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To register students:

1. Click the Student tab.
2. Onthe Options menu, click Registration, and Register Student. The Student Registration

wizard displays Step 1.
Student Registration: Select Student Step 10f4
New student
First name Jonathan
Last name Barmresi
Gender M -
Date of birth 02/01/2002 & Age 12

‘ New family member ‘¢

< Badk Mext = Finish Cancel

3. Type the student’s First Name, Last Name, select a Gender, and type or click = toentera
Date of birth.

4. If this student is related to another student in the district, click New family member and a box
with additional fields appears. Enter any required fields (determined by your root organization’s
preferences). Enter a name at the Related Student field and click Search. The Student Pick
List appears. Find the related student and click OK. Then, select the Relationship to the stu-
dent you are registering (such as sibling). Click Next.

When you click Search for related student, any information (such as phone number and
address) your district chooses to copy from the related student to the new student appears in
Step 2.

5. If the new student’s information matches an active student in the district, a pop-up appears list-
ing the name and information of the matching student and the following message:
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Matching student found. Selecting a student will activate this student with their existing student information. Click cancel to close
this window and enter a new student

1 record (7
Hame Gender DOB |LAsD {Grade [EnrStatus Last Withdrawal Contact
o Baresi, Jake M nz.lnimnz!zﬂmums]u Acive - ]numnnululow,masmmnm

The name of the matching student’s school appear under Contact. Click for additional
information, such as a contact name and phone number. Click Cancel to enroll a different
student. If you click OK, Step 1 of the Student Registration wizard appears with a warning
message:

The selected student is already active.

Click Cancel to enroll a different student. Aspen does not allow you to register a
student who is already active.

6. If this student is a returning student, meaning he or she was active in your district or school in the
past but is now inactive, use the same registration process as for a new student.

7. However, if the student withdrew from your district or school due to a withdrawal reason defined
by your district in the Student Registration Restriction preference (such as expulsion), then a
warning message might appear:

The student cannot be registered because
of hisfher last withdrawal reason: Expelled

System administrators can set a user role, usually the Enroliment Manager, to override this
restriction in the user role details.

Based upon the data entered, a student match has been found; however, the matched student cannot be enrolled at this time. Please
select Cancel to return to the previous screen.

If you are attempting to enroll a brand new student, please select Next to continue the registration process.
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The Student Registration wizard displays Step 2:

Student Registration: Damographics Step 2 of 4
Goneral A idr o
Firsl fu s bdichasl
Kiddla namez F.'tm
Ho middls rovms flsg |_|
e Last ramiea Wallaoe
f Sufdin L
Gearichar Y
Date of birth 1Z3MER0 | B
CitwTavm of birth Waymauth
Fraana 01 TE1-555.554 1
Fruore 02
Fraane OF
Horrsroocm 1m1
He rras | mrigguisge English | C‘L
Calendar Etamdard L
'

Enter general demographic information for the student.
Click the Address tab to enter the student’s address information. You can type an address, or

click Q to select an address in your system. You can also click Search Grid Codes to
search for an address close to the one you typed.

Click Next. The Student Registration wizard displays Step 3:
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Step3ofd
Schodl = Hame Crows Polrt High Sehoal
Year of graduation |21:I.I:$ Grade fewel |00
Ersull mar stabus ckive Q
Loeal idarifiar ™" Agte Assign T
State identifier 225133821
Diste | 122i2004 iz}
Code = Q
Reazon | Ralocata q
CEFsar school name L 1
[oua] ) - [eme]

11. Type or select the student’s enroliment information, such as the school being entered.

If you are using the District view and your organization uses grid codes to assign students to
schools, you can select a school from a list of schools associated with the student’s address. If
the school you select is not associated with the student’s address, the Out of grid code warning
appears next to the school name. To move to the next step, you must select a reason at the

Reason field.

12. Enter the information on Step 3, and click Next. The Student Registration wizard displays the
Confirmation dialog box.

13. Click Finish to register the student.
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Re-register a Returning Student

Register a student who was active in your district or school in the past, but is now inactive, using
the same process you use when registering a new student. See Register a Student.

However, if the student withdrew from your district or school due to a withdrawal reason set in the
Student Registration Restriction preference, some users might be restricted from registering
the student. For example, if the Student Registration Restriction is set to Expelled, then the
following warning message appears:

The student cannot be registered because
of his/her last withdrawal reason: Expelled

System administrators can set a user role, usually the Enroliment Manager, to override this
restriction in the user role details.

To allow a user role to override the student registration restriction:

Log on to the District or Intermediate Organization view.
Click the Admin tab.
Click the Security side-tab.

Select the checkbox for a role, such as the Enroliment Manager, and click Details. The user
role's details page appears:

A w N~
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_| seneral ||
Nare * Enrollment Manager
Active directary ou name ||
HE view School wiew Spesial Ed. view ]
Area view F Statt view Personnal view ]
District view Fl Health view | Student view =]
Build view ] Farmily view Ll
Security Access ICategorv Student v
System Table C| R | U |D| G| M Oher
504 Plan [all][none]‘l:‘:l:“l:‘:l:“l:‘:l:‘.
N e
[V] Register students
Student [all] [none] ]| ]| [™] g;::z:?ﬂu:::;
[] change statusrr0s for students
[ student address grid code overide
.DSetlegal alerts
Student Alett ainmenel | [ ] ] 0| 1| ][] set medical aterts
[ set ather alerts
Student Assessment all] [nene] |:| |:| |:| il |:||:|
Student Attendance [all] [none] |:| |:| |:| |:||:||:|
Student Class Attendance [all] [none] |:| |:| |:| i |:||:|
Student Conduct Incident all] [nene] |:| |:| |:| |:||:| |:| [ ] overide conduct restrictions
Student Contact [all] [none] |:| |:| |:| |:||:| |:|
Student Course Request [all] [none] |:| L |:| 7] |:| [ [ attow sourse maximum ovaride
el [ [V/] pirectly add enraliment recards
i/} Overide enraliment restristions ]

5. Click the Category drop-down to select Student.

6. Forthe Student Enrollment system table, go to the last column titled Other. To allow this role to
register any student, including students who have been expelled, select the Override regis-
tration restrictions checkbox.

7. Click Save.

When a user with this role registers a previously expelled student, the following warning
appears, but he or she will be able to continue with the registration:

The student cannot be registered because

é of his/her last withdrawal reason: Expelled

Would you like to register this student
anyway?

[ Continue ][ Cancel ]
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Withdraw a Student

Withdraw a student from your school who will no longer be in your district. For example, you might
withdraw a student who dropped out of school, or who moved to another state.

To withdraw a student:

Log on to the District, Intermediate Organization or School view.

Click the Student tab.

Search for and select the student.

On the Options menu, click Registration, then Withdraw Student. The Withdraw Student
pop-up appears.

5. Use the following table to enter information in the fields:

H DN~
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Field Description

Name Click Qa to select the student from the list that appears.
Current
Primary The school name will automatically appear once the student is selected.
School
Date Type the date, or click B to select the date the student is being
withdrawn from school.
Click Qa to select the code for the student’s withdrawal records. This
code might be used for district informational purposes.
Code
For example, your district might use Transferred within the same
school for the reason this student is withdrawn.
Click Qa to select the reason code.
Reason
For example, your district might use Expelled for the reason this
student is withdrawn.
Click this drop-down to select the new enroliment status code for the
student who is withdrawing. This status might be used for state
Status reporting purposes.
For example, your state status might be Drop Out.
Select this checkbox to disable the student's and his or her contacts'
Aspen user accounts. This denies their access to the Student and
Family portals.
R R R SISwmSm—m_L_——————S—————
Disable related Note: If the contact is shared with another active student, the
user accounts contact's user account will not be disabled.

Note: You cannot disable the user account of a student that is actively
cross-enrolled in one or more other schools.

This checkbox appears if specified in your root organization’s Membership
Create a former preferences. Select this checkbox to create a former school association
school asso- record for this student’s withdrawal. The record appears on the Student tab,
ciation Membership side-tab, School sub side-tab. From the withdrawal date until

the end of the school year, the student will have a “former” student status.
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6. Click OK.

If a student’s membership record contains a record later than the date you entered for the
withdrawal, Aspen displays the following warning :

This student has attendance records posted
after the withdrawal date. Do you want to
delete them?

To delete the later record, click Yes. Otherwise, click No, and you can edit the date you have
entered for this withdrawal.

Withdraw Student

The student's enrallment status cannot be adjusted because the student has
one or mare active cross-enrollments.

Withdrawing a “Private” Student

Sometimes a student has special circumstances and is marked “private” to hide their demographic
information from other schools in the district. If you withdraw a student who is marked private, the
following pop-up appears:

Note: This student is currently marked as Confidential. Withdrawing the student
will remove the Confidential stalus. Please select ‘'Cancel’ if you wish to return to
previous screen.

1. Click Cancel to return to the previous screen.
2. Click Continue to withdraw the student from the school. The following message appears:
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This student is withdrawn and is no longer confidential.

Transfer a Student

Transfer a student from your school to another school in your district. Your Aspen system
administrator defined how Aspen handles student transfers in your district’s enrollment preferences.

Your district uses one of the following transfer processes:

« The sending school pushes the student to the receiving school.

« The receiving school pulls students who have been prepared for transfer from the sending school
by selecting the Transfer Pending checkbox.

« The receiving school can pull any students from the sending school; students are not prepared
for transfer by selecting the Transfer Pending checkbox.

Withdrawal Entry

Current School Adams School Destination School Crow Peint High Schocl North

e o A E—

code e 1O | coe e IQ

A E— G E— Y
L -: .Carme |

To push students to the receiving school:

1. Log on to the District, Intermediate Organization or School view.
2. Click the Student tab.
3. Search for and select the student.
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On the Options menu, click Registration, then Transfer Student. The Transfer Student dialog
box appears.

Enter the withdrawal information for the current school and the entry information for the des-
tination school.

Click OK. The system transfers the student to the destination school, creating a W(withdrawal)
enrollment record for the transferring school and an

To pull students from the sending school:

o DN~
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10.

11.
12.

The sending school logs on to their School view.
Click the Student tab.

Search for and select the student.

Click the Details side-tab.

Select the Transfer pending checkbox and the student’s new school at the Transfer School
field on the student’s detail page.

The receiving school logs on to their School view.

Click the Student tab.

Click the Membership side-tab, and then click Enroliment.

On the Options menu, click Registration, then Transfer Student.

Select the student from the list of pending transfers. The system transfers him or her to the des-
tination school, creating a W (withdrawal) enrollment record for the transferring school and an E
(entry) enrolliment record for the destination school.

Enter the Entry information.

Click OK.

To pull students from the sending school, unrestricted:

H DN~

The receiving school logs on to their School view.

Click the Student tab.

On the Options menu, click Registration, then Transfer Student.
Do one of the following:

o Type the student’s LASID in the ID field.
e Click Cl, to select a student.
Enter the information, and click OK.

Also, depending on your school’s transfer process, one of the following happens to the
student’s record in your School view, as determined when your Aspen system administrator
defined district preferences:

« You can view the student’s record as a former student.
« You can no longer view the student in your School view.

If you enter dates that are before an existing enroliment record for the student, Aspen
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displays the following error message:

You cannot add an enrollment
record because there is an
existing record with a later date for
this student.

6. Click OK, and adjust the dates you entered for the transfer.

Change a Student's Enroliment Status

Some schools might need to manually change a student’s enroliment status. For example, you
could pre-register a student in May so that his or her information is in the system, even though the
student won'’t attend your school until the fall. Then, in September, you will need to update the
student's status to active.

To change a student’s enroliment status:

Log on to the District or School view.

Click the Student tab.

Search for and select the student.

On the Options menu, click Registration, then Change Student Status. The Update Enroll-
ment Status dialog box appears. Enter the information, and click OK. The system creates an S

enroliment record for the student with the entered date and reason. The system also updates the
student’s enrollment status.

A oODd -~

Promote or Demote a Student

Sometimes a student’s year of graduation might change. If he is accelerated to an earlier year of
graduation, you promote the student. If she is returned to a later year of graduation, you demote the
student.

To promote or demote a student:

Log on to the District or School view.
Click the Student tab.
Search for and select the student.

A w0 DN~

On the Options menu, click Registration, then Promote/Demote Student. The Pro-
mote/Demote Student dialog box appears.

5. Enter the information, including the student’s new year of graduation.
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6. Click OK. The system creates a Yenrollment record and updates the student’sYOGand grade
level.

Associate a Student to a School

You might want to associate a student to another school in your district. There are two types of
associations:

« Former: A student is a former student if he or she transfers from your school to another school
in your district.

» Secondary: A student is a secondary student if he or she attends your school and another
school in your district at the same time. For example, a student might attend the high school
and the vocational technical school.

Your Aspen administrator determines the data you can edit for former and secondary students.

Note: School assaciations are only valid for the school year in which you make them.

To view an association or to associate a student with a school:

Log on to the District, School, Staff, or Health view.
Click the Student tab.
Search for and select the student.

H DN~

Click the Membership side-tab, then click Schools. A list of existing school associations for
the student appears. If the student is already associated with schools, a list of existing school
associations for the student appears.

5. Do one of the following:

« Toview the details of an association, select the school, and click Details on the Schools
side-tab.

« Toenteranew school association for the student, on the Options menu, click Add. The
New Student School Association page appears.

6. Use the following table to help you complete the fields:
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Field Description

School > Name Click q and select the school to associate the student with.

Click Q’ and select the school year for which the association
will be in effect.

School Year

Click the drop-down, and select one of the following:

o Former: A student is a former student if he or she transfers
from your school to another school in your district.

« Secondary: A student is a secondary student if he or she
attends your school and another school in your district at the
same time.

Association type

Note: If you associate a student with a secondary school here,
the Cross-Enrollment alerticon < appears on Student
pages throughout Aspen and in the gradebook (if allowed by

System Administration preferences and a teacher’s gradebook

preferences). A indicates that the student is taking classes
or receiving services at more than one school.

Applies to secondary students only.
Click the drop-down, and select one of the following:

« None: The secondary school cannot take daily attendance for
this student.

« Sole: Only the secondary school can take daily attendance for
Attendance this student.

management type « Shared: Both primary and secondary schools can take daily
attendance for this student. However, the school that enters
the attendance owns it, and the other school has read-only
access toit.

To indicate that the daily attendance was entered at another
school, a red asterisk * appears next to it on the Class Office

side-tab.
Start date Click E, and select the date the association begins.
End date Click E, and select the date the association ends.

7. Click Save.

Note: You can filter the Student List to display only secondary or former students.
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Create Secondary School Associations

Sometimes, students take classes at your school while taking classes or receiving services at
other schools, too. The Create Secondary School Associations wizard is a way to associate these
cross-enrolled students with their secondary schools.

To associate a student with a secondary school:

1. Log on to the School view.
2. Click the Student tab.
3. Click Options, then select Create Secondary School Associations.

The Create Secondary School Associations wizard appears:

Secondary school Belmonte Middle School

District year 2013-2014 -
Start date 8/7/2013 iz

End date 8ra/2014 m

First name

Last name

Gender -

Date of birth R ~oe

Sesrch || Cancel |

4. Do one of the following:

« Click Push if you are at the student’s primary school, and want to push the student records
to the secondary school.

« Click Pull if you are at the student’s secondary school and want to pull the student records
into your school.
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5. Select the student’s Secondary school from the drop-down. If you are pulling a student record
into your school, your school’s name appears.

6. Select the District year for the cross-enroliment.
7. Enterthe Start date and End date that the student will attend the secondary school.

If you pull a student record into your school, do the following:

8. Enter the First name, Last name, Gender, and Date of birth for the student.
9. Click Search.

10. A pop-up lists the student’s name, some demographic information, and contact information for
the student’s primary school. Click OK.

| Matching student found. Selecting a student will cross-enroll him ar her into your school.

1 record (7
:Hm Gender OB LASID Iﬁﬂ"lﬂi En Status | Last Withdrawal Contact
© \Wight. Semantna|F 4162003(2020002281/04  |Actve - Gary Osis 5 ¥ SD 73, Abbotsforg Schaol District 24

If you push a student record to another school, do the following:
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I Push | Pu |

Secondary school Waybwight Elementary School -
District year 2013-2014 -
Start date 8772013 m

End date 8/42014 E

Students

Salection

Snapshots

Salected students: 0

[ox ] (_cancm ]

8. Inthe Students box, select one of the following:

« Selection: Select any student from the Student List.
« Snapshots: Select a snapshot of students.

9. Click OK.

Whether you pushed or pulled the student record, a pop-up indicates the results of the cross-
enroliment:

@ Schoal Association Results

|Associations oreated: 1
|Associations skipped (already exist): 0

Cross-Enrolling Students Whose Primary Schools Do Not Use Aspen

Students whose primary schools do not use Aspen might want to take classes or receive services
(cross-enroll) at schools in your district. These students must first be enrolled into a "holding"
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school.

After the district creates a holding school, it designates the school as such via its Membership
preferences.

To create a "holding" school:

Log on to the District view.

Click the District tab, Schools side-tab.

On the Options menu, click Add. The School Details page appears.
Enter any school details to identify this as the holding school.

5. Click Save.

AP oODd -~

A school registrar can then enroll students into the holding school using the Student Registration
wizard (by selecting the holding school at the School > Name field in step 3). The student’s
enrollment status will be Active No Primary once the record is saved.

After the student is enrolled in the holding school, the school registrar can then cross-enroll the
student into the secondary school via Create Secondary School Associations.

Secondary School Information Report

Run the Secondary School Information report to view details about cross-enrolled students. You
can choose to display:

« students who attend your school as their primary school, and are cross-enrolled at other schools
« students who attend your school as a secondary school
« all cross-enrolled students

To run the Secondary School Information report:

1. Log on to the School view.
2. Click the Student tab.

3. Onthe Reports menu, select Secondary School Information. The Secondary School pop-up
appears.

4. Enterthe report parameters.

The report displays in the format you specify:
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Assign a Group of Students to a Program

You can assign a group of students to a program and add it to their student records. For instance,
you might want to assign a group of students to the free- or reduced-lunch program, or a college-

bound program, to track that data.

April 04, 2014
Student Name Primary School Cross-Enrolled School(s) Start Date End Date
Abreu, Michasla Belmonte Middle School |\Veterans Memaorial School 08-Aug-13 O4-Aug-14
Abreu, Sammy Belmonte Middle School |Ballard Early Childhood Center 08-Sep-13 O2-Aug-14
Ackroyd, Yasmine  |Belmonte Middle School | Gary Caks Secondary 5D 73 O7-Aug-13 O4-Aug-14
Asello, Caroline Belmonte Middle School |Lynnhurst School 10-Mow-13 12-Mov-13
Itinerant Schoal 12-Mow-13 14-Mov-132
History School 20-Mov-13 22-Mov-13
Saugus High School 12-Feb-14 O04-Aug-14
Adello, Kimberly Belmonts Middle School [Waybright Elementary School 08-Aug-13 O4-Aug-14
Alken, David Belmonte Middle School | Saugus High School 21-Mar-14 O4-Aug-14
Andrews, Connor Belmonte Middle Schocl |Ballard Early Childhood Center 08-fug-13 O4-Aug-14
Saugus High School O7-Aug-13 O4-Aug-14
Gary Caks Secondary 5D 732 O7-Aug-13 O4-Aug-14
Andrews, Randy Belmonte Middle School | Gary Caks Secondary SD 73 01-Apr-14
Andrews, Seth Belmonte Middle School | Gary Caks Secondary 5D 732 O7-Aug-13 15-bar-14
Ballard Early Childhood Center 07-Aug-13 31-Mar-14
Arsenault. Morgan  |Belmaonte Middle School |Ballard Early Childhood Center O7-Aug-13 O4-Aug-14
Arsenault, Morgan  |Belmonte Middle School | Gary Caks Secondary SD 73 O7-Aug-13 O04-Aug-14
Ballard Early Childhood Center 07-Aug-13 04-Aug-14

You can also associate one student, or a small number of students, to a program.

To assign a group of students to a student program:

1. Log on to the School view.
2. Click the Student tab.

-153 -




Managing Student Information

3. Onthe Options menu, click Assign Student Programs. The Assign Student Programs dialog
box appears:

Assign Student Programs

School Crow Point High School
Program ClL :
Students to include Curmrent selection -

Search walue

Start date

End date

i

Active students only

At the Program field, click D@ to select the student program that you want to assign students
to.

>

o

At the Students to include field, indicate which group of students you want to associate with
the program. Select Current selection, All,YOG (year of graduation), or Homeroom.

o

At the Search value field, enter the criteria for the previous field. For instance, if you selected
YOG or Homeroom, enter the applicable year of graduation or homeroom number.

7. Enterthe date that this association begins at Start date.

8. Enter the date that this association ends at End date.

9. Select Active students only to only include students who have an active enroliment status.
10. Click Run.

A message appears indicating the number of students that were associated with the program, and
how many student records were skipped:

154 -



Managing Student Information

Messages

Students skipped due to existing program within date range:
13 student program record created.
0 student program record skipped.

Track a Student's Programs

You can track the programs each student is enrolled in. For example, a student might be enrolled in
the ESL and special education programs at your school. For each one, you can track the
enroliment start and end dates.

To enter or view a student in a program:

Log on to the District or School view.
Click the Student tab.
Search for and select the student.

A w0 N~

Click the Membership side-tab, then click Programs. A list of programs the student is enrolled
in appears.

5. Do one of the following:
« Toview the details of the student’s enrollment in a program, select the program, and click
Details on the Programs side-tab.

« Toenroll or withdraw a student from a program, on the Options menu, click Add. The New
Student Program Participation page appears. Enter the information, and click Save.

View and Manage a Student's Groups

You can track the groups that a particular student belongs to. You can also add a student to a
group and delete a student from a group.

Note: Each group might or might not have its own Page.

To manage the groups that a student belongs to:

Log on to the School view.

Click the Student tab.

On the Student List, select the checkbox of the student whose groups you want to view.
Click the Membership side-tab. The Enroliment details appear.

On the side-tab, click Groups. A list of the student's groups appears:

o N~
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Pages School HH Staff  Attendance Conduct Grades  Assessment Schedule Global  Admin

Options Reports Help Y == h = =
Student List :: 11 - Andrade, Cindy [ (][« ][a]l» ] »]

Group > Title \Group > Categor w Management
Details P p > Category ype g type
Class of 2012 |Cther

Single Person Manual

Contacts Crow Paint High Scheel Academic Schosl Automatic

Attendance Chemistry \scademic Section Roster Automatic

US His 2 Section Rester Automatic
Conduct

Transcript

Assessments

Schedule

Enrollment
Schools
Programs

Groups
Details

To add this student to a group:

1. Onthe Options menu, click Add.
2. Click Q to select a group.
3. Click Save.

To remove this student from a group:
1. Select the checkbox of the group you want to remove the student from.

2. Onthe Options menu, click Delete.

Entering Student Transactions

You can view details for the following transactions:

« student fees
« student events

« workflows to enter conduct incidents or manage special education plans

View Student Events

You can track any events for a student. For example, you might log each time you send a warning
letter home to a student’s parents.

To enter an event for a student:

Log on to the District, School, or Staff view.
Click the Student tab.
Search for and select the student.

Click the Transactions side-tab, then Events. A list of existing events for the student appears.
Do one of the following:

o~ DN~

« Toview the details of an event, select the event, and click Details on the side-tab.
« Toadd an event for the student, on the Options menu, click Add.
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The New Student Event Tracking page appears. Enter the information, and click Save.

Manage Student Workflows

Your Aspen system administrator creates workflows to coordinate multi-step processes involving
one or more users from start to finish. For example, your system administrator might create
conduct workflows, special education workflows, and professional development workflows. For
each workflow, a checklist walks users through the process, step-by-step.

After you, or another user, initiates a workflow for a student, use the checklist already created for
that workflow to follow the process.

To manage student workflows:

Log on to the District or School view.
Click the Student tab.
Search for and select a student. Click the Transactions side-tab.

Click the Transactions side-tab, then Workflows. Any current workflows for the student
appear.

A w0 DN~

5. Do one of the following:

« Tocomplete a task, on the checklist of an existing workflow for the student, select the work-
flow, and click Checklist on the side-tab.

« Toinitiate a new workflow, on the Options menu, click Initiate. The Initiate Workflow wiz-
ard appears. Follow the steps of the wizard. After you click Finish for Step 3 of the wizard,
the system creates the workflow and the checklist becomes available.

Managing Documents for Students

You can manage documents for students from the Documents side-tab.
Here you can:

« View oruse journal entries to track meetings with or concerning the individual.

« View or upload documents to save with the student.

« View and print other student forms.

Add or View Documents Associated With Students/People

You can attach files such as Microsoft Word and Excel documents to student records. These files
are easy to retrieve and view.

Note: Depending on your user role privileges, you may be able to access Documents from
the School, District, Staff, Health, Special Education, and Family views.

To attach files:

1. Log on to one of the following:
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« School view: Click the Student tab.

« District view: Click the Student tab.

« Staff view: Click the Student tab.

« Health view: Click the Student tab.

« Build view: Click the Student tab.

« Special Education view: Click the Student tab.
« Family view: Click the Family tab.

Click the Documents side-tab.

On the Options menu, click Add. The New Document page appears.
Enter the information in the fields, and import the document.

Click Save.

To view the document, click the Documents side-tab.

Click the name of the document you want to view.

Click Download = .

Manage a Student Journal

Create and manage journal entries for students. For example, guidance counselors might create a
journal entry each time they meet with a student.

To manage a student journal:

o~ DN~

Log on to the School or District view.

Click the Student tab.

Select the student.

Click the Documents side-tab, and then click Journal.
Do one of the following:

« Towork with an existing journal entry, click the entry.

« Toadd ajournal entry for a student, on the Options menu, click Add. The New Student
Journal page appears. Enter the information, and click Save.

View a Student's IEP

You can view a student’s special education IEP.
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To view a student’s IEP:

1. Log on to one of the following:

« School view: Click the Student tab.

« District view: Click the Student tab.

» Staff view: Click the Student tab.

« Health view: Click the Student tab.

« Build view: Click the Student tab.

o Special Education view: Click the Student tab.
o Family view: Click the Family tab.

Select the student.

Click the Documents side-tab, then click IEPs. A list of the student’s IEPs appears.
For details of an IEP, click the value in the IEP status column.

Click the sub-tabs to view all pieces of a student’s IEP.

o A~ N

Note: Every time you log on to view a student’s IEP, a record is placed in a log that the
special education manager monitors.

View and Print Student Forms

The Forms Manager lets you view and print student forms. Depending on your user role privileges,
you may be able to create, edit, and track these forms also.

Depending on how the form is defined, the Forms side-tab may provide you with the following:

« Copies of student forms you already generated and printed
« A history of when each form was generated and printed

« The ability to print blank copies of a form

« The ability to print multiple forms at one time

To manage forms:

Click the Student tab.
Find and select the student you want to print forms for.
Click the Documents side-tab.

A w0 N~

The Forms Manager appears:

o The first column lists the form ID.

« The second column lists the full name of the form, along with a link to create a new form.
To create a new copy of a form: Click New. If there is not a link to create a new form,
then only one copy of the form can be generated.

« The third column displays checkboxes.
To print multiple forms: Select the checkboxes for the forms you want to print, then click
Print Selected.
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To print one form: Click = next to the date in the last column.
« The last column displays the dates the form was generated.

To view or edit a form: Click a date to view or update the form, or click = to print one
copy of the completed form.

Managing a Student's Educational Plans

You can create multiple general educational plans for students, including 504 plans and Educational
Proficiency Plans (EPP).

For any type of educational plan, you can review dates, accommodations, disabilities, concerns,
and evaluations.

To help you manage a student’s educational plan in Aspen, you can do the following:

« Create arecord for the plan.

« Track meetings held to create and maintain the educational plan.
« Print an educational plan.

« End an educational plan.

Create an Educational Plan Record

Create arecord for a student’s educational plan to track review dates, accommodations,
disabilities, and all information concerning the plan.

To create an educational plan record:

1. Log on to one of the following:

« School view

« District view

« Staff view

« Health view

« Build view

« Special Education view

2. Click the Student tab.
3. Search for and select the student.
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4. Click the Documents side-tab, and then click Ed. Plans.

5. Click , and select Educational Proficiency Plan.

6. On the Options menu, click Add. The template for a standard Educational Proficiency Plan
appears:

Pages School Sluden Staff  Attendance Conduct Grades Assessment Schedule Global  Admin

Options Reports Help

Student List :: 10 - Abramson, Patrick :: New Student Ed. Plan ¥ /3
— CC T -

Attributes English Science Communication | Signatures ‘Optional

Contacts

Attendance ‘ Educational Proficiency Plan |
Conduct Status * et Review date E
Transcript Effective date =] District signed date =]
Assessments ||l == Rl =
Last megting date
Schedule
Advisor Q
Membership

In conversations with the student, explain why an Educational Proficiency Plan (EPF) is needed and the correlation between the student's fulure education and career goals and high school coursework. Explain
WELCERUER that in most cases the EPF will be in effect for two years or until the student has altained proficiency in English Language Arts, Mathematics, andior Science & Technology/Engineering

Journal This Educational Proficiency Plan is for the following content area(s) - check those that apply:
Documents English Language Arts Mathematics Science & TechnologyEngineering

Ci)

7. Inthe box at the top of the page, enter the general information for the plan:

8. Select a Status (Draft, Active, Previous, Discarded, Rejected). When you change the status of
a draft plan to Active, the system changes the draft to Previous.

9. Type or click B to determine the Effective date, End date, Review date, District signed
date, and Parent signed date.
10. Type orclick q to enter an Advisor.

11. If you have created a meeting record, the date of the last meeting record you created for this
plan appears.
12. Click the following sub-tabs to enter the necessary information:

« Attributes

« English

« Math

« Science

« Communication
« Signatures

« Optional

13. Click Save.

Track Meetings for an Educational Plan

Track meetings you hold to initiate, maintain, and adjust an educational plan for a student.
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To track meetings:

1. Log on to one of the following:

© © N o o~ wN

School view

District view

Staff view

Health view

Build view

Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents side-tab, and click Ed. Plans.

Select the plan.

On the Documents side-tab, click Meetings below Ed. Plans..

On the Options menu, click Add. The New Student Ed. Plan Meeting page appears.
Enter the meeting date, time, location, and details.

Click Save.

Run the Educational Plan Report

Run the Educational Plan report to print a hard copy of a student’s ed. plan. The report groups
accommodations by category.
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Aspen Public Schools
26 Court Streef - Boston, MA 02108

Educational Proficiency Plan (EPP)

MName: Agurkis, Adam ID: 1028177893
Date of birth: 6/11/1994 Grade: 11
School: Crow Peint High School YOG: 2012

Parents/Guardian  Richardson, Lee
Connly, Laurales

Address: 54 Holmes 207 Phone: (781) 740-9732
Hingham, MA 02043

Advisor name: Advisor contact

In conversations with the student, explain why an Educational Proficiency Plan (EPP) is needed and the correlation
between the student's future education and career goals and high school coursework. Explain that in most cases the
EPP will be in effect for two years or until the student has aftained profici in English Language Arts and
mathematics.

School personnel should indicate the option they will use to document the student's EPP:

[ A. Department sample EPP template
[ B. career Plan Model

O c. Locally developed student plan (by
[ D. Software/web portal

| Part l. Student’s C IA ts Information

This Educational Proficiency Plan iz for the following content area(s) -- check those that
[ English Language Arts [ mathematics [ Science & Technology / Engineering
Please complete the following review using available criteria.

A. Student high school grades from EPP content area (or all) courses

B. Other diagnostic assessment results

C. Student or faculty input'recommendations if available

Student MCAS Pre-Educational Plan Test

Assessments Courses

Date Assessment Score  Level Grade Course Full Course Name Final Grade
English
Math
Science

To run the Educational Plan report:

1. Log on to one of the following:

« School view

« District view

o Staff view

o Health view

« Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents side-tab, and then click Ed. Plans.
Select the plan to go to the Details page.

On the Reports menu, click Educational Proficiency Plan.
Select the report format, and click Run.

N o o kMoo

End an Educational Plan

You might need to end an educational plan either during or at the end of the school year.
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To end an educational plan:

1. Log on to one of the following:

« School view

« District view

« Staff view

« Health view

« Build view

« Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents side-tab, and then click Ed. Plans.

Select the plan.

On the Documents side-tab, click Meetings below Ed. Plans.

Select the remaining meetings on the plan.

On the Options menu, click Delete.

Click Details on the side-tab.

At the Status field, select Previous. The educational plan is no longer active.

© © N g~ DN -

Managing a Student 504 Plan

Manage a student’s 504 plan, including review dates, accommodations, disabilities, concerns, and
evaluations.

To manage a student’s 504 plan:

« Create arecord for a 504 plan.
« Track meetings held to create and maintain a 504 plan.
« Runthe 504 Plan report to print a copy of the plan.

« Enda504 plan.
« View a summary of a student's 504 plan.

« Determine the alert icon that appears for a student with a 504 plan.

Create a 504 Plan Record

Create arecord for a student’s 504 plan to track review dates, accommodations, disabilities, and all
information concerning the plan.
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To create a 504 plan record:

1. Log on to one of the following:

« School view

« District view

« Staff view

« Health view

o Build view

« Special Education view

Click the Student tab.
Search for and select the student.
Click the Documents side-tab, and then click Ed. Plan.

Click , and select 504 Plan.
On the Options menu, click Add. The Section 504 Accommodation Plan page appears:

o o A~ w N

Pages School Student Staff  Attendance Conduct Grades  Assessment Schedule Global  Admin

Optians Reports Help

Student List :: 10 - Abramson, Patrick :: New Student Ed. Plan T Q
Cancel Standard £04 Form -

Section 504 Accommodation Plan

Details

Contacts

Attendance s Draft - End date

iz
Effective date =2 Review date =]
]
]

Conduct

Last meeting date District signed date
T ript

Parent signed date

Assessments

Schedule Summary of meeting to discuss student's disability and request accommodation(s):

o]

Membership
Transactions
Journal
Student's disability:

”D\;ahm!ynnde |
IEPs | No matching records |
Ed. Plans

> Details Delete
Meetings How does disability affect one or more of student's life activities in school?

De

0

Forms

7. Inthe box at the top of the page, enter the general information for the plan:

« Select a Status (Draft, Active, Previous, Discarded, Rejected). When you change the status
of a draft plan to Active, the system changes the draft to Previous.

o Type orclick B to determine the Effective date, End date, Review date, District signed
date, and Parent signed date.

« If you have created a meeting record, the date of the last meeting record you created for this
plan appears.
8. Type a summary of the meeting held to discuss the student’s disability and accommodations.
9. Click Add to select one or more disabilities you need to list for the student for the 504 plan.
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Type a description of how the student’s disabilities affect the student’s life activities in school.

. Type any parent/guardian and student concerns.

To add a record for any evaluations, click Add.
Type the student’s history and evaluative data.
To define the accommaodations for the student, click Add.

Type other accommodations not available in the accommodation list.
Click Save.

Track Meetings for a 504 Plan

Track meetings you hold to initiate, maintain, and adjust a 504 plan for a student.

To track meetings:

1.

© © N o o~ DN

Log on to one of the following:

« School view

« District view

« Staff view

« Health view

« Build view

« Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents side-tab, and then click Ed. Plans.

Select the plan.

On the Documents side-tab, click Meetings below Ed. Plans.

On the Options menu, click Add. The New 504 Plan Meeting page appears.
Enter the meeting date, time, location, and details.

Click Save.

Run the 504 Plan Report

Run the 504 Plan report to print a hard copy of a student’s 504 plan. The report groups
accommodations by category.
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To run the 504 Plan report:

1.

N o oMb

Log on to one of the following:

School view

District view

Staff view

Health view

Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents side-tab, and then click Ed. Plans.
Select the plan to go to the Details page.

On the Reports menu, click Educational Proficiency Plan.

Select the report format, and click Run.
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Aspen Public Schools
26 Court Street - Boston, MA 02108

Educational Proficiency Plan (EPF)

Name: Clark, Edward ID: 1177327984
Date of birth:  11/18/1283 Grade: 11
School: Crow Point High School YOG: 2012

ParentsiGuardian Peper, Christine
Mcfaline, Leigh

Address: 228 Beatty Avenus Phone: (781) 741-1785
Hingham, MA 02043

Advisor name: Advisor contact

In conversafions with the student, explain why an Educational Proficiency Flan (EFFP) is needed and the comeiation
befween the sfudent's fufure education and career goals and high school coursework. Explain thaf in most cases the
EPF will be in effect for bwo years or undd the student has atfained proficiency in Engiish Language Arfs and
mathematics.

School personnel should indicate the option they will use to document the student’s EPP:
[ A. Department sample EFP template

[ B. Career Plan Model

O ¢c. Locslly developed student plan (by

D. Softwareiweb portal

| Part I. Student’s Courses/iAssessments Information

This Educational Proficiency Plan is for the following content area(s) -- check those that
Oe&n glish Language Aris O mathematics O sciznce & Technology / Engineering
Please complete the following review using available criteria.

A. Student high schood grades from EPF content area (or all) courses

B. Other diagnostic assessment results
C. Student or faculty mputirecommendations if available

Student MCAS Pre-Educational Plan Test

Assessments Courses

Date ABSERaMEn Score Lavel Crade Courss Full Courss Name Final Grada
English
Math
Science
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Aspen Public Schools
26 Court Street - Boston, MA 02108

Educational Proficiency Plan (EPP)

Flanned Meetings and Communication

Meetings with the student will be scheduled during his/her junior and senior year to evaluate progress made.
Meeting information:

Please note when and how parents/guardians will receive communication from the school about the supports
and services this student will receive to reach proficiency.

Lefter: Fhone:
In-person E-
Lefter: Fhone:
In-person E-

Aspen Public Schools
26 Court Street - Boston, MA 02108

Educational Proficiency Plan (EPP)

Part lIL Signatures

EPF Completion Verification Section {required)

This student has completed all requirements of hisfher OYes O Mo

Principal or headmaster (or designee)

Advisor name: Advisor contact
Principal or headmaster {or designee) signature Date
Student signature Date
Parent/guardian signature Date
Guidance or school advisor signature Date
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Aspen Public Schools
26 Court Street - Boston, MA 02108

Educational Proficiency Plan (EPP)

Optional Section:
Supports & Additional Learning Opporunities

List activities/programs that student is taking part in to complete and support this plan {e.g.. tutoring,
academic support, AVIDE [Advancement Via Individual Determination], study groups, etc.):

Describe any other additional courses or supports that the student will participate in to reach or make
progress toward proficiency and college and career readiness:

entify any school or community member who will meet to encourage the student to be successful and well
prepared for his or her high school and post-graduation plans.

Name:

Please record the type of communication (in-person meeting, email, phone, etc.) and the date:

Describe other recommended additional learning opportunities in which the student will participate.

Additional Learning Opportunity Grade
Advanced Placement [AP)

Capstone or Senior Project

Dwal Enrollment: courses taken for
both high school and college credit

Online course for high school or
college credit

Service Learning

Work-based learning

View Summary of Student's 504 Plan

If a student has an active 504 plan, the 504 Alerticon appears next to the student's name.

Note: Your district can customize the alert icon that appears for 504 plans.

To view a summary of the student's 504 plan:

1. Click the 504 Alerticon . The alert lists the effective date, and for each accommodation, the
content area, category, name, and description:
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Effective date B/2502008

L i £

ContentArea Category Name Description

a1 SRR Taa, e Frequent Test sdministered in short pericds with freguent
Breaks b...

2l Sl e T of Dy i'l'nitadmlmstered at a time of day that takes

Cance|

2. Click the Description to view details.

End a 504 Plan

You might need to end a 504 plan either during or at the end of the school year.

To end a 504 plan:

1.

N
©

© © N o o s~ N

Log on to one of the following:

« School view

« District view

« Staff view

« Health view

« Build view

« Special Education view

Click the Student tab.

Search for and select the student.

Click the Documents, and then click Ed. Plans.

Select the plan.

On the Documents side-tab, click Meetings below Ed. Plans.
Select the remaining meetings on the plan.

On the Options menu, click Delete.

Click Details on the side-tab.

At the Status field, select Previous. The 504 plan is no longer active.
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Determine the Alert Icon for a 504 Plan

You can determine the icon that appears for students with a 504 plan.

To determine the alert icon for 504 plans:

1. Logonto the District view.

2. Click the Admin tab.

3. Click the Data Dictionary side-tab.

4. Onthe Data Dictionary side-tab, click Extensions.
5. Find and select the STD-504-PLAN extension.

6. Select the General Ed Plan checkbox.

7

Click the Icon drop-down to select the icon. As you scroll through the list, the icon appears next

to the field:
Pages District Student Staff  Attendance Conduct Grades  Assessment Schedule Global Tools WAdmin
Options Reports Help
Extensions :: STD-504-PLAN - 504 Plan
Auto-saved at 9:27 PM
& 504 Fl
Tables Name [ an |
- ; .
Extensions Description [Dictionary for the Standard 504 Flan |
» Details Category
Tables
Parent dictionary > Niame | | |Q,
Reference
Health? (]
Calculated
Fields Special Ed? i}
PO? [}
Forms
General Ed Plan?
Workflows ;
lcon E vl
ngﬂ 504 Education Plan |
Definitions Cumiculum Accommcdstion Plan
nc=l | Auto-S{ 5y cation Proficiency Flan k
System Status Gifted and Talented
Individualized Educstion Plan
Individuslized Student Sucoess Flan
Log Response to Intervention

8. Click Save. The icon appears as an alert icon for students with active 504 plans.

Manage Snapshots for Individual Records

You can manage the snapshots a specific student, staff member, room, or course is a member of.
For example, assume you create a snapshot of all students on the Volleyball team at the beginning
of the season. Then, a student joins the team. Select that student and add him or her to the

snapshot.

To manage snapshot membership for an individual record:

« Tomanage student snapshots, click the Student tab.
« Tomanage staff snapshots, click the Staff tab.
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2. Search for and select the specific record.

3. Click the Snapshots side-tab. A list of snapshots the student, staff member, course, or room
belongs to appears.

4. Do one of the following:
« Toadd the record to a snapshot, on the Options menu, click Add. The Snapshot Pick List
appears. Select the snapshot and click OK.

« Todelete arecord from a snapshot, select the checkbox next to the record. On the Options
menu, click Delete.

Associate Related Students

Indicate when students are related, or share an address. When students at a school share an
address, you can assign one student as the courier to bring handouts home. You can also change
the courier, as needed.

To associate related students:

1. Logon to the District, Intermediate Organization or School view.
2. Click the Student tab.

3. Search for and select the student.

4

5

Click the Contacts side-tab, then click Related Students.
On the Options menu, click Add. The New Student page appears:

s School [VSEGEREY Staff  Attendance onduct rades t  Schedule Global  Admin

Reports Help

6. Atthe Name field, click Q and select the associated student from the pop-up. Click OK.

7. Atthe Relationship field, click the drop-down to indicate whether this student Lives with the
other student, or is a Relative or Sibling.

8. Click Save.

Assign a Student Courier

Aspen lets you assign a courier to help distribute notices to students' homes and cut down on
ink/paper costs.

-173-



Managing Student Information

At the beginning of each school year, you can run this procedure to ensure that each household has
a courier. Aspen automatically assigns the older student at an address as the courier.

You can change the default courier, if needed. If only one student at an address attends this school,

that student is automatically assigned as the courier.

To assign or edit student couriers:

1. Log on to the School view.

2. Click the Student tab.

3. Onthe Options menu, select Assign Couriers. The Student List appears, with students
grouped by address.

4. Search for the student or family you are looking for. To select a different student in the family as
the courier, deselect the checkbox next to that student’s name in the Courier column. Select the
checkbox in the row of the student who will act as the courier.

5. Click Save.

Manage Courier Groups

When students who attend the same school share an address, Aspen can assign one student as
the courier to bring handouts home. Aspen automatically assigns the older student at an address as
the courier, but you can change the default courier as needed.

To change the student courier at a shared address:

Log on to the School view.
Click the Student tab.
Select the checkbox next to the student assigned as the courier, then click Details.

In the Courier Group box at the bottom of the details page, click the Manage Courier Group
link.

A w0 DN~

The Student Pick List pop-up appears for the students at this address:

« The Shared Address box lists the students’ address.
« The Shared School box lists the school they attend.
« The Update Courier box lists the students’ names at this address.
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5. Inthe Update Courier box, select the checkbox next to the name of the student who will serve
as the courier for this address.

6. Click Save.
7. When you return to the student details page, click Save.
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